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License and Warranty 

 

License Agreement 

Copyright laws of the United States and international treaty protect this software.  Verity Software House provides this 
software under the following conditions:  

Software is intended to be installed and registered on one computer.  An additional user license is required for each 
additional installation. 

Some software is licensed for metered-usage with a software “battery”.  A software battery is licensed to one machine 
for one user account. 

Backups of the software must be used only for archival purposes. 

Duplication of the manual is strictly prohibited without the expressed written permission of the copyright holder. 

If you transfer the use of this software to another party, that party must accept the terms of this agreement, and you 
must transfer all copies of the software or destroy them.   

Your license to use this software will terminate if you are found to be in violation of this agreement.   

The laws of the State of Maine and the United States of America govern this license.   

 

Limited Warranty  

Verity Software House (VSH) warrants the physical media and the physical documentation, if included, to be free of 
defects in materials and workmanship for a period of 30 days from date of purchase.  If VSH receives notice of defects 
in materials or workmanship within the warranty period, VSH will replace the defective media or documentation. 

VSH makes no other warranties, either expressed or implied, with respect to this manual or with respect to the 
software described in this manual, its quality, performance, merchantability, or fitness for any particular purpose.  VSH 
software is licensed "as is".  The entire risk as to its quality and performance is with the buyer. Should the software 
prove defective following their purchase, the buyer (and not VSH, its distributor, or its retailer) assumes the entire cost 
of all necessary servicing, repair, or correction and any incidental or consequential damages.  In no event will VSH be 
liable for direct, indirect, incidental, or consequential damages resulting from any defect in the software, even if VSH 
has been advised of the possibility of such damages.  Some states do not allow the exclusion or limitation of implied 
warranties or liability for incidental or consequential damages, so some of the above limitations or exclusions may not 
apply to you. 
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Latest Versions 

 

To find the latest versions for ModFit LT and the documentation, visit the Verity Software House web site at 
www.vsh.com.  This site provides a complete version of the latest revision of the online documentation, patches, and 
technical support information for the program. 

You can also email us at verity@vsh.com to determine whether or not you have the latest version.  Please include the 
version that appears on the start-up dialog box, and the file date for the program with your email. 
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Naming Convention 

 

This manual and ModFit LT’s analysis results use shortened forms of ploidy terms to improve readability.  We use the 
term “Diploid” when referring to "DNA diploid".  Similarly, we use the terms “Aneuploid” and “Tetraploid” when referring 
to “DNA aneuploid" and "DNA tetraploid" respectively. 

When using analysis results in publications or other contexts outside of the software, we suggest that the explicit 
“DNA” terms be used.   See "Convention on Nomenclature for DNA Cytometry", Hiddeman et, al., Cytometry 5:445-
446 (1984) for additional details. 
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New Features in ModFit LT 

 

Version 3.2 

 

 This version supports native OSX on the Mac platform, and Vista on the Windows platform. 

 We have removed OLE automation support from this build.  Please contact Verity Software House tech support 
(tech@vsh.com) if you would like to see this added back in a future release. 

 Graphics are now bitmap format instead of vector format for clipboard and disk files. 

 A number of bug have been fixed. 

  

 

 

Version 3.1 Service Pack 3 

22 September 2005 

 The program now supports high-resolution, digital data up to 32-bits.  This includes support for 18-bit FCS data 
files exported by BD's Diva software.  

 A "Convert" button has been added to the listmode Choose Parameter dialog.  This button displays the Edit 
Properties for Log Conversion dialog that allows linear parameters to be converted into log parameters.  Use this 
option when reading Diva-generated files that were stored in linear, FCS 3.0 format.  The dialog displays a list of all 
parameters in the file, allowing the user to select parameters to convert to log for display and analysis.  It also provides 
an option to convert to 4-decades or the "computed" decades for the native, linear resolution. 

  The program now supports FCS files containing more than one dataset.  When a multi-dataset file is opened, the 
program displays the Choose Dataset dialog to allow the user to select the dataset which should be used for analysis. 
The selection remains in effect until it is invalid or the user makes a new choice.  The dialog can be redisplayed by 
enabling the "Multi Dataset Prompt" property in the File Batch Settings dialog. 

 When the program is configured to base ploidy determination on an external reference or an internal standard, 
several new results are reported.  The results will display a "Reference Diploid" value that shows the location where 
the Diploid G1 is expected to be.  In addition, each cell cycle shows a "DI based on reference:" statistic, which is 
computed as the G1 mean of the cycle divided by the "Reference Diploid" value.  For all cycles except Diploid, the 
typical "DI" is also still reported. 

 A new function has been added to the equation processor.  The "F" function can be used to convert a keyword 
value into a floating-point number.  This allows the keyword to be used in calculations.  The syntax is: F[expression], 
where expression is typically a keyword.  For example, the $P1B keyword stores the number of bits used to store a 
value for parameter 1 in an FCS file.   
To compute the number of bytes used by parameter 1, the following equation could be used: 

    "Parameter 1 bytes = ";F[[$P1B]]/8 

To display the same result as an integer: "Parameter 1 bytes = ";p[0];F[[$P1B]]/8       

 New internal keywords have been added to provide access to the External Reference Mean [ExtRefMean], and the 
Diploid-to-Standard Ratio [DipToStdRatio].   

 The SetProperty DDE/OLE command has been enhanced for the ExternalReference property. 

  DDE Syntax from WinList: [SetProperty(Property=value)] 

  OLE Syntax from VB: SetProperty(propertyString, valueString) 

  Supported properties and values: 

   AutoAggregates=On,Off 

   AutoDebris=On,Off 

   Standards=0,1,2 

   ExternalReference=position or 

   ExternalReference=position,dynamicRange 

  In this second format, the dynamicRange is used by ModFit LT to scale the position value  to it's histogram scale.  

 A new ploidy index of -1 has been added for hypo-diploid models.  Ploidy index can be displayed using the 
MF_PLOIDYINDEX keyword.  
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 Bug fix: Program crashed when S-Phase component was changed to a single Gaussian.  This has been corrected.  

 Bug fix: The Mac version did not properly list files on some network drives.  When the network drive was selected, 
files in the application folder were displayed.  Corrected.  

 

Version 3.1 Service Pack 2 

19Dec2003 

  The Proliferation Wizard now detects conditions where there is little or no Parent generation.  The wizard locks the 
SD for the Parent to the last known good SD and alerts the operator.  This addresses problems that could occur in 
analyzing a sequence of proliferation data files where the Parent generation is not present as the experiment 
progresses. (11Dec2003 VI 1115) 

  The X-zoom graphic is now placed behind the main graph by default, instead of on top of it. It can be moved to be 
on top of the main graph by selecting the main graph, choosing the Report->Send to back command, and then 
selecting and moving the zoom graph. 

  Implemented "battery" usage system. (26Sep2003) 

  Bug fix: Corrected crash that could occur when an older version of the proliferation model was opened in a report 
and used for analysis in a newer version of the program. (10Dec2003 vi 1115) 

 

Version 3.1 Service Pack 1 

30May2003 

  The program now supports 3 gates and displays gated data in the second and third gates.  See the Listmode 
appendix for more details.  

  Prolif wizard now supports export of "partition" information.  Options for export appear on the Other tab of the prolif 
wizard dialog.  A new tutorial describes how this feature can be used with WinList to provide enhanced proliferation 
analysis. 

  The Proliferation wizard now supports a "floating" model option for the daughter generations.  On the Generations 
tab, you can choose between the "Standard" and "Floating" model options.  In the standard model, the mean of each 
generation is dependent on the previous generation, based on the spacing value.  In the floating model, a range is 
associated with each generation and the mean is allowed to 'float' in the model.  This option should ONLY be used 
with well-defined, visibly-separated generations. 

  Added a Lock SD option to the Parent Tab of the Proliferation Wizard.  This option is useful for proliferating 
samples in which the parent population becomes indistinct. When the option is enabled, the SD for the parent 
population can be edited.  All generations use the same SD as the parent, regardless of the state of the Lock SD 
option.   

  The status bar now displays low and high X and Y values as gate regions move or resize to allow for more precise 
positioning. You can also display the position of a region by clicking and holding on the region without moving it.  

  When the program opens, it is now positioned and sized to the location and size which were last used.  

  The registration dialog now displays a confirmation dialog when a valid unlock code is entered.  

  The User Login name is now stored in a keyword, MF_USERLOGIN, which can be displayed on reports and 
stored in the database. 

  The program now uses the Unbiased Summation method for reducing histogram resolution to 256 channels.  This 
will likely improve RCS values for histograms that have native resolution greater than 256-channels.  It may also result 
in slightly different locations for peaks found by the Peak Finder.  

  After selecting a batch of data files or reports, the program now automatically displays the  Edit Properties for 
Batch dialog to allow batch properties to be adjusted prior to opening  the first file. 

  Options and Configuration now provides separate options for auto-scaling X and Y axes to allow greater control.   

  Bug fix: User edits to the X axis label are now left in place when new data files are opened.  If first characters of 
the label are the default  label "Channels", the program will auto-label the axis.   Otherwise, the user label is left alone.  

  Bug fix: Graphics now update correctly for first-time DDE connection with Winlist on PC. 

  Bug fix: The program could crash if gating resulted in zero events in the histogram.  The crash would occur when 
trying to fit the histogram.  This condition could also occur with DDE connections to WinList.  
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  Bug fix: The Proliferation Wizard did not reposition the parent range if the parent position was adjusted in the 
dialog when editing the model.  This led to cases where the model would fail to fit some files if the parent population 
moved beyond the scope of the range.  

  Bug fix: program could crash if low or high channels for zoom graphics were greater than 256 channels AND 
preference settings for Desired Resolution were 256.  Crash would occur when a new data file was read into the 
report.  

  Bug fix: program could crash with file or report paths greater than 120 characters. Revisions now support paths to 
250 characters.   

  Bug fix: When batch analyzing files using the "Fit with current model" option, the program would slow down as it 
progressed through the batch.  An internal array was not properly cleared in this scenario. 

  Bug fix: With auto-scaling disabled, user-defined scale didn't apply when advancing to next batch file  while in 
scale view.  This has been corrected.   

 

Version 3.1 

  Several new keywords have been documented. 

  The Edit Keywords dialog now uses an Add button instead of a Copy button.  The added equation will have a 
standard default value. 

  OLE features have been enhanced to provide more extensive OLE Automation capabilities. 

  A Reset button has been added to the batch controls. 

  A new AutoAnalysis setting has been added to make all G2M's dependent.  By default, this setting is enabled.  
This is a SIGNIFICANT CHANGE from previous versions that greatly improves operator-to-operator consistency. 

  The logic that detects shifting of positions of internal standards has been improved. 

  Crashes that could occur if AutoAnalysis could not create any cell cycles in the model have been corrected. 

  Options and Configuration now has an Overrides section that can apply settings to models in reports as they are 
loaded.   

  Models now have the ability to ignore internal standards in the generation of debris and aggregate components.  
By default, internal standards are now ignored by these components. 

  The Full Model Editor now displays the component ID when showing the list of components in the model. 

  Bug fix: Sync and Prolif wizards didn't clean out analysis keywords from database or keyword objects.  Corrected 
30Jul2001  (vi 969) 

  Bug fix: Debris component could report negative percentages and areas in unusual cases.  Corrected 30Jul2001.  
(vi 999) 

  Bug fix: The program did not read INCLUDE equation files from the model's path if a model was opened in the Full 
Model Editor.  Corrected 26Jul2001. 

  Bug fix: A crash occurred when a model component (other than the last component) was deleted from a model 
with the Full Model Editor.  Corrected 25Jul2001 (vi 1010) 

  Bug fix: A crash in peak finder could occur when a histogram had no events.  This unusual case could occur in a 
DDE connection with WinList when the histogram in WinList is gated and shows no events. Corrected 25Apr2001   

  Bug fix: The program can now identify hypo-diploid conditions where the hypo-diploid peak is at a lower channel 
than an internal standard. 

  Bug fix: The program now defeats S-phase cutoff warning when in OLE automation mode.  Corrected 4Sep2001 
(vi 294) 

  Bug fix: A custom model in saved report did not "fit" when the report was re-opened.  Corrected 4Sep2001 (vi 975) 

 

Version 3.0 

  AutoDebris™ component handles Paraffin, Fresh and Frozen preparations. 

  AutoAggregates™ provides a more robust system for handling higher aggregate forms. 

  AutoLinearity™ determines the best linearity setting for G2M and aggregates automatically, eliminating a major 
source of analysis variability. 
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  Cycle Analyzer™ features an enhanced PeakFinder to work with extensive variety of histograms, and uses a new 
rule-based system for ploidy classification. 

  Auto-analysis now handles complex histograms such as near diploid, hypo-diploid, multiploid, tetraploid plus 
aneuploid, and more. 

  Choosing a model uses a revised dialog to make model selection much more flexible and open-ended.  Models 
are created dynamically instead of being stored on disk. 

  The peak finder system has been completely revised to provide a much more robust, statistical method for 
identifying peaks in histograms. 

  The new database system includes a database viewer, expanded keyword list, and support for multiple databases 
active at one time.   

  Quick Model Editor allows quick changes to current model, with quick access to AutoDebris, AutoAggregates, 
G2M, S-Phase, and Linearity. 

  Full Model Editor provides a complete model construction system.  Use existing models as base for edits or start 
from scratch to build custom models for novel applications. 

  Dynamic model creation system builds models on the fly for auto and manual analysis. 

  New batch analysis controls provide efficient and sophisticated data file and report processing. The new batch 
toolbars automatically appear when multiple files are selected, with VCR-style buttons to allow go-to-first-file, repeat, 
next file, auto-advance, and go-to-last-file. 

  Powerful batch configuration options are available for processing data files and reports. 

  User Defined Keywords allow you to create custom equations that can be displayed on reports and stored in 
databases. 

  Revised report format includes new results for events in cell cycles, average cycle events per channel, and an 
improved layout for results. 

  New graphics include a legend of model component colors, report objects that zoom in on portions of the 
histogram, and a report representation of the Fit Diagnostics dialog. 

  Export histogram and report graphics to disk as PICT, metafile, or bitmap. 

  Histograms can now be analyzed at 1024 channels, and support has been added for 16-bit FCS files, multiple 
histogram FCS format, and ASCII data file format. 

  New Auto-analysis options allow you to set tetraploid threshold and determine how ploidy will be determined. 

  The Proliferation Wizard features new results for Upper Generation Proliferation Index (UGPI) and Precursor 
Frequency. 

  New Internet-based registration system allows quick registration and access to Verity support. 

  Three levels of user-access to program features allow better control over program configuration options. 

  HTML-based online help provides more efficient searching and viewing of documentation. 

  An event logging system has been added to assist technical support in tracking down problems. 

  Many reported problems with printers have been corrected. 

  Many reported problems from version 2.0 have been corrected. 
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System Requirements 

 

Minimum System Configurations 

PC: Windows 2000, XP, Vista or greater with 50MB free disk space for program files. 

Macintosh: OSX 10.3.9 or greater with 50MB free disk space for program files.  
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Installation and Setup of ModFit LT 

 

You will need to register the software with Verity Software House in order to unlock the program on the computer.  
This can be done using the online registration process or by contacting technical support.  

Note: If your program is an update version, you will need the serial number for the previous version in order to register 
and unlock the software. 

 
To install ModFit LT for Windows 

 Log on to your computer with an account that has Administrator privileges.   

 Insert the ModFit LT CD into the CD-ROM drive.   In most cases, a welcome screen will appear automatically.  
Follow the directions on the screen.  If the welcome screen does not appear within a minute after the CD has been 
inserted, run the program named Setup or Setup.exe on the CD.   

 The setup program will guide you through installation.  Follow the directions on the screen to complete the 
installation. 

 See the section on registering your software for information on how to register your software. 

 
To run ModFit LT for Windows 

 Open the Start menu, and choose Programs.  Then navigate to the Verity folder, and choose ModFit LT. 

 

 
Instructions for Macintosh version 

You will need to register the software with Verity Software House in order to unlock the program on the computer.  
This can be done using the online registration process or by contacting technical support.  

ModFit LT requires OSX 10.3.9 or greater.  You will need to have administrative rights to install the software. 

Note: If your program is an update version, you will need the serial number for the previous version in order to register 
and unlock the software. 

 
To install ModFit LT for Macintosh 

 Insert the ModFit LT CD into the CD-ROM drive.  In most cases, a welcome screen will appear automatically.  If 
the welcome screen does not appear within a minute after the CD has been inserted, run the installer directly from the 
CD 

 The Installer will guide you through installation.  Follow the directions on the screen to complete the installation. 

 See the section on registering your software for information on how to register your software. 

 
To run ModFit LT for Macintosh 

Start the program by double clicking on the ModFit LT application in the Applications/ModFit LT folder. 

 





 

17 

Registering your new software 

 

Why You Should Register 

With this version of ModFit LT, registration is more important than ever before.   In fact, your software will not be fully 
functional until you register.  Here's why. 

This version of the program uses software security that allows it to be used without a hardware lock.  Software security 
requires you to register your software in order to receive an Unlock Code to make the program fully functional.  You 
can run the program up to 10 times prior to registering the software. 

Of course, registration is useful for other reasons, too.  We can inform you of bug fixes and updates, and provide you 
with better technical support. 

 

How to Register 

When you start the program for the first time, it will automatically start the Registration Wizard.  You can access this 
dialog at any time by clicking the Registration button on the dialog box that is displayed when the program starts up. 

 

  

 

Click the Next button to begin the registration process.   

 

  

 

The wizard will ask how you want to register the program.  Select the appropriate option and click Next. 
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Then next step in the wizard shows some information about the program.  There are 3 fields that you need to fill in for 
this step: Serial #, CD Key, and Email.  You can also enter or edit the Computer Name field to identify your computer. 

The Serial number and CD Key can be found on the outside of the box the program came in, or in email if the program 
was provided to you by download.  Enter these exactly as they appear; they are case-sensitive.  If you have lost or 
misplaced the Serial number or CD Key, contact Verity technical support at tech@vsh.com or (207) 729 6767. 

For the Email field, make sure to enter a valid email address.  Otherwise, you may not receive the Unlock Code and 
the program will not be fully functional. 

Click Next to continue the registration process. 

 

If you have more than one user account at vsh.com, you will be presented with another step.  This step only appears if 
you have more than one account. 

 

  

 

Choose the web account that you want to use for registration, and then click Next. 

 

At this point, the program will request an unlock code from the registration server at vsh.com.  If successful, you will 
see the confirmation step and the Unlock Code for your computer. 
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You can print the registration information by clicking the Print button.  Click Finish to close the wizard and continue 
working with the program 

 

If there was a problem with the registration, an informative message will explain the problem and steps to take to 
correct it. 

 

Once you have completed the registration successfully, the program will be fully functional. 

 

 

If the registration wizard cannot connect to vsh.com… 

Sometimes firewalls can prevent the registration wizard from connecting to vsh.com.  In this case, you can try 
registering with your browser.  Choose the second option in the list and click Next to launch your browser with the 
correct registration information.   

 

  

 

Follow instructions on screen to complete the process. 

 

To register your software using email… 

The registration wizard can help you send email to Verity Software House with your registration information.  Choose 
the third option in the list and click Next to create an email message. 
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Follow instructions on screen to complete the process. 

 

If you do not have Internet access… 

If you do not have access to the Internet, you can send the registration information below to Verity Software House by 
fax, mail, or telephone.  Our technical support staff can register the software for you with the information you provide, 
and supply you with the Unlock Code to enter into the Registration Wizard. 

Here is the information we need.  You can print this page and fill it in. 

These fields are found in the Registration dialog box. 

Program Name: 
Program Version: 
Computer ID:  
Serial number: 
CD Key: 

User Information 

Name: 
Institution: 
Address: 
City: 
State/Province: 
Zip/Postal Code: 
Country: 
Phone: 
Fax: 
Email: 

Our technicians will use the information below to create a web user account for you on our web site. 

Name to use on VSH web: 
Password to use on VSH web: 
A question we can ask to verify who you are: 
The answer to the question to verify who you are: 

If you are updating from a previous version, you will need to supply the serial number of the previous version. 

Serial Number of previous version: 

 

Contact Verity Software House 

Verity Software House 
PO Box 247, Topsham, ME 04086 
USA 

 
Email: verity@vsh.com 
Web: www.vsh.com 
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Phone:  (207) 729 6767 
Fax: (207) 729 5443 
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Tutorials 

First Time Using ModFit LT 

 

Welcome to ModFit LT! 

This short tutorial will introduce you to the major features of the program.  It just takes a few minutes.   

=>  Start the program by following instructions in the Installation and Setup section.   

=>  Click the OK button on the opening dialog. 

=>  In the User Login dialog, type your name and choose “Standard User” from the User Group drop down.  Leave the 
Password field empty and click OK. 

ModFit LT presents a row of buttons in a toolbar just beneath the program's menu bar at the top of its window.   The 
buttons are named and arranged to give you quick access to important functions in ModFit LT. 

 

Opening a data file 

  

=>  Click the File button on the toolbar.  

The Open File dialog is displayed.  With this dialog, you can navigate to a folder in which you have stored the data you 
want to analyze with ModFit LT.  We will just open a sample file for now. 

=>  Select Sample1.fcs from the Samples folder located where ModFit LT is installed.  Click Open to load the file.  

ModFit LT reads the sample file and displays the histogram on the report page.  You are now ready to analyze the 
sample. 

 

Auto-analyzing the data 

  

=> Click the Auto button on the toolbar.  

ModFit begins its automatic analysis of the sample.  It scans the histogram for peaks, and based on the sizes and 
positions, the program attempts to determine the number of cell-cycles in the sample.  Then, it creates a model to use 
with the sample and performs a non-linear least squares analysis of the data.  Depending on the speed of your 
computer and the complexity of the sample, this may take a few seconds to complete. 
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Review the analysis 

The program displays the analyzed histogram and the computed percentages for various populations.  All of the 
elements on the report page are moveable, and most can be re-sized, allowing you to customize the look of your 
reports. 

Review the results of the analysis to see the type of information ModFit LT provides.   See the section on Analysis 
Results for more on this topic. 

 

Adding text to the report 

  

You can easily add text to the report.  A report toolbar appears next to the main toolbar, making it easy to add objects 
to the report.  

=> Click the text tool  in the report toolbox.   

The Edit Text dialog appears.  Here you can enter any text you want to add to the report.  In addition, you can store 
comments in a database so they can be easily retrieved without retyping them.  See Report Design for more on using 
comments and moving objects on the report. 

=>  Type a comment, and then click OK. 

The comment is displayed on the report.  You probably need to move it to another location. 

=>  Click and hold the mouse button down on the text you just added.  Drag it to a new location and release the mouse 
button.   

All report objects can be moved in the same manner. 

 

Auto-naming and saving the report 

  

This is a good time to save this report.  ModFit LT has a quick and convenient way to do this.  It is called Auto Save 
Report. 

This option creates a name for your report based on the name of the data file you analyze.  See the Auto Save Report 
command for more on how reports are named. 

=>  Click the Save button on the toolbar.  

Your report has now been stored on disk.   

=>  From the File menu, select New.  This option clears the report from the screen. 

 

Retrieving the report 

When you want to retrieve a report from disk, you simply re-open the report.   

=>  From the File menu, select Open->Report.   

The File Open dialog is displayed, showing the reports in the report folder.  Here you can navigate to a new folder if 
you need to. 

=>  Select the report you just saved.  (Hint:  Look for the name of the data file, "Sample1.FCS".  There should be a 
report with "Sample1" as the first part of the name.) 

=>  Click Open. 

The report will be loaded, and you should see things just the way they appeared when the report was saved. 

You can also use the Recent Reports menu in the File menu to select from recently saved reports. 

 

Welcome to the world of modeling with ModFit LT. 

 

See also: 

Histogram and S-Phase Assessment  
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Creating a report template  
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Optimizing Auto Analysis 

 

This tutorial describes how to configure Auto Analysis to work with your data files.  Three configuration dialogs are 
used to set up the program for Auto Analysis: Peak Finder Settings, Auto Analysis Settings, and Options and 
Configuration dialogs.  By modifying the content of these three dialogs, you can optimize Auto Analysis to handle your 
data sets.   

There are two major benefits to correctly configuring the Auto Analysis system.  First, it will reduce the amount of time 
you have to spend analyzing each histogram.  Of equal importance, you will increase user-to-user consistency of 
analysis results.  The time you spend configuring the system can produce a tremendous benefit in very few analyses.    

 

Prerequisites 

In order to complete this process, you need a data set of twenty or more histograms of the same cell type that have 
been acquired according to a prescribed protocol.  Your protocol for sample preparation, staining, and acquisition 
should be well defined and strictly followed.  Since different types of samples may have different characteristics and 
preparation procedures, you may need to configure the program differently for each type of sample you analyze.  

You will need to log in to the program as an Administrator in order to set up the program and save the settings as 
default settings.   When you save settings as default settings, the program uses those settings each time it starts up.  
If you log in as an Advanced User log you can change configuration settings for the current session of ModFit LT, but 
the settings will not be reloaded automatically.  As a Standard User, you cannot access the dialogs that configure the 
Auto Analysis system. 

 

Setting Options and Configuration 

From the Edit menu, choose Options and Configuration.  This will display a dialog containing a number of 
configuration settings.  Most of these settings do not need to be changed from the program default settings. 

One set of values you may need to adjust is found under the section AutoLinearity Settings.  The Low and High 
linearity values define the range over which the program can adjust the linearity during AutoLinearity adjustments 
when the AutoLinearity option is enabled.  You should enter the acceptable range for G2/G1 ratios for your data set. 

Review other settings in this dialog.  For details on each setting, see Options and Configuration.   

Make any adjustments required to the values.  You may want to save these settings to a file that can be manually 
loaded back into the program.   To do this, use the Save button at the bottom of the list in the dialog.  When you need 
to re-open the saved settings, use the Open button.  This also allows you to transfer settings from one computer to 
another. 

Click OK to close the dialog and accept the changes you have made.  If you logged in as an Administrator, the 
program will ask if you want to save the changes as defaults.  Choose Yes if you want all users to use these settings 
when the program starts. 

 

Reviewing a Data Set for Important Peaks 

Next, the peak finder needs to be tested for your data set. 

Click the File button on the toolbar.  Navigate to the location of your data set and select twenty or more of the files to 
be analyzed.  Click the Open button. 

The program will open the first file in the set.  If the file is a listmode file, you will need to select the parameter to 
analyze.  Gating is not recommended. 

There are two things to notice at this point.  At the bottom of the application window, the program now displays a batch 
navigation toolbar.  We will use this to review the data set.  Secondly, the first histogram has one or more peaks 
identified with black triangles along the x-axis.  These are the peaks that the program's Peak Finder has identified.  
When the program is correctly configured for your data set, it will identify the vast majority of the internal standards 
and G1 peaks for cell cycles in your data set.   It will also identify many of the well-defined G2M peaks, but these are 
not as critical as the G1 peaks.  It should not identify many false peaks, that is, portions of the histogram that you do 
not consider to be real peaks. 

To review the data set, we need to tell the program what to do as we navigate through the batch of files.  Click the 
leftmost button on the batch control toolbar to display the Edit Properties for File processor dialog. 
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Set the File processor as follows: No analysis, do not save or print reports, do not prompt for database or files.  Then 
click the OK button to close the dialog.  This tells the program that all we want to do is open the data files as we 
navigate through the batch. 

Now, here is the process for peak finder review.  For each file in the batch, write down whether the program has 
identified all of the internal standards and the G1 peaks for each cell cycle.  If the program misses an important peak, 
note the location(s) of peaks omitted.   The major reasons peaks are missed are that they are too small, too wide, or 
they do not represent a normal, Gaussian distribution.  All of these parameters can be adjusted in the program's peak 
finder.  Also note the locations for any false peaks.  For missing peaks and false peaks, try to note the characteristics 
of the peak, e.g. short, wide, shoulder. 

Make notations for the histogram, and then click the "Next" button on the batch toolbar. 

  

 

Repeat this process for each file in the data set. 

 

Configuring Peak Finder Settings 

Review the notations you made for the data set.  If the program correctly identified 95% or more of the peaks in your 
test data set, you probably do not need to make any adjustments.  If the Peak Finder did not perform as well as it 
should, here is how to make adjustments to the settings. 

Hopefully, there are some common characteristics to the histograms that caused problems for the Peak Finder. Use 
the batch navigation buttons on the batch toolbar to re-open a histogram that is representative of the mistakes the 
Peak Finder made. 

Next, choose Peak Finder Settings from the Edit menu.  The Edit Properties for Peak Finder settings dialog is 
displayed.   

Click the Show button at the top of the list of options.  This will display a dialog that allows you to see the current 
histogram, and to understand the characteristics of each peak. 

As you move your mouse over the histogram, vertical lines will be displayed showing the boundaries for a peak that 
the program found.  The lower portion of the dialog shows a number of peak filters, as well as the statistics for the 
peak your mouse is over. 
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Example of Peak Finder with a "missing peak" 

 

Move the mouse over a peak that the program did not identify.  Look at the lower portion of the dialog for one or more 
of the settings that do not show the word "Pass".  Adjust the sliders for the failing settings until all of the settings show 
"Pass" for the peak.    

If no vertical lines appear for a peak, the peak does not qualify as a statistically valid peak.  This kind of error cannot 
be corrected in the Peak Finder. 

As you make adjustments, sweep your mouse across the histogram to review the status for all of the peaks.  If you 
find that false peaks now "pass", you may need to compromise on your adjustments.  If, however, the false peaks are 
very small, the program may exclude them from Auto Analysis for not passing other thresholds, so you should not 
worry about them at this point. 

Once you have made adjustments that satisfy the histogram, click OK to close the Peak Finder dialog and return to the 
Edit Properties for Peak Finder settings dialog.  You may at this point choose to save these settings to a file using the 
Save button at the bottom of the list.  Alternately, you may want to write down the new settings.  Since this process is 
experimental and may require several iterations, it is good to keep track of each set of adjustments. 

Click OK to close the dialog.  When prompted by the program, you should not save these settings yet. 

Now you need to try out the new settings on the data set again.  Move to the first file in the batch.  Make notations for 
missing peaks and false peaks, and then move to the next file. 

Repeat this process of reviewing and adjusting until the Peak Finder is tuned for your data set.  Then, display the Peak 
Finder Settings dialog once again.  This time, save the settings to a file using the Save button.  Click OK to close the 
dialog.   

If you logged in as an Administrator, the program will ask if you want to save the changes as defaults.  Choose Yes if 
you want all users to use these settings when the program starts. 

 

Adjusting Auto Analysis Settings 

The final phase in optimizing Auto Analysis for your data makes use of the Auto Analysis Settings dialog.  This dialog 
controls how the program interprets the peaks in a histogram. 

From the Edit menu, choose Auto Analysis Settings.  The Edit Properties for Auto Analysis settings dialog will be 
displayed. 

The first three options are straightforward.  We recommend that you enable AutoDebris and AutoAggregates, as these 
components are robust and automatic in the way they handle debris and aggregation in histograms.  The Apoptosis 
option is usually left disabled for Auto Analysis unless you have a series of histograms in which you want to model 
apoptosis as a Gaussian distribution below the first cycle's G1 peak. 
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For Linearity, either leave the value at 2.0 or enter the average G2/G1 ratio of a data set.  The G2/G1 ratio is easily 
computed by dividing the mean channel of a G2 peak by the mean channel of the G1 peak of the same cycle.  Typical 
ranges are 1.95 to 2.0.   

In the Standards and Reference section, enter the number of internal standards your histograms contain.  If you have 
internal standards, you should click the Edit button to set the properties of the standards.  The most important property 
to set for each standard is its expected channel position.  By entering an expected position, the program can make 
better decisions about when peaks shift and where the first cycle begins. 

If you want to make use of an external reference standard for determining the location of the Diploid population, you 
should enter its channel location.  This is only required if you want to base the Diploid position on the external 
reference. 

The Ploidy Determination section provides a number of interesting possibilities for assigning ploidy labels to peaks.  
We will examine these in detail. 

First, the Maximum cell cycles entry can in most cases be set to Unlimited.  However, if you want to restrict Auto 
Analysis to creating models with a limited number of cell cycles, select the number of cycles in this drop down listbox. 

The Diploid determination list presents 4 options for determining which cycle is labeled "Diploid".  The first option, 
"First cycle is Diploid", simply assumes that the first peak, after any internal standards and apoptosis, is the Diploid G1 
peak.  This option should be used for paraffin samples.   When you use this option, you do not need to enter a value in 
the related field, Diploid-to-Standard ratio. 

You can also choose to base the Diploid cycle decision on the position of one of the internal standards or an external 
reference channel position.  In these cases, you need to enter the expected Diploid-to-Standard ratio.  For example, if 
your 2nd internal standard appears at channel 40 and you expect the Diploid G1 to be at channel 50, you can choose 
"Based on Standard2" for Diploid determination and enter 1.25 for the Diploid-to-Standard ratio.  (Note: The value 1.25 
in this example is for PI-stained trout red blood cells in relation to PI-stained human Diploid cells. For DAPI staining or 
other internal standard cells, the ratio will be other values.) 

The G1 threshold field determines how big a peak has to be in order for it to be called a G1 peak.  This is a relative 
height after adjustment for aggregates.  In essence, it acts like another filter in the Peak Finder, but specifically relates 
to G1 classifications.  If you have a number of small peaks that Auto Analysis is calling G1 peaks and you do not want 
them classified that way, increase the G1 threshold about 2 or 3 units at a time until they are not longer considered G1 
peaks. 

The Peak location range field determines how much of a shift from the expected locations you will allow.  For example, 
if the value is set for 10 (percent) and the Diploid is expected to occur at channel 50, the program will look for a peak 
between channel 45 and 55.  Generally, values between 5 and 10 are best for this field. 

The S-Phase group does not require adjustments for most users.  The settings are based on industry-standard 
recommendations and practices, so if you change these settings, it will be difficult or impossible to compare results in 
your lab with results of other labs. 

The Tetraploid group allows you to set the threshold at which the program will call a peak a Tetraploid G1 instead of a 
Diploid G2M.   Recommended values range from 15 to 25, and you may need to experiment with these values on your 
data set. 

When you finish making your first adjustments to the settings, use the Save button at the bottom of the list to save the 
settings to a file on disk.  As with other configuration dialogs, you may need to go through several iterations before you 
find the best settings for your data set. 

Choose OK to close the dialog.  If prompted, you should not save these settings as default settings yet. 

 

Testing the Auto Analysis settings 

At this point, you are ready to test the full system. 

Choose File Batch Settings from the Edit menu.  Note that this is the same as clicking the Edit Batch button on the 
batch control toolbar. 

Change the settings to Auto-analyze each data file that you open.  Click OK to close the dialog. 

Click the "go to first" button on the batch control toolbar.  The first histogram will be opened and an Auto Analysis will 
be performed.  Make a notation to indicate whether the program correctly analyzed the histogram.  Pay particular 
attention to the ploidy classifications for each cycle and the graphical representation of the fit. 

Advance to the next file.  After the program auto-analyzes the histogram, make notations about the success or failure 
of the program.  Repeat this process for the entire data set. 

After all files have been processed with Auto Analysis, review your notations.  The goal is to have the program work 
automatically for greater than 90% of the histograms.  If you need to make additional adjustments, repeat the process 
of reviewing and adjusting until you achieve the best results.   

When you have the settings that work best, display the Auto Analysis Settings dialog once again.  Save the settings to 
a file using the Save button.  Click OK to close the dialog.   

If you logged in as an Administrator, the program will ask if you want to save the changes as defaults.  Choose Yes if 
you want all users to use these settings when the program starts. 
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Summary 

The process of tuning Auto Analysis for your own data sets involves three dialog boxes: Options and Configuration, 
Peak Finder Settings, and Auto Analysis Settings.  After setting up configuration options, an iterative process is used 
to find the best Peak Finder Settings for a data set.  As the final step, a similar iterative process is used to tune the 
Auto Analysis Settings to a data set. 

Use a data set of histogram generated from the same cell or tissue type.  As you perform this process for a data set, 
save your settings for each dialog box so that they can be reloaded at any time.   

You should perform this process for different sample types if the preparation process or the histograms themselves 
have difference characteristics from the data set initially used to optimize Auto Analysis.  

You will always find some histograms in a data set that are unusual when compared with the rest.  Do not try to 
optimize Auto Analysis for unusual histogram, or you will find that it fails more often than it works.  Instead, base your 
decisions on the typical histograms in a data set, and you will find the system has a much higher success rate. 

 

See also: 

Options and Configuration  

Peak Finder Settings  

Auto Analysis Settings  
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Manual analysis with ModFit LT 

 

If ModFit LT has difficulty detecting peaks or identifying the ploidy patterns of a sample using automatic analysis or 
you need to make your own modeling decisions, you can use manual analysis to tailor the analysis to the data. 

Manual analysis involves several steps.  First you open the sample you want to analyze.  Next, you use the Choose 
Model dialog box to select a model that matches your assessment of the sample.  Once the model is selected, you 
need to position ranges over important peaks, and finally tell the program to analyze the sample.  

  

Here is an example. 

=> Click the File button on the toolbar.   

=>  Open the file "Problem1.fcs" from the Samples folder. 

 

There are several problems with this histogram, the most important being that its peaks are very broad.  In order for 
Auto Analysis to succeed, the important peaks in the histogram must be correctly identified.  Peaks are shown by the 
small black triangles under the graphic.  Depending on your Peak Finder settings, the program may have missed one 
or both of the dominant peaks in the histogram.   

This is a circumstance where you must use manual analysis to model the sample.  Even if the peaks are all detected, 
you can still continue with this tutorial. 

 

=>  Click the Choose Model button on the toolbar  .   

 

This dialog allows you to define the model that you want to use for the histogram.  Based on the options you choose, 
the program will construct a model to match those assumptions.  This is a DNA Aneuploid sample, so the selections 
we make in the dialog need to reflect that. 

 

  

 

=>  Enable AutoDebris by checking the AutoDebris checkbox. 

=>  Enable AutoAggregates by checking the AutoAggregates checkbox. 

=>  Disable Apoptosis by clearing the check in the Apoptosis checkbox. 

=>  Set Linearity to 2.0.  This is the default G2/G1 ratio. 

=>  Set Standards to 0.  There are no internal standards in this file. 

=>  Set Number of cycles to 2.  We want to model 2 cell cycles in this data file: a Diploid and an Aneuploid cycle.  

=>  For the Model template, choose "Dip Ane".  This tells the program the ploidy to assign to each cycle.  

=>  For the Range positions, choose "Compute range positions".  If you use this dialog to modify a model, you might 
choose "Use current range positions" so that the program did not move existing ranges.  

=>  Click OK to confirm your choices and close the dialog.   
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The program will construct the model and try to position the model ranges over detected peaks.  It switches to the 
Range view automatically.  You can switch to this view anytime by clicking the Range button on the toolbar. 

 In the Range view, you can position ranges over the peaks in the sample.  You move a range by clicking on the range 
label, and dragging it to a new location with the mouse button down.  When finished, you release the mouse button.  
To adjust the width of a range, click the black handle and drag to choose a new size.  If a range is already correctly 
positioned and sized, do not move or resize it. 

 

=> Make sure the Debris range is located over the starting point of debris at the left edge of the histogram.  This range 
is always used to identify the start of debris.  The right side of the range should be placed at approximately two-thirds 
of the histogram scale. 

=> Next, ensure that the Dip G1 range is positioned over the first peak, the DNA Diploid G0-G1.  It does not need to 
be stretched to encompass the peak as long as it is centered on the peak.  You should see a red fill in the first peak 
that indicates the range estimate of the size of the peaks. 

=>  Move the An1 G1 range over the center of the second peak, the DNA Aneuploid G0-G1.  This peak will fill with 
yellow to indicate the range estimate. 

 

Notice that as you move a range, the left pane on the status bar displays information about the range’s position.  The 
left and right values are in channel units; the top is in number of events.  When the mouse button is released, the 
status bar indicates the fitted estimates for the range. 

 

=>  Move the Dip G2 range over the portion of the histogram that is about twice the position of the Dip G1 range.  This 
is the approximate position of the Diploid G2-M. 

=>  Move the An1 G2 range to about twice the position of the An1 G1 range.  This is the approximate position of the 
Aneuploid G2-M. 

 

  

 

With the ranges in position, you are ready to analyze the sample.   

 

=>  Click the Fit button  on the toolbar to perform the non-linear least squares fit.  

 

Review the analysis to ensure that the model correctly matches the sample.  If it does not, you should make sure you 
selected the correct model and that its ranges are correctly positioned. 
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Summary: The manual analysis mode should be used when the peak finder or automatic analysis mode fails, or you 
need to make your own decisions about how to model a sample.  It enables user intervention at the key points in the 
analysis: model selection and range positioning. 

Models are selected using the Choose Model option from the Analysis menu, or by clicking the Model button on the 
toolbar. 

Ranges used to identify peaks must be positioned so that each range identifies a unique peak; they should not 
overlap.  For example, the Dip G1 range is used to identify the Diploid G0G1 peak, and no other peak range should be 
placed over the same peak.  You should not, for example, place the An1 G1 range over the same peak as the Dip G1 
range.  The Debris range is the only exception.  Since it does not identify a peak, it should be stretched across about 
two-thirds of the histogram.  

 

See also: 

Model Descriptions  

Choose Model command (Analysis menu)  

Position Ranges command (Analysis menu)  

Using the Sync Wizard  

Using the Proliferation Wizard  
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Using AutoLinearity 

 

Purpose: 

The purpose of this tutorial is to demonstrate the appropriate use of ModFit LT linearity controls.  The video form of the 
tutorial is available on the ModFit LT CD and the Verity Software House web site.  The goals of the tutorial are listed 
below. 

1.  Define linearity and its potential effects on cell cycle analysis. 

2.  Show an example of a fit with an inappropriate linearity setting. 

3.  Demonstrate the manual method of adjusting linearity from within Quick Model Editor. 

4.  Demonstrate automatic linearity detection from Quick Model Editor. 

5.  Demonstrate automatic linearity detection from Report Batch Control Editor. 

6.  Discuss the linearity configuration settings. 

7.  Discuss a recommended approach to modeling with an optimized linearity setting. 

 

Definition and Potential Effects 

We define linearity as the observed ratio between the DNA Diploid G2M and G0G1 positions.  Normally this value 
should be two, but it can, under normal circumstances, deviate from this ideal value. 

Linearity affects cell cycle analysis in at least two ways.  The first effect is that for models that have indistinct G2M 
peaks, the program uses the internally stored linearity setting to position the G2M in the fitting process.  For example, 
if a G1 peak were found to be located at channel 100 and the program was told that the associated G2M peak was 
indistinct, the final G2M position would be forced to 195 if the linearity setting were 1.95.  If the linearity setting were 
2.00, the G2M position would be 200.  Thus, linearity can affect the position of G2M peaks under some circumstances. 

The second major effect is on the aggregation model component.  This model component assumes, for example, that 
doublet positions are twice singlet positions and triplet positions are three times the singlet positions.  ModFit LT uses 
the linearity setting to transform the data so that it is perfectly linear prior to creating the theoretical shape of the 
aggregate distribution.  Thus, linearity can also affect the positions of computed aggregates and affect the model’s fit 
and S-Phase estimate. 

How important is the linearity setting in estimating the S-Phase fraction?  In many cases it can make up to a 100% 
change in S-Phase estimates, as shown in the next graph. 

  

lintut1.bmp 

 

In this particular file a linearity setting of either 1.90 or 2.1 results in approximately twice the aneuploid S-Phase 
estimate as a value of 1.99. 

Therefore, it is important to optimize this setting for a particular histogram and model in order to obtain accurate and 
consistent S-Phase estimates.   

 

Example of inappropriate linearity setting 
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Here is a report demonstrating a model that used an inappropriate linearity setting. 

  

lintut2.bmp 

 

Notice that the Aneuploid S-Phase is 10.51 and the reduced chi-square is 1.82 for this analysis. 

In order to better appreciate the linearity effects, we also show a scaled view of the graph.  This allows us to easily see 
the Diploid G2M peak and aggregates. 

Notice that the diploid G2M model component appears shifted to the left of the observed G2M peak and the aggregate 
peak is also shifted to the left.  This aggregated peak represents doublets between diploid G0G1 (red) and aneuploid 
G0G1 (yellow) cells. 

 

The manual method of setting linearity from within Quick Model Editor 

To change the linearity setting for this loaded model and data, we use the Quick Model Editor.  In this dialog box is an 
edit box called Linearity, which currently has the value of 1.93. 
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lintut3.bmp 

 

As seen earlier, by visual inspection of the fit, we can infer that this value is too low since the G2M and aggregate 
model components are to the left of their optimal positions.  We can manually change the linearity setting to a better 
value by typing in a linearity value of, say, 1.98 and refitting the model. 

  

lintut4.bmp 

 

The G2M and aggregates now line up better, resulting in a lower aneuploid S-Phase, 8.96, and reduced chi-square, 
1.56. 

Unfortunately, the trial and error approach to setting linearity is time consuming and can result in variability in S-Phase 
estimates.  A better approach is to let the program find the optimal linearity setting. 

 

Automatic linearity detection from Quick Model Editor 

Let’s now use a new feature in ModFit LT that is designed to automatically find this optimal linearity setting. 

We will again select the Quick Model Editor.  This time, however, we’ll check the Auto Linearity checkbox, click OK 
and click the Fit button. 

With this method, the program examines a set of linearity settings, searching for the one that results in the lowest 
reduced chi-square.  The message status bar in the lower-left corner indicates its progress. 

After it has completed this analysis, it re-fits the histogram with the optimized linearity setting.  For this example the 
optimized linear setting is 2.01. 
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lintut5.bmp 

 

The advantage of using the automatic linearity detection is that it potentially eliminates another factor in S-Phase 
estimate variability. 

Unfortunately, this procedure is rather time consuming.  It would be advantageous if the entire process could be done 
automatically with batch processing. 

 

Automatic linearity detection from Report Batch Control Editor 

Suppose you have already created ModFit LT reports for a number of histograms.  These reports have already been 
carefully reviewed and now are ready to be further refined by the automatic linearity detection system. 

When ModFit LT detects that multiple reports have been selected, it shows a Report Batch Control on the desktop.  
Normally it will appear at the bottom of the application window. 

  

lintut7.bmp 
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By clicking on the “Edit” button at the left of the toolbar, a dialog box containing relevant report batch control properties 
will be shown.  If we set the Analysis property to “Fit and do AutoLinearity”, the program will automatically perform 
AutoLinearity adjustments, then re-fit with the report model each time a new report is loaded.  Finally, by choosing 
“Re-save report”, the new optimized linearity setting and model fit will be stored in the report automatically.  You might 
decide to also activate some of these other options such as printing or databasing depending on your specific needs. 

You would then choose the Redo button to analyze the first report in the batch and then select the Auto Advance 
button to do the rest of the reports.  This process is time-consuming, which is why it is best handled in automatic batch 
processing. 

This is a powerful technique that enables optimal linearity detection automatically to be done in background. 

 

Linearity configuration settings 

How does the program determine the starting and ending linearity value to test in the auto linearity detection system?  
These settings are stored in the Options and Configuration section of the program.  This dialog can be displayed if you 
are logged into the program as either an Advanced User or Administrator. 

  

lintut8.bmp 

 

ModFit LT contains reasonable default values for these settings.  If your laboratory has a smaller range of possible 
linearity values, you can save considerable time by making the Low linearity and High linearity settings more 
restrictive.  The Linearity Increment can also be adjusted to make the system more streamlined. 

If you are logged in as an Administrator, the program will ask whether these settings are to be saved when you click 
OK.   

 

A recommended approach to modeling with an optimized linearity setting 

Our recommended approach to the routine analysis of DNA files is as follows.  First, find a good average linearity 
setting for your laboratory and enter it into the Auto Analysis Settings option in the program.  You may also need to 
tailor other aspects of the auto analysis system as well.  You will need to be either an Administrator or Advanced User 
to do this. 

Second, use batch file processing with Automatic Analysis as much as possible.  Click the File button on the toolbar 
and select the files for analysis.  When ModFit LT detects that more than one file is selected, the File Batch toolbar will 
become visible. 

Click the File Batch toolbar Edit button.  Select Auto-analysis, Save Report and make sure the path to the reports is 
correct.  We recommend using a different folder for each set of reports.  If the report path is incorrect, use the navigate 
button to set it to the correct location. 
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Now you are ready to automatically analyze a number of files and store their reports.  By choosing the Re-do or First 
File Batch Control button, the current file will be processed.  When that is done, select the Auto-advance button to do 
the rest. 

Notice how the program automatically detects the peaks, chooses the correct model and performs the least-squares 
fit.  By automatically analyzing as many files as possible you not only save time but also ensure that the analysis is as 
reproducible as possible. 

After the files have been automatically analyzed, they need to be carefully reviewed.  Use the File menu Open Reports 
option to multiply select all the newly stored reports.  Much like the data files, when ModFit LT detects that multiple 
reports are selected, it makes the Report Batch Control visible.  Take care not to confuse these similarly looking 
controls.  You can distinguish these controls by either their position or balloon help. 

The Report Batch Control makes it easy to review all the reports.  If a mistake was made by the automatic analysis 
system, fix it with the Quick Model Editor or Load Models button, perform the new analysis and then resave the report.  
Pay particular attention to possible ploidy mistakes or missing peaks. 

Once all the reports have been validated, use the procedure discussed above to perform automatic linearity detection 
on a batch of reports.  Click the Report Batch Control Edit button, choose “Fit and do AutoLinearity” and Re-save 
reports. 

By clicking on the Go To First report batch button, the first report will be re-analyzed with the Auto Linearity system 
turned on and the report will be ultimately saved.  After the system is finished, click the Auto Advance button to 
analyze the rest of the reports. 

 

This concludes the linearity tutorial. 
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Databasing with ModFit LT 

 

This section introduces some of the concepts and functions needed to work with ModFit LT's database features.  It is 
more of a discussion than a tutorial, however there are examples to clarify some aspects of the system. 

ModFit LT has a simple, powerful database engine that allows you to store large amounts of data easily in one or more 
database files.  You can view databases from within the program, manually add, delete, and replace records, and 
select the fields you want to store in each database.  The databases are created in a simple, text format known as tab-
delimited ASCII text, which can be read by common database and spreadsheet programs.  These features give you a 
great deal of flexibility in choosing what information to store, where to store it, and how to integrate the information into 
other database and information systems. 

 

How do you create a database? 

NOTE: Creating a database is only available to Advanced Users and Administrative users.  Standard users do not 
have access to the Edit Keyword Map dialog box. 

It is best to run an analysis of a data file before you create or edit a database.  Open one of your data files, preferably 
from a DNA Aneuploid sample, and perform an Auto-Analysis.  This will fill the program with the information you can 
choose to store in your database.  You can set up a separate database for each kind of analysis you do, one database 
for everything you do with the program, or anything in between.   

To edit or define databases, select Databases from the Edit menu, you will see the Edit All Databases dialog.   

 

  

databasetut1.bmp 

 

There is one database, "Database1", created by the program automatically.  This database will not store anything until 
you tell the program what information you want to save in the database.  To do so, you need to select the database in 
the list and click the Edit button.  You can also double-click the item in the list to do this. 

NOTE: Creating a database is only available to Advanced Users and Administrative users.  Standard users do not 
have access to the Edit Keyword Map dialog box. 
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The Edit Keyword Map dialog is displayed.  The left side of this dialog presents the information available to store, and 
the database fields are shown on the right.  Initially, the right-hand list is empty. 

 

What can you store in the database? 

ModFit LT allows you to database virtually any statistic it generates, as well as keyword information from the files that 
you analyze.  The tree on the left of the dialog can be expanded to display branches of keywords.  To open or close a 
branch of the tree, double click the label.  You can also click the “+” or +”-“ buttons in the tree to open and close 
branches.  Each branch of the tree contains a set of related keywords. 

To add an item to the database definition, select it in the tree on the left and click the Add button.  A field will be 
appended to the database.  You can also select more than one Keyword at a time and click Add to create multiple 
fields at once.   

 



ModFit LT User Guide 

42 

  

databasetut3.bmp 

 

NOTE: Because of limitations imposed by common database and spreadsheet programs, you may want to restrict the 
number of fields you create.  Other programs usually will not read a text database with more than 255 fields of data.    
Since it is likely that you will want to open ModFit LT databases with other software, it is best to keep your databases 
with fewer than 255 fields.   

The field names initially assigned when you click the Add button are based on the keyword added.  

 

  

Databasetut4.bmp 
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You can edit the names for the fields after they are added to the list, if you wish.  To do so, click once on the field 
name to select it, then after a brief pause, click slowly again.  An edit control will appear around the field name, 
allowing you to type a new name for the field.  You can also use the Tab key to move from one field to the next if you 
need to edit the names of several fields. 

To remove one or more fields from the database, select the fields in the list and click the Delete button. 

To replace an existing field with a new keyword, select the new field in the Keywords list and the one to replace in the 
list.  Then, click the Replace button.  The name of the field will not change, only the keyword used to evaluate the 
field. 

To change the order of fields in the database, select one or more fields in the list and then use the Up and Down 
buttons to move the field(s). 

When you have finished selecting information to store in the database, click the OK button to close the Edit Keyword 
Map dialog. 

 

What files are created? 

When you select keywords to store in a database, ModFit LT creates three or four files on disk to manage the 
database.  The location of the files depends on the operating system, as shown in the table below.  You can choose 
another location, as long as you have read/write permissions to that folder. 

 

Operating System Default Location 

Windows 2000 and XP C:\Documents and Settings\All Users\Documents\ModFit LT for Win32 

Windows Vista C:\Users\Public\Documents\ModFit LT for Win32 

Macintosh OSX /Library/Application Support/ModFit LT for Mac 

 

A file is created to store a "map" of keywords to database fields.  The map file name uses the name of the database 
object and appends ".map" to it.  For "Database1", the map file is named "Database1.map".   

Next, the program creates or revises the actual database file.  This is the tab-delimited, ASCII text file that you may 
open in other database or spreadsheet programs.  The database file name uses the database object name and 
appends ".txt" to it.  This file is readable in virtually any program that can open unformatted text.  The first line of the 
file contains the names of the fields separated by tabs; it is known as the database header or definition.  Each 
subsequent line contains a record of information.  

If the database had been created previously, ModFit LT will automatically create a backup of the database before 
overwriting the existing one.  The backup file will have the same name as the database, with "backup" appended to it.  

Finally, the program creates a text file called a "key" file.  This is a text file that explains the database and mapping 
files.   You can open this file in a text editor to review the structure of the database you have created.  Its name is 
based on the database object name, with "key.txt" appended to it. 

 

How do you activate the database? 

Once a database has been defined, there are several additional properties you can specify.  These properties 
determine whether the database is active, whether it will prompt you before saving a record, whether or not you want 
to see the records in a database viewer, and where you want to store the database. 

To edit these properties for a database, select the database in the Edit All Databases dialog box and click the 
Properties button.  The Edit Properties for Database dialog will be displayed. 
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The properties are enabled or disabled with simple check boxes.  You can use the Choose button to use an existing 
database that you have defined previously.  You can change the location of the database using the Path button. 

In order to store records of information in a database, it must be "active".  To make a database active, check the 
Active checkbox in the Edit Properties dialog.  Database records are saved when after Automatic Analysis or Execute 
Model commands are performed.  Additionally, you can save a record at any time by clicking the "+" button on the 
database viewer. 

If the Prompting checkbox is checked, ModFit LT will display a message each time it is about to save a record to the 
database.   You can choose at that time whether or not you want to save the record.  If Prompting is disabled, the 
database will save a record without prompting. 

To view the database while you work with ModFit LT, check the Viewer checkbox.  A database viewer window will be 
created and displayed.  The database viewer can be moved, resized, and scrolled horizontally or vertically.  It has a 
toolbar that provides some additional manual database functions.  See the topic Database Viewer for more 
information. 

The size of the font used for the database viewer can be set with the Viewer font size property. 

To select an existing database on disk, click the Choose button.  A file selection dialog box will appear, allowing you 
to navigate to the existing database and select it.  Linking to an existing database will rename the database in memory 
to match the one selected on disk, and the associated database map on disk will be loaded as well. 

To change the location of a database, click the Path button.  A path navigation dialog will appear.  Navigate to the new 
location. 

 

How do you rename or create additional databases? 

To rename a database, display the Edit All Database dialog box by selecting Edit Databases from the Edit menu.  
Click once to select the database you want to rename.  After a brief pause, click again on the object to display an edit 
box in the Name column.  Type the new name for the database. 

The name you type must contain only alphabetic, numeric, or space characters, and must be at least 4 characters 
shorter than the maximum file name length for the operating system you are using.  If a file with the new name already 
exists, you will be given a chance to overwrite the existing file, use the existing file, or cancel the operation. 

When you want to create an additional database, click the New button.  This will create an empty database with a new 
name.  

Each database has its own map of keywords to fields, and its properties determine whether it is active, prompting, and 
showing a viewer. 

 

Errors with databases 

Since the database system involves creating and manipulating files on disk, there are conditions where errors can 
occur.  If, for example, one of the critical database files is moved or deleted, the program will not be able to use the 
database.  When the program runs into a problem like this, it displays a dialog box of choices. 
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When you see this dialog, it means that the database "txt" file and the "map" file are out-of-sync with one another.  
They may have a different number of fields, a different order, different fields defined, or one of the files may be 
missing.  If you choose the first option, the map file is emptied and partially recreated with the fields defined in the 
database header.  In this case, you need to recreate the keyword-to-field "map" using the Edit Keyword Map dialog.   If 
you choose the second option, all records in the database txt file are emptied and a new "header" is written into it to 
match the database map file.  The third option leaves the map and the txt files out-of-sync and deactivates the 
database, allowing you to investigate the problem before any action is taken. 

 

As with any of our tutorials, if you should have any questions or problems with the software, please do not hesitate to 
send email to verity@vsh.com, or call our Technical Service line (207 729-6767 x190). 

 

See also: 

Edit Databases  

Edit Keyword Map  

Edit Properties for All Databases  

Edit Properties for Database  

Database Viewer  



ModFit LT User Guide 

46 

Using the Sync Wizard 

 

This tutorial introduces the use of the Synchronization Wizard, or "Sync Wizard", used to analyze data with perturbed 
populations.  The Sync Wizard allows you to specify important aspects of your data and constructs a model to match.  
Once the model is created, you can use the Sync Wizard to run through a set of files, adjusting the model as needed. 

You will learn how to start the Sync Wizard, how to adjust the settings used to create the model, and how to analyze 
your data samples with the model created.  Best of all, you will see how easy it is to use the Sync Wizard to model 
synchronized cell lines. 

Let’s dig in. 

 

Starting the wizard 

=>  Start ModFit LT if it is not already running. 

=>  Click the File button on the toolbar.  The Open dialog box will appear. 

 The files you will use in this tutorial are stored in a folder called "Synchronization" under the ModFit LT directory.   
=>  Navigate to the Synchronization directory and open "Cho074dn.fcs".  This is the control population, and is the first 
file you will analyze. 

=>  From the Analysis menu, click the Sync Wizard popup menu and choose Create or edit model.  The 
Synchronization Wizard dialog will appear. 

 

 

 

Setting up the model 

Notice the tabs across the top of the dialog.  These tabs are labeled with the categories you can adjust in the model.   

The options on the Start tab let you create or edit a model, and also provide an alternate path to open a data file.  
Since you have already opened the file we want to use and are ready to create a model, you do not need to make any 
changes to the Start tab. 

 

=>  Click the G0-G1 tab. 
This tab displays your data file so that you can tell the Sync Wizard where the G0-G1 peak is. 
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The program positions the red cursor over the first peak it finds in the sample.  In this case, it is correctly positioned.  
If, however, you need to adjust it, you simply click the red triangle and drag it over the G0-G1 peak.  If you would 
rather type in a position, you can edit the G0-G1 channel edit box directly. 

Now you need to decide whether to let ModFit LT adjust the G0-G1 position during the modeling process, or to lock 
the G0-G1 position.  Here is how to decide. 

If your sample has a clearly defined G0-G1 peak and you want the program to look for the best peak position over a 
range of channels, choose "Adjust automatically."  The Sync Wizard will create a range, "G0G1", with boundaries 8 
channels above and below the peak position, and center it on the peak. It will look for the peak within the "G0G1" 
range.  If your G0G1 peaks shift from file to file, as long as they fall within the range the program should find them.  If 
the G0G1 peaks shift too much, you can adjust the position or size of the "G0G1" range to account for the shift.  In 
fact, the Sync Wizard will prompt you if it cannot find a peak in the range.  

If the peak is not clearly visible or you do not want the program to scan for the G0-G1 peak, you should choose "Lock 
the position".  This setting prevents the program from adjusting the position.  
=>  Select "Adjust automatically" for this sample. 

=>  Click the G2-M tab. 
This tab displays your data file so that you can tell the Sync Wizard what the G2/G1 ratio is. 
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If you know the G2/G1 ratio already, you may enter it directly into the G2/G1 ratio edit box.   

=>  Enter 1.92 in the G2/G1 ratio edit box. 
 

If you have a sample with a visible G2-M peak, you can click the red triangle and position it over the G2-M peak.  As 
you move the triangle, the channel position and G2/G1 ratio values update automatically. 

The model created by the Sync Wizard will multiply the G0-G1 peak position and standard deviation by the G2/G1 
ratio appearing on this tab to compute the G2-M mean position and standard deviation.  The position of the G2-M peak 
is always, therefore, dependent on the position of the G0G1 peak.   Similarly, the standard deviation of the G2-M peak 
is dependent on the standard deviation of the G0G1 peak. 

 

=>  Click the S-Phase tab. 
This tab allows you to select what shape you want to use to model S-Phase, how many of them you want to use, and 
how to space them if you use more than one.  Let's change the setting to 5 equally spaced rectangles. 

=>  Change the Number of Compartments to 5. 
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=>  Click the Other tab. 
This tab allows you to enable debris and aggregate subtraction if needed.  The default state of no debris or aggregates 
is fine for this example. 

 

=>  Finally, click the Report tab. 
Here you will find options that let you fine tune the information reported by the Sync Wizard model. 

 

 Running the model 

You are now ready to do the analysis. 
=>  Click the Analyze button on the Synchronization Wizard dialog. 

The Sync Wizard creates the model you just designed, sets some ranges on the data, and fires off the analysis of the 
sample.  You should see results similar to these: 

 
Sync Wizard Model 
  
File: Cho074dn.fcs 
Date acquired: 3-MAR-89 
Date analyzed: 22-Feb-2000 
 
G0G1:  
  98.94 %     Mean: 99.86 
  CV: 2.82 % 
G2M:  
  0.03 %     Mean: 199.71 
  G2/G1: 2.00 
S-Phase:  
  1.02 %     Mean: 128.14 
  
  Compartment 1:  0.65 % 
  Compartment 2:  0.13 % 
  Compartment 3:  0.05 % 
  Compartment 4:  0.09 % 
  Compartment 5:  0.11 % 
  
Modeled Events: 47440 
RCS: 1.209 
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Notice that the S-Phase is reported both as a total percentage and for each of the rectangle compartments in your 
model.  You could at this point add comments, print and save your report.  You do not need to do that for the tutorial.  

You will also notice a floating "Wizard" toolbar is now displayed over the report. 

 

 

 

The first button on the toolbar lets you open and analyze a data file in a single operation.  The second redisplays the 
Synchronization Wizard dialog so that you can edit the model.  And the third lets you exit the Sync Wizard.  These 
options are also available in the Analysis menu, Sync Wizard popup. 

 

Adjusting the model 

Let’s suppose you are interested in just three S-Phase compartments: early, mid, and late S-Phase.  Using 3 
compartments will make the model more conservative in S-Phase.  A more conservative model avoids over estimating 
the S-Phase population.  You can edit the model to do this quite easily.   

=>  Click the second button on the Wizard toolbar.  This is the same as opening the Analysis menu and choosing Sync 
Wizard, Create or edit model.  The Synchronization Wizard dialog is displayed. 

On the Start tab, the Wizard has switched from "Create" to "Edit the current synchronization model" automatically. 

=>  Click the S-Phase tab. 

=>  Change the "Number of Compartments" from 5 to 3. 

=>  Click the Analyze button.  The sample is analyzed again, this time reporting on just 3 compartments in S-Phase. 

 

Opening and analyzing new data files 

Let’s run through several more samples to see what happens to the data. 

=>  Click the first button on the Wizard toolbar.  The Open dialog appears. 

=>  Open the next file.  As soon as the file is loaded, the Sync Wizard analyzes it and the new results displayed.   

=>  Continue opening each subsequent sample.  The S-Phase and G2-M populations begin to increase while the G0-
G1 peak diminishes. 

=>  When you have finished with the Sync Wizard, click the third button on the Wizard toolbar.  The Wizard will ask 
whether you are finished using the Wizard.  Choose Yes to exit the Wizard. 

 

Summary 

The Synchronization Wizard is a tool designed to allow you to easily analyze samples with perturbed S-Phase and G2-
M populations.  It is organized by categories into "tabs" which allow you to describe your data and choose options to 
use in modeling your data. 

Once you have created a model with the Wizard, the Wizard toolbar is displayed.  It provides shortcuts to opening and 
analyzing samples, adjusting the Sync Wizard settings, and quitting the Sync Wizard. 

Control the model’s flexibility by adjusting the shape used and number of compartments in S-Phase.  The default 
setting, 3 rectangles, is good for most cases.  The trapezoid shape more closely approximates the shape of the 
perturbed S-Phase distribution, but it can provide the model too much flexibility. 

 

A Few Additional Notes  
If you save a report with the Wizard toolbar displayed and the Wizard active, you will save the current state of the Sync 
Wizard model in the report.  In this way you can create your own "default" settings for the Synchronization Wizard.  
Simply re-open the report to return to the saved state. 
If you allow the model to "Adjust automatically", you can switch to the Range view and adjust the G0-G1 range so that 
it encompasses the range of channels over which the program can scan for the G0-G1 peak.  If the Sync Wizard does 
not detect any peaks under the G0-G1 range and it is set to "Adjust automatically", it will prompt you with several 
choices: to move the range, to lock the position, or to cancel the analysis. 
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Using the Proliferation Wizard 

 

 This tutorial introduces the use of the Proliferation Wizard, used to analyze cell tracking dye samples. 

You will learn how to start the Proliferation Wizard, how to adjust the settings used to create the model, and how to 
analyze your data samples with the model created.  The primary job is to identify the location of the parent population 
and confirm a few other settings.  Once these simple decisions are made, the Wizard constructs a model that easily 
analyzes your cell tracking samples. 

 

Starting the wizard 

=>  Start ModFit LT if it is not already running. 

=>  Click the File button on the toolbar.  The Open dialog box will appear. 

The files you will use in this tutorial are stored in a folder called "Proliferation" under the ModFit LT directory.   
=>  Navigate to the Proliferation folder and open "nonprol.fcs".  This is the first file you will analyze, the "parent" 
population. 

=>  Choose "FL2-Height Log" as the parameter to analyze. 

=>  Click OK in the Define Gates dialog; we will not define any gates for this example. 

=>  From the Analysis menu, click the Proliferation Wizard popup menu and choose Create or edit model.  The 
Proliferation Wizard dialog will appear. 

 

 

 

Setting up the model 

The tabs across the top of the dialog are labeled with the categories you can adjust in the model.   

The options on the Start tab let you create or edit a model, and also provide an alternate path to open a data file.  
Since you have already opened the file we want to use and are ready to create a model, you do not need to make any 
changes to the Start tab. 

 

=>  Click the Parent tab. 
This tab displays your data file so that you can tell the Proliferation Wizard where the Parent population peak is.  The 
program automatically positions the red cursor over the right-most peak it finds in the sample. 
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=>  Click the red triangle and drag it over the center of the Parent peak, if necessary.  If you would rather type in a 
position, you can edit the Parent channel edit box directly.  Set the position to channel 202 for this example, because it 
is a good approximation of the center of the peak. 

This tab also allows you to “lock” the standard deviation (SD) of the Gaussian component used to model the parent 
population.  This option is most useful when analyzing samples in which there is a great deal of proliferation.  In these 
cases, the parent population is often difficult for the model to resolve, and the modeling process broadens the SD of 
the parent too much.  For this example, leave this option unchecked. 

 

=>  Click the Generations tab. 
Normally, you will not need to make adjustments on this tab.  It allows you to review and edit the number of 
generations to model, the number of log decades in the data sample, and the spacing between generations.   
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If you know the true dynamic range of your cytometer's logarithmic amplifier, you can adjust the value in the Log 
decades field to match.  The wizard will automatically adjust the Spacing value between generations based on the new 
dynamic range. 

In some cases, you may need to adjust the Spacing value directly.   For example, in some tracking dyes, there is not a 
true halving of fluorescence intensity when the cells divide.  This requires a manual adjustment to the spacing. 

The wizard provides two variations for modeling the generations: Standard and Floating.  In the Standard mode, the 
mean position of the Gaussian for each generation is dependent on the position of the parent generation.  For 
example, if the parent population is located at channel 200, the first generation will be located at the parent location 
(200) minus the spacing value (19.19), or 180.81.  The next generation will be 19.19 channels less than the first, and 
so on. 

The floating option allows the mean of each generation to be computed independently of the other populations.  This 
option provides much greater flexibility to the model and will work well for samples with visually distinct generations.  
The floating option is not recommended for samples where generational boundaries are not obvious to the eye. 

For our example, we do not need to adjust any additional settings. 

 

Running the model 

You are ready to analyze the first sample with your model. 
=>  Click the Analyze button on the Proliferation Wizard dialog. 

The Proliferation Wizard creates the model and analyzes the sample.   

 

Percentages and means are reported for the parent and all generation populations.  At this point you could add 
comments, print and save your report.  You do not need to do that for the tutorial.  

You will also notice a floating "Wizard" toolbar is now displayed over the report. 

 

 

 

The first button on the toolbar lets you open and analyze a data file in a single operation.  The second redisplays the 
Proliferation Wizard dialog so that you can edit the model.  And the third lets you exit the Proliferation Wizard.  These 
options are also available in the Analysis menu, Proliferation Wizard popup. 
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Opening and analyzing new data files 

After setting up the model on a non-proliferating sample, you are ready to open and analyze the samples collected at 
subsequent time points.  For our tutorial, we have one proliferating sample. 

=>  Click the first button on the Wizard toolbar.  The Open dialog appears. 

=>  Open the next file, "prol.fcs".  As soon as the file is loaded, the Proliferation Wizard analyzes it and the new results 
are displayed.  We now see some interesting distributions and the percentages for each generation.  Also reported are 
some indices to help quantify the extent of proliferation in the sample. 

 

  

 

Adjusting the model 

You may be interested in trying several other options in the Proliferation Wizard, found in the Other tab.  To try these, 
you need to redisplay the dialog. 

=>  Click the second button on the Wizard toolbar.  This is the same as opening the Analysis menu and choosing 
Proliferation Wizard, Create or edit model.  The Proliferation Wizard dialog is displayed. 

On the Start tab, the Wizard has switched from "Create" to "Edit the current proliferation model" automatically. 

=>  Click the Other tab. 

=>  Enable the Background option by clicking on it.  This will use a rectangle to subtract debris in the sample. 

=>  Click the Asymmetric cytokinesis option.  This option will interpolate along the background rectangle to set the 
standard deviations for the generations.  It yields an analysis result that quantifies the degree of error the cells made in 
dividing in half. 

The other edit field in this group defines the starting generation for "true proliferation."  This value is used in the 
calculation of Upper Generation Proliferation Index and the Precursor Frequency.  For a description of the use of 
Precursor Frequency, see "A flow cytometric method to estimate the precursor frequencies of cells proliferating in 
response to specific antigens", Givan, A., et al, Journal Of Immunological Methods Vol. 230, 1999 Elsevier Science 
B.V. 

=>  Click the Analyze button.  The sample is analyzed again, with slightly different results. 

 

=>  When you have finished with the Proliferation Wizard, click the third button on the Wizard toolbar.  The Wizard will 
ask whether you are finished using the Wizard.  Choose Yes to exit the Wizard. 

 

Summary 

The Proliferation Wizard is a tool designed to allow you to easily analyze samples prepared with cell tracking dyes.  It 
is organized by categories into "tabs" which allow you to describe your data and choose options to use in modeling 
your data. 

Once you have created a model with the Wizard, the Wizard toolbar is displayed.  It provides shortcuts to opening and 
analyzing samples, adjusting the Proliferation Wizard settings, and quitting the Wizard. 
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Enhanced Proliferation Analysis 

 

Features in ModFit LT and WinList provide unprecedented capabilities to analyze cell proliferation.  

ModFit LT performs sophisticated non-linear least squares analysis in just a few clicks of a mouse and reveals the 
secrets of the sample: proliferation index, non-proliferative fraction, and precursor frequency, to name a few.  An 
export feature allows ModFit’s proliferation results to be saved to disk so that other applications can extend the 
analysis. 

 

  

 

This is where WinList comes in.  WinList’s special NStat region can import ModFit LT’s proliferation results and adjust 
itself to partition the generations according to the proliferation analysis.  That simple enhancement sets the stage for 
exciting new analysis capabilities. 
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This tutorial will explore these new features to examine a CFSE-stained sample containing several other markers.  
You will need both ModFit LT (version 3.2 or later) and WinList (version 5.0 with a Build Date of 1 May 2003 or later). 

 

Part 1 

In this section, you will perform a Proliferation Wizard analysis with ModFit LT and export its results.   

=> Launch ModFit LT and pass through the opening dialogs. 

=> Using the Open Data command, navigate to the Samples\Proliferation folder in the application folder.   

=> Select “CFSE sample.fcs” and click Open. 
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=> Choose “P3: FL1-H-CFSE” from the parameter list, and click OK. 

 

  

 

=> Leave the Gate checkboxes unchecked and click OK. 

=> From the Analysis menu, choose Proliferation Wizard, and then Create or edit model. 

=> In the Proliferation Wizard dialog, click the Generations tab. 

=> Choose the “Floating” model option from the drop-down list. 
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=> In the Proliferation Wizard dialog, click the Other tab. 

=> Enable the Export options checkboxes: “Export partition table” and “Prompt for file name”. 

These options will cause the program to create the export file after analysis and allow you to enter a name for the 
export file. 

=> Finally, click the Analyze button to perform the analysis. 

When the analysis is complete, the Save dialog will be displayed.  You can save the file to any location.  

=> For this tutorial, save the export file in the same folder as the data file.  

When you choose the Export option for the Proliferation Wizard, the program determines the boundaries between 
adjacent generations and writes that information to the export file.  The boundaries are the points of intersection 
between the Gaussian components in the model.  An example is shown below. 

 

  

 

Part 2 

In this section, you will set up WinList to import those results into an NStat region. 

=> Launch WinList and pass through the opening dialogs. 

=> Click the Open Data icon on the toolbar. 
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=> Navigate to the ModFit LT folder, and then to the Samples\Proliferation folder. 

=> Select the CFSE sample.fcs file and click Open. 

=> If the Edit Listmode dialog appears, just click OK to close it. 

=> In the Create Histograms dialog, select CFSE for the X axis and CD69 PE for the Y axis.   

=> Click Add to List twice.   

This will create two copies of CFSE vs. CD69 PE. 

 

  

 

=> Click OK to close the dialog. 

Two histograms will be created, each displaying CFSE vs. CD69 PE. 

Now we need to create an NStat region and import the proliferation partitions from ModFit LT. 

 

=> Choose NStat tool from the histogram toolbar for one of the CFSE vs CD69 plotscf. 

 

  

 

=> In the NStat Properties dialog, click the Import button. 

=> Navigate to the folder in which the Proliferation export file was saved. 
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=> Select ProlifWizardPartitions.txt and click Open. 

After the import, the number of columns is automatically changed to 10. 

 

  

 

=> Edit the NStat rows to 1. 

=> Click OK. 

 

=> In the second histogram, create another NStat region. 

=> For this one, set NStat rows to 2, NStat columns to 1, and uncheck other options. 

=> Click OK. 

 

At this point, one of the histograms contains an NStat that shows the proliferation partitions, and the other histogram 
has an NStat that will allow us to define the CD69 negatives and positives. 

=> Adjust the second NStat so that it approximately divides the two major populations in the second histogram, as 
shown. 

 

  

 

At this point, you have completed the basic import process. 
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Part 3 

In this section, you will extend the WinList analysis to explore other markers as a function of the proliferation analysis. 
To better analyze and visualize the generations, we will create a calculated parameter using the FCOM function.  This 
function creates a new parameter that will allow us to look at each population independently.  It uses gates as input, so 
we start by enabling gates for the NStat regions we just created. 

=> Display the Edit Gates dialog by clicking the Gate button on the toolbar. 

=> For gates G1 through G11, set the Activation property to Always enabled.  

 

  

 

=> Click OK to close the Edit Gates dialog. 

=> Choose Edit Data Source from the Edit menu. 

=> Click Add Parameters. 

Now, it’s time for the fun part.   

=> Type this expression into the Equation edit box: 
flog(FCOM(G1,G2,G3,G4,G5,G6,G7,G8,G9,G10)+0.5)*1024/flog(1024)+FRND(10) 

The really important part of this scary-looking equation is the FCOM portion.  The FCOM function takes gates as 
arguments.  For a simple FCOM(G1) expression, the result of the function is either 1 if an event is ”in” the G1 gate, or 
0 if it is “out” of the gate.  When more gates are added to the FCOM expression, there are more and more possible 
values for events.  We are using the FCOM with 10 gates to isolate the generations that ModFit LT’s Proliferation 
Wizard identified earlier.  As you will see, the result  of these FCOM expression will separate these continuous 
distributions into clearly delineated bins.   

 

=> Click the Add button. 

=> Type this expression: 
(FCOM(G11)+0.5)*1024/2+FRND(10) 

This expression will allow us to sort events that are CD69 PE positive and negative. 

 

=> Click the Add Button. 
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=> Click OK. 

 

Let’s create more explanatory names for the two equations we just created. 

=> Click Names and Resolutions. 

=> Click on P8 in the listbox. 

=> In the Name edit box, type Proliferation. 

=> Click on P9 in the listbox. 

=> In the Name edit box, type CD69 Expression. 

 

  

 

=> Click OK. 

=> Click OK to close the Edit Data Source dialog. 

 

We are now ready to explore this data file in really interesting ways.  Wouldn’t it be fascinating to see CD69 as it 
relates to proliferation, viewing each generation independently?  Could we quantify the CD69 expression of CD69-
positive cells for each generation?  Yes, and yes. 

 

=> From the Create menu, choose Histogram. 

=> Choose Proliferation for the X Axis and CD69 PE for the Y Axis. 

=> Click the Graphics button. 

For this display, dots will work better than contours. 

 

=> Enable Show all dots and Color density. 

=> Disable Contours. 
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=> Click OK. 

=> Click OK to close the Edit Histogram dialog. 

A new histogram is displayed.  Let’s create another histogram to isolate the CD69 Positives and Negatives. 

 

=> From the Create menu, choose Histogram. 

=> Choose Proliferation for the X Axis and CD69 Expression for the Y Axis. 

=> Click the Graphics button. 

=> Choose the options you want for this display. 

=> Click OK. 

=> Click OK to close the Edit Histogram dialog. 

Another new histogram is displayed. 

 

=> From the Window menu, choose Arrange All, and then choose Tile.   

This will arrange the histograms so that all 4 can be seen. 

 

  

 

Here, we can see the generations separated into discrete populations along the x-axis.  The Y-axis shows the 
continuous CD69 parameter in the lower-left histogram and discrete subsets of CD69 positives and negatives in the 
lower-right histogram.  Regions can be created to quantify the subsets. 

You can, of course, explore how other parameters relate to cell proliferation.  Simply create additional histogram to 
display the parameter combinations you are interested in. 
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You have done the real work in setting things up with this tutorial.  If you save this setup as a WinList protocol, the 
calculated FCOM parameters, NStat regions, and selected histograms can be recalled very easily by re-loading the 
protocol. 

When you analyze new data files with ModFit LT’s Proliferation Wizard, you can export new partition files.  Then, open 
the same data file into your WinList protocol and re-import the partitions into the NStat region.  All of the calculated 
parameters will update based on the new data and partitions. 
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Creating a report template 

 

One of the best ways to save time with ModFit LT is to design one or more reports to use as templates and save them 
to disk.  You can open a template and use it as the starting point of your analysis, with your customized comments, 
graphics, and layout. 

In this tutorial, we will design a simple report using ModFit LT's built-in text and graphics tools.   

 

=>  If the program is not already running, launch ModFit LT by double-clicking on its icon.  Click the OK button on the 
banner page. 

=>  Click the File button on the toolbar or choose Open->Data from the File menu.  Choose one of the sample files, 
and then click Open to load it. 

You will see a histogram, but no results.  In order to display the results, we have to analyze the data. 

=> Click the Auto button to automatically analyze the sample.  Once finished, ModFit LT will show us the results in 
textual format.  

=>  Click the Report button to display the report toolbox.  This puts ModFit LT into report editing mode. 

 

Suppose that we want to create a report that looks something like the one pictured below. 

 

We have added four objects to this report and moved things around a bit.  The top of the report contains a circle, 
arrow, and title text, and there is a new free-form text object at the lower right of the report.   

We will build a report template like this example. 

 

Building the example 

=>  Adjust the Zoom  so that you can see the whole report page on the screen. 

=>  Click the histogram graphic and drag it down the report page about two inches. 

=>  Click the results text and drag it down the page, as well.  Align the top of the text with the top of the graphic. 

=>  Click the S-Phase assessment text under the graphic and move it down.   

=>  From the report toolbox, click the Ellipse tool   .  This will insert a circle onto the report page. 

=>  Drag the circle to adjust its position to resemble the example. 

=>  Click the Arrow tool in the report toolbox   .  An arrow will be inserted into the report. 

=>  Drag the arrow so that its tip is next to the right hand side of the circle.  Then, click and drag the other end of the 
arrow across the page to form a horizontal line. 
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=>  Click the Text tool in the report toolbox   .  The Edit Text dialog will appear. 

=>  Click the Font button to display the font dialog.  Increase the font size to 26.  You can change the font and color as 
well.  Click OK when you are done adjusting the font. 

=>  Type "My Very Own DNA Report" (or some other title if you must) into the text edit box, then click OK.  The text is 
inserted into the report. 

=>  Move and resize the text so that it is positioned correctly over the arrow.   

 

OK, we have just one more item to add.  Take a deep breath. 

=>  Click the Text tool once again.  In the Edit Text dialog, type a comment that you might make about the data you 
analyze.  Then click OK. 

=>  Move this last text to the lower right portion of the report page.  You may want to align it with the top of the S-
Phase assessment text. 

 

Great.  You are done.  All that is left is to save the report under some name that we will remember. 

=>  From the File menu, choose Save As.  In the File Save dialog, enter the name "PRACTICE".  Click the Save 
button.  

 

Using the template 

Wonderful.  The report has been saved.  So how does one use a report as a template?  It is really quite simple.   

When you launch ModFit LT, open the report you want to use.  In our example, that is "PRACTICE".  Once the report 
is loaded, open a new data file, and analyze it.  All of the results in the template reflect the new sample.   

If you save reports for each sample, you would save the report using either the File menu Save As, or the Save 
button on the toolbar that automatically names the report based on the data file loaded.  Your template will remain 
untouched as long as you save each new analysis under a new name. 

If you want to protect your reports from someone accidentally overwriting them, you can make them "read-only".  On 
the Macintosh, use the Finder's Get Info to make the report a "Stationery pad".  Whenever you open it into ModFit LT, 
it will open a copy of the report and leave the original untouched.  On the PC, use the file Properties option to change 
the file to "Read Only".  If someone accidentally tries to save a report by the same name, the system will force them to 
choose a new name for their report. 

Of course there is a lot more you can do to customize your report template.  Look at some of the sample reports 
provided with the program, and experiment with some designs of your own.   

Note: If you have saved reports with a previous version of ModFit LT, you should load them into this version of the 
program and save them again to upgrade them to the latest version format. 

 

Summary: You can design report templates that include graphics, text, and the layout you want.  Templates can be 
opened in ModFit LT and used as the starting point for the analyses you do with the program.  They can save you time 
and energy, since you design them only once and use them over and over again.  
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Field Testing ModFit LT 

 

This section provides a step-by-step process for testing the functions of ModFit LT in your lab.  It uses the sample data 
files shipped with the program, and allows us to compare the results you see in your lab with those we have on file at 
Verity.  

In order to perform this process, you must log in to the program as an Administrator or Advanced User.  This is 
required because you will need access to the Auto Analysis Settings and Peak Finder Settings dialog boxes. 

Please be sure to follow each step carefully. 

 

=>  If the program is not already running, launch ModFit LT by double-clicking on its icon.  Click the OK button on 
banner page.  Log in as an Administrator or Advanced User.  

=>  Choose Auto Analysis Settings from the Edit menu.   

=>  Scroll to the bottom of the dialog and click the Reset button. 

=>  Click the OK button.  If prompted, do not save changes as default settings or you will change your configuration.  
The settings will only be applied to this session of ModFit LT. 

=>  Choose Peak Finder Settings from the Edit menu.   

=>  Scroll to the bottom of the dialog and click the Reset button. 

=>  Click the OK button.  If prompted, do not save changes as default settings or you will change your configuration.  
The settings will only be applied to this session of ModFit LT. 

=>  Choose Options and Configuration from the Edit menu.   

=>  Scroll to the bottom of the dialog and click the Reset button. 

=>  Click the OK button.  If prompted, do not save changes as default settings or you will change your configuration.  
The settings will only be applied to this session of ModFit LT. 

 

The program is now in its default configuration.   

 

=>  Click the File button on the toolbar or choose Open->Data from the File menu.  Find SAMPLE1.FCS and select it, 
then click Open to load it. 

=>  Click the Auto Analysis button.   

=>  Click the Print button.    

 

=>  Click the File button and load in SAMPLE2.FCS. 

=>  Click the Auto Analysis button.   

=>  Click the Print button.    

 

=>  Click File button and load in SAMPLE3.FCS. 

=>  Click the Auto Analysis button.   

=>  Click the Print button.    

 

=>  Click File button and load in SAMPLELM.FCS. 

=>  Choose P5:  FL2-A for the DNA parameter.  Click OK. 

=>  Choose OK in the Define Gates dialog. 

=>  Click the Auto Analysis button.   

=>  Click the Print button.    

 

=>  Send the reports to Verity Software House, Attention: Customer Support,  P.O. Box 247, Topsham, ME 04086 or 
FAX them to (207) 729-5443. 
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Reference 

File menu 

New command (File menu) 

 

Use this command to create a new document in ModFit LT. 

You can open an existing document with the Open->Report command. 

Shortcuts 

Keys: CTRL + N on PC;  Command + N on Mac 
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Open Report command (File menu) 

 

Use this command to open an existing ModFit LT report document.  Choosing this option will display the File Open 
dialog to select file(s) to open.   

A Report document contains an analysis of data and possibly additional report objects that you add to the document.   

A batch of reports may be selected at one time.  When more than one report is selected, the Report Batch Settings 
dialog is displayed to allow you to set options for batch processing.  Then, the Report Batch toolbar will be displayed at 
the lower right side of the application window.  This toolbar will allow you to navigate through the selected reports, and 
provides additional batch processing options. 

To select a batch of reports, click the mouse on the first item you want to select and drag the mouse over sequential 
files in the list.  Alternately, you can click the first item, hold down the Shift key and click the last item to select a group 
of files.  Hold down the CTRL key to select non-adjacent files in the list.   

 

Shortcuts 

Keys: CTRL + O on PC;  Command  + O on Mac 



Reference 

71 

Open Data command (File menu) 

 

Use this command to open a data file.  Choosing this option will display the File Open dialog to select a file to open. 

A data file is a Flow Cytometry Standard format histogram or listmode data file.  You can load one data file at a time 
into a report document.   

A batch of files may be selected at one time.  When more than one data file is selected, the File Batch Settings dialog 
is displayed to allow you to set batch processing options.  Then, the File Batch Toolbar is displayed at the lower left 
side of the application window.  This toolbar will allow you to navigate through the selected files, and provides 
additional batch processing options. 

To select a batch of files, click the mouse on the first item you want to select and drag the mouse over sequential files 
in the list.  Alternately, you can click the first item, hold down the Shift key and click the last item to select a group of 
files.  Hold down the CTRL key to select non-adjacent files in the list.   

 

See also: 

Batch Processing  

 

Shortcuts 

Toolbar:  

Keys: CTRL + F on PC;  Command  + F on Mac 
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File Open dialog box 

 

This dialog is used to open both reports and data files in ModFit LT.  This is the standard File Open dialog box for the 
operating system, so its appearance and features are different on Windows and Mac versions. 

 

  

 

Files 

You can select one or more files from the list.  If more than one file is selected, files can be opened sequentially using 
the batch control toolbars that will appear at the bottom of the application window. 

If the file you select is an FCS listmode file, additional dialog boxes will be displayed after you click the Open button.  
See the section on Listmode for details. 

 

Files of Type 

Select the type of file you want to display in the Files listbox. 

 

Open 

Click this button to open the first selected file and close the dialog. 

 

Cancel 

Click this button to cancel the save operation. 
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Save command (File menu) 

 

Use this command to save the active document to its current name and directory or folder.  When you save a 
document for the first time, ModFit LT displays the Save As dialog so you can name your document.  If you want to 
change the name and directory of an existing document before you save it, choose the Save As command. 

Shortcuts 

Keys: CTRL + S on PC;  Command + S on Mac 
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Save As command (File menu) 

 

Use this command to save and name the ModFit LT report document.  ModFit LT displays the Save As dialog so you 
can name your document.   

To save a document with its existing name and directory or folder, use the Save command. 
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File Save As dialog box 

 

This dialog is used to save reports in ModFit LT. This is the standard File Save dialog box for the operating system, so 
its appearance and features are different on Windows and Mac versions. 

 

  

 

Files 

You can select a file from the list or enter a name in the “Save As” edit box. 

 

Save as Type 

Select the type of file you want to display in the Files listbox. 

 

File name 

Type the name for the report in this edit box.   

 

Save 

Click this button to save the report and close the dialog. 

 

Cancel 

Click this button to cancel the save operation. 
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Export Histogram Graphic 

 

Use this command to export the graphics for the histogram to a file on disk.  The format of the graphic can be selected 
using the Options and Configuration dialog.  Supported formats currently include bitmap (bmp), JPeg (jpg), Tiff (tif), 
Portable Network Graphics (png), Portable Pixmap (ppm), X11 Bitmap (xbm), and X11 Pixmap (xpm).  

   

When you select this option, the File Save dialog is displayed.  Navigate to the location where you want to store the 
graphic file, and then enter a name for the file.  Click the Save button to store the file on disk. 

Exporting is also available in batch processing.  See File Batch Settings and Report Batch Settings for more. 
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Export Report Graphic 

 

Use this command to export the graphics for the entire report to a file on disk.  The format of the graphic can be 
selected using the Options and Configuration dialog.  Supported formats currently include bitmap (bmp), JPeg (jpg), 
Tiff (tif), Portable Network Graphics (png), Portable Pixmap (ppm), X11 Bitmap (xbm), and X11 Pixmap (xpm).  

  

When you select this option, the File Save dialog is displayed.  Navigate to the location where you want to store the 
graphic file, and then enter a name for the file.  Click the Save button to store the file on disk. 

Exporting is also available in batch processing.  See File Batch Settings and Report Batch Settings for more. 
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Print command (File menu) 

 

Use this command to print a ModFit LT report to the selected printer.  The Print dialog box is displayed allowing you to 
select printing options.   

Shortcuts 

Toolbar:   (Prints without options) 

Keys: CTRL + P on PC; Command + P on Mac 
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User Login 

 

Use this option to display the User Login dialog box, used to enter the User name and set the User group for the 
current user.  See User Group Permissions for information about what functions each user group can perform in the 
program.  Passwords are pre-defined for each user group, and supplied with the software. 

This dialog is automatically displayed each time the program is started. 

 

  

 

User name 

Enter your name in this edit box. 

 

User group 

Select the user group to which you belong.  Each user group has different permissions within the program.  See User 
Group Permissions for details. 

 

Password 

If your user group requires a password, enter the appropriate password in this field. 

 

Click OK to confirm your entries and close the dialog.  You will be alerted if your password is incorrect for the selected 
User group. 

 

Click Cancel to close the dialog.  If the dialog is cancelled as the program is starting up, the User group will be set to 
the most restricted group. 
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User Group Permissions 

 

ModFit LT supports several different User Groups, each having access to different functions in the program.  The User 
group is selected in the User Login dialog, displayed as the program starts up. 

Three user groups are available:  Standard user, Advanced user, and Administrator.  The Standard user group does 
not require a password.  Advanced and Administrator groups each require a separate password, supplied with the 
software. 

An Administrator can configure the program so that passwords are not required for any user group.   See Options and 
Configuration for details. 

The table below summarizes the permissions of each group. 

Operation Standar
d 

Advanc
ed 

Administrat
or 

Edit Model Colors Yes Yes Yes** 

Full Edit Model No Yes Yes 

Edit Database Map No Yes Yes 

Edit Auto Analysis Settings Limited* Yes Yes** 

Edit Peak Finder Limited* Yes Yes** 

Edit Options and 
Configuration 

Limited* Yes Yes** 

Edit S-Phase Cutoffs No No Yes** 

 

* Only basic options are available to Standard users in advanced dialogs.  

** Only Administrators can save settings as default for the program.  When an Administrator closes one of these 
dialogs by clicking OK, the program will prompt, "Do you want to save these settings as program defaults?"  Choosing 
"Yes" will store the settings to the program's preference file, and the program will use these settings each time it is 
started.  Choosing "No" will make the settings apply only to the current session. 
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Recent Files command (File menu) 

 

This menu is a convenient list that shows the most recent data files that have been opened in ModFit LT.  Select a file 
from the list to open the file for analysis. 
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Recent Reports command (File menu) 

 

This menu is a convenient list that shows the most recent report files that have been opened in ModFit LT.  Select a 
file from the list to open the report. 
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Exit (Quit) command (File menu) 

 

This option is called Quit on the Macintosh version. 

Use this command to end your ModFit LT session.  You can also use the Close command on the application Control 
menu in PC versions. 

Shortcuts 

Keys: ALT + F4 on PC;  Command + Q on Mac 

Edit menu 

Copy command (Edit menu) 

 

Use this command to copy the report or a single object to the clipboard.  This command is unavailable if there is no 
data currently loaded into the program. 

Copying to the clipboard replaces the contents previously stored there. 

To copy a single object, click the object to select it, then choose the Copy command.  The object will be placed in the 
clipboard. 

To copy the entire report, make sure no object is selected in the report, then choose the Copy command.  The report 
will be copied as a graphic image to the clipboard. 

 

Shortcuts 

Keys: CTRL + C on PC;  Command + C on Mac 
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Paste command (Edit menu) 

 

Use this command to insert a copy of the clipboard contents onto the report.  This command is unavailable if the 
clipboard is empty or if ModFit LT does not support the format of the data. 

When the clipboard contains more than one format at a time, ModFit LT prompts you to select the format you want.  
Select the format you want from the list and click OK to paste the object. 

After it is pasted, the object may be selected and dragged to a new location on the screen. 

Supported formats include the following: 

PC version: Text, Bitmap 

Mac version: Text, Bitmap 

 

Shortcuts 

Keys: CTRL + V on PC;  Command + V on Mac 
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File Batch Settings (Edit menu) 

 

This option displays the Edit Properties for File processor dialog box, allowing you to choose what happens during 
batch processing of data files.  The dialog is displayed automatically when you select more than one data file for 
analysis. 

 

  

 

Batch processing options apply when you select more than one data file in the Open Data dialog box.  When more 
than one file is selected, the File Batch toolbar is displayed at the lower left portion of the application window.  You can 
navigate through the batch one file at a time, or auto-advance through the batch.   

 

Analysis 

Choose what analysis option you want to occur when a new data file is opened.  The options available are listed 
below: 

No analysis: No analysis is performed. 

Auto-analyze: Automatic Analysis is run on each data file. 

Fit with current model:  The Execute Model command is executed on each data file. 

 

Save Report 

Enable this option to automatically save a report for each data file.  The report is automatically named using the Auto 
Save Report command.  Saving occurs after any analysis has been performed, and again when moving to another 
batch item. 

 

Save Report Path 

If the Save report option is enabled, reports will be saved to the path shown here.  Click the Folder button to select a 
new location for reports. 

 

Print Report 

Enable this option to automatically print a report to the current printer.  Printing occurs when moving to another batch 
item. 

 

Save Graphics 

This option allows you to save graphics for the histogram or report.  Graphics are automatically named based on the 
data file that is loaded, as described in Export Histogram Graphic and Export Report Graphic.  The save operation 
occurs when moving to another batch item.  The options available are listed below: 

No: No graphics are saved to disk. 

Histogram: Histogram graphics are saved. 

Report:  Report graphics are saved. 
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Histogram and Report:  Both Histogram and Report graphics are saved. 

 

Database prompt 

Enable this option if you want to be prompted to store the analysis in any active databases.  If you clear this checkbox 
and databases are active, records will be stored without prompting.  If databases are inactive, this option is ignored. 

 

File prompt 

Enable this option if you are opening listmode files and you want the program to allow you to change the selected 
parameter or gates, or if you are opening histogram files with multiple histograms in each and need to select the 
histogram of interest. 

 

Multi Dataset prompt 

Enable this option if you are opening files that contain more than one FCS dataset.  For example, Beckman Coulter 
FC-500 files are often stored with 2 datasets: one containing 10-bit FCS 2 data, and the second containing 20-bit FCS 
3 data.  In order to select a dataset, this option must be enabled. 

Once you have selected a dataset, you can disable this option and process an entire batch of files without having the 
prompting dialog appear. 
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File Batch Toolbar 

 

This toolbar is displayed at the lower left of the ModFit LT application window when you select more than one file in 
the Open Data dialog.  

 

  

 

Most of the buttons on the toolbar are used to navigate through the batch.  The leftmost button is used to edit the 
properties of the batch processor.  See File Batch Settings for more on file batch properties. 

 

As you navigate through the batch, the actions and options in the File Batch Settings dialog are performed on each file 
that is opened.  This allows you to perform a series of automatic operations just by moving to another batch item, such 
as automatic analysis, saving and printing reports.  The function of each button is described below. 

  

Edit the properties of the batch. 

 

Display the Choose Batch dialog to select a batch item to 
open. 

  

Go to the first file in the batch. 

  

Go to the previous file in the batch. 

  

Redo the current file in the batch. 

  

Go to the next file in the batch. 

  

Go to the last file in the batch. 

  

Auto-advance through the batch. 

  

Stop the auto-advance process. 

 

Help for the batch toolbar. 

 



ModFit LT User Guide 

88 

Choose Dataset 

 

  

 

This dialog is displayed to allow you to select a dataset for analysis in a file that contains more than one dataset.  It is 
displayed if the “Multi Dataset prompt” is enabled in the File Batch Settings dialog. 

The dialog displays some information about each dataset, based on keywords it finds and evaluates in the datasets.  
Choose the dataset that you want to analyze, then click the OK button to continue opening the file. 
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Choose Batch Dialog 

This dialog is displayed when the Choose button on the File Batch or Report Batch toolbar is clicked.  It allows you to 
choose a batch item to open. 

 

  

 

The listbox displays all items in the batch.  To select an item, click on it in the list and click OK.  The item will be 
opened. 

Click Cancel to close the dialog without changing the batch item. 
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Report Batch Settings (Edit menu) 

 

This option displays the Edit Properties for Report processor dialog box, allowing you to choose what happens during 
batch processing of reports.  The dialog is displayed automatically when you select more than one data file for 
analysis. 

 

  

 

Batch processing options apply when you select more than one report in the Open Reports dialog box.  When more 
than one report is selected, the Report Batch toolbar is displayed at the lower right portion of the application window.  
You can navigate through the batch one report at a time, or auto-advance through the batch of reports.   

 

Analysis 

Choose what analysis option you want to occur when a new data file is opened.  The options available are listed 
below: 

Auto-analyze: Automatic Analysis is run on each data file. 

Fit with current model:  The Execute Model command is executed on each data file. 

Fit and do AutoLinearity:  An AutoLinearity adjustment is performed for each report, and the model is finally fit 
with the best linearity setting.  See Using AutoLinearity for more on this option. 

No analysis: No analysis is performed. 

 

AutoAddZoomObjects 

Enable this option to automatically add an X-Zoom and Y-Zoom graph to each report that is processed.  These objects 
allow close examination of the low level events such as debris, aggregates, and S-Phase, and provide a magnified 
view of the area around the Diploid G1 peak. 

 

Save Report 

This drop-down provides three report saving options described below.  Saving occurs after any analysis has been 
performed, and again when moving to another batch item. 

Don't re-save report:  The report is not resaved. 

Re-save report:  The report is resaved, using the save report name. 

Auto-name and save report:  The report is resaved using the Auto Save Report command.  The name of the 
report may change from the original name with this option. 

 

Print Report 

Enable this option to automatically print the report to the current printer.  Printing occurs when moving to another batch 
item. 

 

Save Graphics 
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This option allows you to save graphics for the histogram or report.  Graphics are automatically named based on the 
data file that is loaded, as described in Export Histogram Graphic and Export Report Graphic.  The save operation 
occurs when moving to another batch item.  The options available are listed below: 

No: No graphics are saved to disk. 

Histogram: Histogram graphics are saved. 

Report:  Report graphics are saved. 

Histogram and Report:  Both Histogram and Report graphics are saved. 

 

Database prompt 

Enable this option if you want to be prompted to store the analysis in any active databases.  If you clear this checkbox 
and databases are active, records will be stored without prompting.  If databases are inactive, this option is ignored. 
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Report Batch Toolbar 

 

This toolbar is displayed at the lower right of the ModFit LT application window when you select more than one file in 
the Open Reports dialog.  

 

  

 

Most of the buttons on the toolbar are used to navigate through the batch.  The leftmost button is used to edit the 
properties of the batch processor.  See Report Batch Settings for more on report batch properties. 

 

As you navigate through the batch, the actions and options in the Report Batch Settings dialog are performed on each 
file that is opened.  This allows you to perform a series of automatic operations just by moving to another batch item, 
such as rerunning the analysis and printing reports.  The function of each button is described below. 

  

Edit the properties of the batch. 

 

Display the Choose Batch dialog to select a batch item to 
open. 

  

Go to the previous report in the batch. 

  

Redo the current report in the batch. 

  

Go to the next report in the batch. 

  

Go to the last report in the batch. 

  

  

Auto-advance through the batch. 

  

Stop the auto-advance process. 

 

Help for the batch toolbar. 

 



Reference 

93 

Databases (Edit menu) 

 

Purpose:  To add, delete or edit one or more databases.  See Databasing with ModFit LT for more on databases. 

 

The Edit All Databases dialog can be displayed by choosing Edit Databases from the Edit menu. 

 

  

 

Overview 

ModFit LT can have one or more databases defined at any time.  The database format is ASCII-formatted, tab-
delimited database.  Any FCS keyword or analysis result can be mapped to a database field.  A complete description 
of the functionality of the database system can be found in the Databasing with ModFit LT discussion. 

 

Edit 

If a database is selected, this option shows the Edit Keyword Map dialog box.  You can also double-click the database 
item to activate this option.  Note:  This option will not be available if you log in as a Standard User.  Only Advanced 
Users and Administrative Users can edit the structure of the databases. 

 

Properties for the selected item 

This button appears in the group of buttons below the listbox.  It allows you to edit properties for the selected item in 
the list.   

If a database is selected, the Edit Properties for Databasen dialog will be displayed. 

 

Duplicate 

If a database is selected, this option creates a new database.  You may edit the name of the database by clicking on 
the name, and after a brief pause, clicking again.  The name will then appear in an edit box. 

 

Delete 

This option will delete the selected database from the list. 

 

OK 

Put away the Edit All Databases dialog box. 

 

Properties 

This button edits properties for the containing object.  

The Edit Properties for All Databases dialog box will be displayed.   

 

Help 

Show this help topic. 
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Edit Properties for All Databases 

 

Purpose:  To perform actions that will apply to all databases in the Edit All Databases. 

 

Choosing Edit Databases from the Edit menu, then clicking the Properties button can display the Edit Properties for All 
Databases dialog.  Note: Make sure nothing is selected in the Edit All Databases list when clicking the Properties 
button. 

 

  

rf_AllDatabasesProperties.bmp 

 

Overview 

The dialog is displayed when the Properties button is clicked in the Edit All Databases dialog, and no databases are 
selected in the list.   It allows you to perform action on all of the defined databases at once. 

 

Activate all 

Activates all databases.  When a database is active, it can store records of information as you analyze files in WinList. 

 

De-activate all 

Disables all databases.  No database will store information until it is reactivated. 

 

Delete files 

Removes all database files on disks for databases in the Edit All Databases dialog.  This is a convenient file 
management button, but should be used with great caution.  Make sure you have adequate backup copies of 
important databases before using this option. 

 

OK 

Close the dialog and accept changes. 

 

Cancel 

Since the options in this dialog box are immediate, Cancel is the same as clicking OK. 

 

Help 

Show this help topic. 
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Edit Properties for Database 

 

Purpose:  To activate, display, and set other attributes of a database.  See Databasing with ModFit LT for more on 
databases. 

 

The Edit Properties for Database dialog can be displayed by choosing Edit Databases from the Edit menu, selecting 
the database you want, then clicking the Properties button.   If the Database Viewer is displayed, clicking a button on 
the viewer's toolbar can also access this dialog. 

 

  

databasetut5.bmp 

 

Overview 

Each database can be activated independently.  Additionally, the database can be set for prompting or automatic 
mode, and a viewer window can be displayed.  This dialog also allows you to set the path and other properties for the 
database. 

 

Active 

Check this option to activate the database.  When the database is active, it will attempt to store a record each time an 
analysis is performed.  Uncheck this option to disable a database; records will not be saved in databases that are not 
active. 

 

Prompting 

Check this option if you want ModFit LT to prompt you each time it is ready to save a record.  The prompt will allow 
you to confirm or cancel the saving of the record into each active database.  Uncheck this option for automatic 
operation where ModFit LT stores the information without prompting. 

 

Viewer 

Check this option to display a Database Viewer for the database.  The viewer displays the fields in columns and each 
row represents a record in the database.  Additional options are available on the viewer window. 

 

Viewer Font Size 

Select a font size to use for the database viewer. 

 

Choose database 

This option allows you to choose an existing database on disk.  Click the "Link to" button.  A file selection dialog box 
will appear, allowing you to navigate to the existing database and select it.  Linking to an existing database will rename 
the database in memory to match the one selected on disk, and the associated database map on disk will be loaded 
as well. 

 

Change location 

This option allows you to change the path for the defined database.  Click the "Path" button to display a Choose 
database location dialog.  Navigate to the location in which you want to store the database. 
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If a database of the same name already exists in that folder, you will be offered three choices.  First, you can choose 
to overwrite the database with the one you have defined.  Secondly, you can choose to use the database that exists in 
the new location, replacing the structure you have defined in memory.  This is convenient if you have a database 
already defined that you want to use.  Or you can choose to cancel the action. 

 

OK 

Save property settings and put away the Edit Properties for Databasen dialog box. 

 

Cancel 

Close the dialog and discard any changes you have made. 

 

Help 

Show this help topic. 
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Edit Keyword Map 

 

Purpose:  Select the information you want to save in a database.  See Databasing with ModFit LT for more on 
databases. 

 

The Edit Keyword Map dialog can be displayed by choosing Edit Databases from the Edit menu, selecting the 
database you want to edit, then clicking the Edit button.  If the Database Viewer is displayed, clicking a button on the 
viewer's toolbar can also access this dialog. 

 

  

databasetut4.bmp 

 

Overview 

Each database in ModFit LT has its own structure, made up of a set of keywords to database and a matching set of 
fields in a database.  The Edit Keyword Map dialog determines how the keywords are "mapped" to fields in the 
database. 

 

Results Tree 

This tree expands to display all of the available groups of keywords and the keywords in each group.  A branch of the 
tree can be expanded by double clicking the mouse on it.  Select a branch of the tree by clicking once on it. 

This tree is used to select the keywords you want to store in the database.  It allows multiple selection.  See the 
discussion in Databasing with ModFit LT for more on proper selection of information to database.  

 

Map Definition 

This list displays the field names and the keywords they relate to.  The first column showing the field name can be 
edited; other columns are for display only.  To edit a field name, click once on the field to select it, then click again 
after a moment to enter edit mode. 

 

Add 

Click this button to add the keywords selected in the Results Tree to the database definition shown in the Map 
Definition list.  Fields are named automatically to show the source of the information.  You can also double-click on a 
keyword to add it to the definition. 

 

Replace 

The option is available when you select an item in the tree and an item in the Map Definition list.  It allows you to map 
a new keyword to an existing field in the database. 

 

Up/Down 
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These buttons allow you to change the order of fields in the Map Definition list.  Select one or more fields in the list, 
and then use the Up and Down buttons to move the item(s). 

 

Delete 

Click this button to delete the fields selected in the Map Definition list from the database.  

 

OK 

Save changes to the database.  If records already exist in the database, the structure of the records will be revised to 
match the new structure you have defined.   

 

Cancel 

Close the dialog and discard any changes you have made. 

 

Help 

Show this help topic. 
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Database Viewer 

 

Purpose:  Display the contents of a database. 

 

The Database Viewer can be displayed by choosing to show the viewer in the database properties.  To do so, choose 
Edit Databases from the Edit menu, select the database you want, and then click the Properties button.   In the Edit 
Properties for Database dialog, enable the viewer and click OK. 

 

  

rf_dbviewer.bmp 

 

Overview 

This window can be displayed for any database you have created.  The viewer displays the fields defined in the 
database as column headings.  Each record in the database is shown as a row of information.  The window can be 
scrolled horizontally and vertically if there is information out of view.  Each column can be resized by dragging the 
partition between the column headings with the mouse. 

 

  

rf_viewertool.bmp 

 

At the top, a toolbar provides buttons to manually add, delete, and replace records.  When the "+" (add) button is 
clicked, the current analysis information is added to the database.   

Click the "-" (delete) button to delete the selected records from the database; if the button is grayed, there are no 
records selected.   

Click the replace button to store the current analysis into an existing record in the database. 

 

Additional buttons activate and deactivate the database, display the Edit Keyword Map dialog, display the Edit 
Properties for Database dialog, and backup the database.  

 

See Databasing with ModFit LT for more on databases. 
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Colors command (Edit menu) 

 

Use this command to adjust colors used for the model graphics.  You can change color, fill style, and transparency for 
colors in the current model.  The changes you make can also be remembered and applied to other models. 

 

 

 

Component List 

To choose a new color for a model component, click the color swatch next to the component.  The standard dialog for 
choosing colors will appear.  Select a new color and click OK.   

 

To choose a new fill style for a model component, click the sample fill for the component.  A drop-down list of choices 
will appear.  Select a new fill style from the list.   

 

Each component can either be transparent or opaque.  This determines how overlapping components are drawn.  To 
make a component transparent, enable the checkbox in the Transparent column.  Uncheck the option to make a 
component opaque. 

 

OK 

When you click OK, you will be asked whether you want to apply the changes to all models, or just the current model.  
If you choose to apply to all models, the changes are stored for future sessions of ModFit LT.  If you choose to apply 
the changes only to the current model, the changes will be lost when you load a new model, perform an Auto Analysis, 
or close the program. 

 

Reset All 

Click this button to clear all color selection overrides. 

 

Cancel 

Click this button to discard changes to colors. 
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Quick Model Editor 

 

Overview 

The Quick Model Editor allows you to make changes to the current model.  It is available when the model you are 
using is created by AutoAnalysis or by using the Choose Model option. 

Changes you make with this dialog are applied to the model when you click OK.  In order to see the changes to the 
model, you need to re-analyze the data by clicking the Fit button or choosing Execute Model from the Analysis menu. 

 

  

 

AutoDebris 

This checkbox determines whether the AutoDebris model component is active or not.  When checked, AutoDebris is 
activated.  The AutoDebris component is used to model debris in data.  It can be left active even when samples 
display little or no debris, because its shape and amplitude are based on probability distributions unique to each 
sample. 

 

AutoAggregates 

When this option is checked, the AutoAggregates model component is activated.  This component is used to model 
the continuum of aggregate forms found in many samples.  It can be left active even when there is little or no 
aggregation in the sample, because its shape and amplitude are based on probability distributions unique to each 
sample 

 

Linearity 

This field modifies the appropriate G2M dependency settings and modifies the aggregate model componentlinearity 
setting.  When the user indicates that a G2M is not visible, the program makes the position and standard deviation of 
the G2M model component dependent on the G1 by this linearity setting.  It updates the linearity setting for the 
aggregate model component as well. 

 

AutoLinearity 

When this option is checked, the program tries a number of linearity settings when executing a model, searching for 
the one that results in the least reduced chi-square (RCS) value.  The beginning, ending and increment values are 
stored in the Options and Configuration section of the program. Since this option can be rather time consuming, it is 
recommended to be done only after the appropriate model has been selected. 

 

Internal standards 

This option determines the number of peaks attributed to standards.  Standard peaks typically occur below the first G1 
peak.  However, you can configure the expected locations for standards in your samples using the Auto Analysis 
Settings dialog box. 
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G2M Section 

The options in this section of the dialog allow you to control how the G2M for each cycle is modeled.  If the option is 
checked (Visible), the program will use the associated G2M range to estimate the position and it will allow that position 
to be adjusted by the modeling process.  If the option is not checked, the position of the G2M will be computed by 
multiplying the G1 position by the linearity value. 

Generally, if a G2M is a well-defined peak that does not overlap another peak, you can enable the option and model 
will provide a more accurate result.  However, if the G2M peak is not clearly defined or if it substantially overlaps 
another peak, uncheck the option.  If the option is checked when a peak is not well defined, the model will produce 
less accurate results. 

 

S-Phase Section 

The options in this section control the state of the S-Phase model component for each cell cycle in the model.  If a 
check appears in the checkbox, the S-Phase component is active and the program will attempt to model it.  Clear the 
check to disable the S-Phase component for the model. 

In samples such as near Diploid histograms, the S-Phases of two or more cycles can be significantly overlapped.  This 
can create problems for the modeling process.  In these cases, it is better to disable one of the S-Phase components, 
normally the Diploid S-Phase. 

 

AutoDebris Section 

NOTE: These options will only appear if you have logged into the program as an Advanced user or Administrator.  
Only experienced users with specific problems to resolve should adjust these settings.  The vast majority of users do 
not need to make any adjustments, and making adjustments may make lab-to-lab or file-to-file comparisons difficult.   

The AutoDebris component is composed of 3 simpler debris-fitting sub-components.  Each sub-component is 
designed to simulate a certain average number of nuclei fragments.  The settings below allow you to adjust the 
assumptions of these three interdependent pieces of the AutoDebris system.   See Options and Configuration for 
additional discussion of this feature. 

First cut number 

This value defines the number fragments assumed by the first debris component.  By default it is 1, which allows it to 
model distributions created by each nucleus splitting once in the sample preparation. 

Second cut number 

This value defines the second debris distribution.  By default it is set to 5, which corresponds to nuclei that have been 
randomly cut five times.  A value of zero turns both the second cut number and third cut number distributions off. 

Third cut number 

This value defines the third debris distribution.  By default it is set to 12, which corresponds to nuclei that have been 
highly fragmented.  A value of zero turns this distribution off. 

 

OK 

Apply the settings to the current model and put away the dialog box. 

 

Cancel 

Close the dialog and discard any changes you have made. 

 

Reset 

This option resets the the properties in this dialog to their default states. 
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Full Model Editor (Edit menu) 

 

  

 

This dialog allows editing of existing models and creation of new models.  It can be used to change any and all 
aspects of a model, and therefore should be used with great care.   

 

NOTE: This option is only available if you have logged in to ModFit LT as an Advanced User or Administrator.  The 
model editor is useful to the small fraction of users who need to create or edit models out of the norm. 

The listbox displays the aspects of the model that can be edited: components, ranges, and equations.   

 

Components: 

Components of the model define the mathematical pieces and their interdependencies.  There are components to 
model debris, aggregates, peaks, and broad distributions.  Each component, in turn, has a set of details that further 
describe the properties of the component.  See Edit Properties for Component for more on this topic. 

Ranges: 

Ranges are used to provide estimates for the model components.  They are displayed when you click the Range 
button on the toolbar, or Position Ranges from the Analysis menu.  Most ranges are used to identify peaks in the 
model, and associated model components use the range position, size, and statistical data as a starting point in the 
modeling of the histogram.  See Edit Ranges for more on this topic. 

Equations: 

Equations are expressions used to display the result of the modeling process.  They can show simple information, 
such as keywords stored in the data file, or sophisticated mathematical expressions based on details of model 
components.  See Edit Equations for more on this topic. 

 

OK: 

Click this button to close the dialog and apply the changes to the current model. 

Open: 

This option allows you to open a previously saved model from disk.  The File Open dialog box is displayed, allowing 
you to navigate to and select the model.  Note: Models from ModFit LT 2.0 and earlier cannot be opened with this 
option. 

Save: 

This option allows you to save the current model to disk for later use.  The File Save dialog is displayed, allowing you 
to navigate to the location where you wish to store the model.   

Help: 

Click this button to display online help for this topic. 
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Edit: 

This button is enabled when one of the list entries is selected.  Clicking the button will display the edit dialog for the 
selected item. 
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Edit Components 

 

  

 

This dialog allows you to add, delete, and edit components of the model.  Each model component mathematically 
describes a piece of the histogram.  The collection of components attempts to fully define the histogram as a 
mathematical model. 

Component names can be edited by clicking slowly once on the name, then clicking again.  The list item will enter edit 
mode; press the Tab key or click another item to accept the revision. 

Select a component in the list, and then click one of the action buttons to modify it. 

 

OK: 

Click this button to close the dialog and accept the changes. 

Help: 

Click this button to display online help for this topic. 

Properties: 

This button is enabled when one of the list entries is selected.  Clicking the button will display the edit properties dialog 
for the selected item. 

Edit: 

This button is enabled when one of the list entries is selected.  Clicking the button will display the edit dialog for the 
selected item. 

Copy: 

Click this button to copy the selected component.  The new copy will be added to the end of the component list, and 
can be selected for editing. 

Delete: 

Click this button to delete the selected component.  If other components are dependent on the deleted component, 
they will become inactive.  Use great care when deleting components to ensure the remaining model components are 
not adversely affected. 

 

See also: 

Edit Properties for Component  
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Edit Properties for Detail 

 

  

 

This dialog allows you to edit the properties of a model component detail.  The details of a component will depend on 
the particular component type.  The properties of each detail define how the detail is related to other component 
details, how it is computed, and the source of its estimates.  See Edit Properties for Component for additional 
information. 

 

Dependency: 

This option determines how the detail is computed.  Floating means that the modeling process will adjust the detail to 
find the best value.  Floating details are commonly used for means and standard deviations of well-defined peaks 
modeled with Gaussian component.  Dependent details are computed directly by applying a multiplicative and/or 
additive factor to the value of the controlling detail.  Fixed details are not adjusted during the modeling process; their 
values are determined either by a static value or from a range estimate.  Interpolate can be selected to compute the 
value of the detail by interpolation.  It is only applicable to standard deviation details.  An example best describes the 
use of this option.  Suppose you have a model that describes a diploid population.  Now suppose there is an extra 
peak in S-Phase that you believe should be broadened in the same way as the S-Phase is broadened.  You would 
choose Interpolate for the standard deviation of the extra peak, and make its controlling component and detail the S-
Phase lower standard deviation.  The upper boundary of the interpolation is automatically the upper standard 
deviation. 

Controlling component: 

If the Dependent or Interpolate is selected as the Dependency option, the controlling component determines what 
model component this detail is dependent upon.  You must also select a Controlling detail (below) to complete the 
dependency.  If the Dependency option is Floating or Fixed, the controlling component is ignored.    

Controlling detail: 

If the Dependent or Interpolate is selected as the Dependency option, the controlling detail determines detail on which 
this detail depends.  If the Dependency option is Floating or Fixed, the controlling component is ignored.    

Multiplicative factor: 

If the Dependent is selected as the Dependency option, the final value of the controlling component's detail is 
multiplied by the multiplicative factor.  As an example, the G2M component's mean position is often made dependent 
on the G1 component's mean by a factor of 2. 

Additive factor: 

If the Dependent is selected as the Dependency option, this value is added to the final value of the controlling 
component's detail, after it has been multiplied by the multiplicative factor. Estimation: 

This drop down provides choices for the source of the estimate for the detail.  Outside-in and Inside-out draw the 
estimate from simple statistics performed before the modeling process.  Range draws the estimate from a range 
associated with this component.  User-entered estimate uses the value entered in the Estimated value field as the 
source of the estimate. 

Estimated value: 

This field displays the estimate that was used for the detail when the model was last run.  If Estimation is set to User-
entered estimate, the value will not be adjusted.  In all other cases, the value may change each time you choose Fit, 
depending on how the details dependencies are set. 

Final value: 
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This read-only field displays the result of the last modeling process for this model. 

 

OK: 

Click this button to accept the changes and close the dialog. 

Cancel: 

Click this button to cancel changes and close the dialog.  This button may be disabled if changes are made that 
cannot be cancelled. 

Help 

Click this button to display online help for this topic. 
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Edit Ranges 

 

  

 

This dialog allows you to add, delete, and edit ranges of the model.  Ranges are graphical elements that you can 
position on the histogram.  They are used to supply estimates to model components. 

Range names can be edited by clicking slowly once on the name, then clicking again.  The list item will enter edit 
mode; press the Tab key or click another item to accept the revision.  See Edit Properties of Range and Edit 
Properties for Component more on this topic. 

 

OK: 

Click this button to close the dialog and accept the changes. 

Help: 

Click this button to display online help for this topic. 

Properties: 

This button is enabled when one of the list entries is selected.  Clicking the button will display the edit properties dialog 
for the selected item. 

Edit: 

This button is enabled when one of the list entries is selected.  Clicking the button will display the edit dialog for the 
selected item. 

Copy: 

Click this button to copy the selected range.  The new copy will be added to the end of the range list, and can be 
selected for editing. 

Delete: 

Click this button to delete the selected range.  If components are dependent on the deleted range, they will become 
inactive.  Use great care when deleting range to ensure model components are not adversely affected. 

Properties: 

This button is enabled when one of the list entries is selected.  Clicking the button will display the edit dialog for the 
selected item. 
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Edit Properties of Range 

 

  

 

This dialog allows you to edit the properties of a model range.  Ranges are graphical elements that you can position 
on the histogram, used to supply estimates to model components. 

 

Label: 

This edit box displays the name of the range.  It can be edited by click inside the edit box and typing new text. 

Active: 

When checked, the range is displayed on the histogram (in Range view) and it can be used as an estimation source 
for model details.  When unchecked, the range will not be displayed and any components that use the range will be 
deactivated. 

X Position: 

The edit box shows the location of the left side of the range.  You can edit the field manually, or position the range 
graphically to change the value.  To display ranges, click the Range button on the toolbar, or choose Position Ranges 
from the Analysis menu. 

X Width: 

The edit box shows the width of the range.  The right side of the range is positioned at X Position plus this value.  

Y Position: 

This value determines the vertical location of the range label.  The value is a percentage of the Y scale. 

Color: 

Click this button to display the standard color selection dialog and choose a new color for the range. 

Type of estimate: 

There are three types of range estimates: Gaussian, Debris and Aggregate.  Most ranges are Gaussian type, used to 
identify peaks in the histogram.  There is typically only one Debris estimate range in a model, used by the AutoDebris 
component for estimation of the debris.   The Aggregate estimate can be associated with the AutoAggregate 
component, but is typically not used. 

OK: 

Click this button to accept the changes and close the dialog. 

Cancel: 

Click this button to cancel changes and close the dialog.  This button may be disabled if changes are made that 
cannot be cancelled. 

Help 

Click this button to display online help for this topic. 
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Edit Equations 

 

  

 

This dialog allows you to edit the equations used to display the result of the modeling process.  See Edit Properties of 
Equation for details on equation syntax. 

You can edit equations by selecting an item in the list and clicking Properties.  Alternately, you can edit an equation 
directly by clicking once slowly to select the equation, then clicking again to enter edit mode.  To leave edit mode, 
press the Tab key or click another item in the list. 

Properties: 

This button is enabled when one of the list entries is selected.  Clicking the button will display the edit properties dialog 
for the selected item. 

New: 

Click this button to add a new equation.  The new equation will be added to the end of the list, and can be selected for 
editing. 

Delete: 

Click this button to delete the selected equation.  Be careful when deleting equations that contain "T[n]" expressions, 
where n is an integer.  These equations compute temporary variables used by other equations; the other equations 
may fail if they make use of a deleted expression. 

OK: 

Click this button to close the dialog and accept the changes. 

Help: 

Click this button to display online help for this topic. 
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Edit Properties of Equation 

 

  

 

This dialog allows you to edit an equation expression.  See Edit Equations for more on how equations are used. 

 

See Equation syntax for details on how to interpret equations. 
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Equation syntax 

 

ModFit equations are expressions that are compiled by the program and evaluated each time the model is analyzed.  
Equations can contain literal text, keywords from the FCS file being analyzed, and symbols that provide access to the 
computed results of the analysis.  Mathematical operations include addition, subtraction, division, and multiplication, 
grouping of operations using parentheses, and use of build-in functions. 

 

Strings 

String literals are enclosed in quotation marks.   

Example equation: "This is text." 

Report output: This is text. 

 

Keywords: 

Keywords can be draw from the FCS file and from internally computed values.  Keywords are enclosed in square 
brackets.   

FCS keywords vary from file to file, and are generally created by the software that was used to acquire the data file. 

Internal keywords include the following: 

[DATE] displays date of analysis. 

[TIME] displays time of analysis. 

[FILE] displays name of data file analyzed. 

[REPORT] displays name of report. 

[AUTONAMEREPORT] displays name generated by AutoNameReport. 

[MODEL] displays the name of the model. 

[ANALYSIS] displays the type of analysis performed, e.g. 
Automatic, Manual. 

[RCS] displays the reduced chi-square value from the last fit 
of the model. 

[GATE1] displays name of gate one, or "Off" if no gate 

[GATE2] displays name of gate two, or "Off" if no gate 

[GATE3] displays name of gate three, or "Off" if no gate 

[FILEPATH] displays full path to data file. 

[MODELPATH] no longer supported 

[REPORTPATH] displays full path to the report 

[VERSION] displays the internal version of the program 

[LINEARITYFACTOR] displays the configuration setting for linearity 

[EXTREFMEAN] displays the value for the External Reference Mean 
position from the Auto Analysis Settings dialog. 

[DIPTOSTDRATIO] displays the value for the Diploid-to-Standard Ratio 
from the Auto Analysis Settings dialog. 

[RANGEnNAME] displays the name of range with ID of n 

[RANGEnLEFT] displays the left channel position of range with ID of n 

[RANGEnRIGHT] displays the right channel position of range with ID of n 

 

Example equation: “Today is “;[DATE] 

Report output shows date of analysis (for example):  “Today is 28-Feb-2005” 

Example equation: [RANGE4NAME] 

Report output shows name of range with ID of 4:  “Dip G1” 

 

Internal functions 

Internal functions are used to gain access to component details, areas, and other computed values.  Below is a table 
describing each function.  Note that component and compartment indexing start at zero (0).   
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Function Description 

A[m, n] Returns the area of component m, compartment n.  
To return the area of all compartments for a 
component, use an asterisk (*) for n.  To return the 
area of all components, use an asterisk for m. 

M[m, d] Returns the value of detail d for model component m. 

T[n]=equation Sets the value of temporary variable n to the 
expression in equation.  After setting a temporary 
variable, you can use the variable without the 
"=equation" portion to return the value of the 
equation. 

T[n] Returns the value stored in temporary variable n. 

P[n] Set the floating-point precision for the rest of the 
equation to n decimal places. 

Y[m, start, end] Returns the portion of the area of component m that 
falls between channels start and end. 

S[start, end] Returns the sum of events between channels start 
and end. 

U[start, end] Returns the mean between channels start and end. 

H[ ] Returns the mean of the highest active cycle 
component.  NOTE: There is no space between the 
open and close square brackets. 

F[expression] Returns the value of a keyword converted into a 
floating-point number.  This allows the keyword to be 
used in calculations. 

For example, the $P1B keyword stores the number 
of bits used to store a value for parameter 1 in an 
FCS file.  To compute the number of bytes used by 
parameter 1, the following equation could be used: 
"Parameter 1 bytes = ";F[[$P1B]]/8 

 

Mathematical operations 

The following operations are supported.   

Operation Usage 

Addition Use the plus symbol (+) between numeric values. 

Multiplication Use the asterisk (*) between numeric values. 

Subtraction Use the minus symbol (-) between numeric values. 

Division Use the slash (/) between numeric values. 

Grouping Use parentheses to group mathematical operations. 

 

Concatenation 

Equations can contain multiple elements separated by a semi-colon (;). 
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Auto Analysis Settings 

 

This dialog is used to configure ModFit LT's Auto Analysis function.  When the current user is logged in as a Standard 
User, only a portion of these options are available.  Advanced users and Administrators have access to all of the 
options in the dialog.  Only those options shown with an asterisk (*) below are available to Standard Users. 

Administrators will receive an additional prompt after clicking the OK button to close the dialog, asking if the new 
settings should be stored as program default settings.  If you answer, "Yes", the program will use the new settings 
each time it is started.  Otherwise, the settings are in effect only for the current session of ModFit LT. 

 

  

 

* AutoDebris 

When this option is checked, the program will enable the AutoDebris component to model debris in the data file during 
Auto Analysis.  Debris is often created in the sample preparation process.  If the option is not checked, the AutoDebris 
component will be disabled. 

  

* AutoAggregates 

When this option is checked, the program will enable the AutoAggregate component to model aggregation in the data 
file during Auto Analysis.  Aggregation in the sample can produce a continuum of particles that are stuck together, 
significantly affecting S-Phase estimates.  If the option is not checked, the AutoAggregate component will be disabled. 

 

* Apoptosis 

If this option is checked, the first peak detected after any internal standards will be considered an apoptotic population 
and modeled with a Gaussian. 

 

Linearity Settings 

* Linearity 

This value is used in the computation of some G2M positions, and in the AutoAggregate model component.  The 
default value is 2.0, as G2M peaks are expected to appear at two times the associated G1 peak.  Adjust this value to 
match the known linearity setting for your instrument. 

When Auto Analysis does not detect a distinct G2M peak for a cycle, it assumes the location of the G2M peak to be at 
the G1 position times this linearity setting.  This is called a dependent G2M, because its position depends on the G1. 

The linearity value is used by the AutoAggregate model component to determine the expected locations of peaks 
created by aggregation. 

 

Standards and References 

* Internal Standards 
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Select the number of internal standards that your data files contain.   

Most DNA internal standards are designed to appear to the left of the first cycle's G1 population.  By default, the 
program will assume that the first peaks it finds should be assigned to the number of standards you select here.  Use 
the Properties of Standards button below to give the program additional information about the internal standards in 
your samples.  

 

* Properties of standards 

Click this button to display the Standards dialog.  This dialog allows you to edit the names and expected locations of 
internal standards in your samples.  By entering expected locations, the program can more accurately determine 
which peaks are standards, and where the Diploid population occurs.  See the description of Diploid determination 
below for more on using this value to assign ploidy. 

 

* External reference standard 

If you enter a value of an external standard location, you can make use of this value in assigning ploidy labels to the 
cycles that AutoAnalysis finds.  For example, if you run a normal Diploid control at a particular channel, you can enter 
that channel position in this edit box.  See the description of Diploid determination below for more on using this value 
to assign ploidy. 

 

Ploidy Determination 

Maximum cell cycles 

Select the maximum number of cell cycles that Auto Analysis can model.  By default, this is set to "Unlimited".  If the 
program detects numerous false peaks in your data files, you may want to specify a maximum of 3 or 4 cycles.  See 
the Peak Finder Settings for more information about finding peaks. 

 

Diploid determination 

This option determines the method that Auto Analysis will use to identify the Diploid cycle in your data files. 

First cycle is Diploid 

This is the default selection.  Use this option if you want the first (leftmost) cell cycle always to be classified as the 
Diploid cycle.   

Based on external reference 

Use this option if you have entered an expected location for an external reference above, and you want to use that 
position as the basis for identifying the Diploid cycle.  The expected Diploid location will be computed as the External 
reference standard location multiplied by the Diploid-to-Standard ratio.  

Based on Standard1 and Based on Standard2 

 Use this option if you have entered expected location(s) for internal standards above in Properties of standards, and 
you want to use one of the standards to compute the expected location of the Diploid cycle. The expected Diploid 
location will be computed as the Expected position of the standard multiplied by the Diploid-to-Standard ratio. 

 

Examples: 

1.  Suppose you have one internal standard in your samples that is normally found at channel 38 in the DNA 
histogram, and that the normal Diploid G1 location is 1.3 times the standard's position.  You would enter the expected 
location of the standard using Properties of standards, select Based on Standard1 for the Diploid determination option, 
and enter 1.3 in the Diploid-to-standard edit box. 

 

2.  Suppose you run a normal Diploid control that is positioned at channel 55 everyday, and that you expect this to be 
the location of Diploid cycles in your test samples as well.  You would enter 55 in the External reference standard field, 
select Based on external reference for the Diploid determination, and enter 1.0 for the Diploid-to-Standard ratio. 

 

Diploid-to-Standard ratio 

This value is used if you have the Diploid determination option selected for Based on external reference, Based on 
Standard1, or Based on Standard2.  The expected location for the Diploid G1 is computed by multiplying this value 
times the expected location of the reference or standard.  

When Diploid determination is set for First cycle is Diploid, this value is not used. 

 

G1 threshold 
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This value sets the minimum relative height for a peak to be considered a G1, after adjusting the height for 
aggregates.  The relative height is a value relative to the largest peak, where the largest peak is 100%.  The default 
setting for G1 threshold is 5%.  To allow smaller peaks to be considered G1 peaks, lower the value.  To make the 
setting more restrictive, increase the setting. 

 

Peak location range 

This value controls how much variation the program allows in looking for a peak at an expected location.  It is a 
percentage of the expected location.  If, for example, the expected location of the Diploid G1 is channel 50 and this 
value is set for 10%, Auto Analysis will look for a peak between channel 50 plus and minus 5 channels, or 45 to 55. 

 

Dependent G2M 

With this option enabled, Means and Standard Deviations for all G2M components will be dependent on the 
associated G1 components in models created by AutoAnalysis.  This setting creates more consistent analysis results 
from one operator to the next, and it is recommended.  With the option disabled, any G2M component that has a well-
defined PeakFinder peak will have a floating Mean and Standard Deviation.  Those without well-defined peaks will be 
dependent on associated G1 components. 

 

S-Phase 

S-Phase shape 

This option controls the mathematical function that is used to model S-Phase.   

Rectangle 

This is the default selection.  It provides the most conservative estimate of S-Phase and is the recommended option. 

Trapezoid 

This option provides one additional degree of freedom over the Rectangle. 

Polynomial 

This option adds two degrees of freedom over a rectangle.   

 

Number of compartments 

Select the number of compartments to use in modeling S-Phase.  By default, this option is 1, the recommended value.   

 

DI for S-Phase 

Enter a DNA index value (DI) below which the program will disable S-Phase modeling for the lower of two overlapping 
cycles.  The default and recommended value is 1.3.   

When two cell cycles are significantly overlapped, the S-Phases can be arbitrarily inflate or deflate in the modeling 
process.  In this situation, it is better to disable the S-Phase for the lower-positioned cycle.  The DI for S-Phase setting 
controls the threshold for this decision. 

 

Tetraploid 

G2M Threshold 

This value determines when a peak at a G2M location is considered to be too large for a G2M peak, and is classified 
as a G1 peak for another cycle.  The value used in making this decision is a simple statistical fit of the peak, not the 
modeled result for the peak.   

The value is a percentage of the estimated area of the associated G1 peak.  By default, the G2M can be up to 15% of 
its associated G1 before it is reclassified as a G1 of another cycle. 

 

Tetraploid location range 

This value controls how much variation the program allows in looking for a potential Tetraploid peak.  It is a 
percentage of the expected location.  

 

* Open 

If you have previously saved Auto Analysis settings to disk, you can use the Open button to load those settings into 
the program.  

Save 
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Use this option if you want to store the current Auto Analysis settings to a file on disk.  The standard file save dialog 
box will be displayed, allowing you to navigate to a location and name the file to save.  

* Reset 

Click this button to restore the Auto Analysis values to the factory default settings. 

 

OK 

Click this button to accept the changes you have made and close the dialog.  If you logged in to the program as an 
Administrator, you will be asked whether you want to use the new settings as default settings.  If you choose Yes, the 
new settings will be used each time the program starts.  If you choose No, the changes will be used for the current 
session of ModFit LT. 

 

Cancel 

This option closes the dialog and discards any changes you might have made. 

 

Help 

This option displays the on-line help for this dialog. 
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Peak Finder Settings 

 

The Peak Finder dialog adjusts the settings used by the system to determine how peaks will be identified in your 
samples.  The peak finder statistically determines what populations are peaks in the histogram data, and then applies 
filters to remove unwanted peaks from consideration. 

When the current user is logged in as a Standard User, only a portion of these options are available.  Advanced users 
and Administrators have access to all of the options in the dialog.  Only those options shown with an asterisk below 
are available to Standard Users. 

Administrators will receive an additional prompt after clicking the OK button to close the dialog, asking if the new 
settings should be stored as program default settings.  If you answer, "Yes", the program will use the new settings 
each time it is started.  Otherwise, the settings are in effect only for the current session of ModFit LT. 

The peak finder is of fundamental importance in Automatic Analysis.  Therefore, it is very important to approach 
changes to the peak finder with care and thoughtfulness.   

Changes to these settings will affect how the program defines a peak, which in turn will alter ploidy detection, model 
selection, and analysis results in Automatic Analysis.  Test any changes you make on a reasonable sampling of your 
data files.  Make changes to improve the overall effectiveness of the peak finder, not to handle an exceptional sample.  
Exceptional samples should be handled using manual analysis. 

 

  

 

Peak Finder - Show 

Click this button to display a graphical version of the dialog box, allowing you to see the current histogram as you 
adjust settings.  See Peak Finder dialog for details. 

 

Start at 

The value controls the point at which ModFit LT starts looking for peaks.  It allows you to skip over channels where 
your data has debris that may be misinterpreted as a peak.  The value is a percentage of the histogram scale, and 
higher values move the starting point to higher channel location. 

 

Low %CV 

This value controls the low %CV cutoff for data to be considered a peak.  %CV reflects the broadness of the peak; 
those peaks which have %CV lower than this filter are excluded.  To remove more narrow peaks, increase the value.  
To allow more peaks, lower the value. 

 

High %CV 

This value controls the high %CV cutoff for data to be considered a peak.  %CV reflects the broadness of the peak; 
those peaks which have %CV higher than this filter are excluded.  To allow more peaks to pass the filter, increase the 
value.  To reduce the number of peaks that pass the filter, reduce the value. 

 

Rise Threshold 

This value controls how far a peak must rise above adjacent data to be considered a real peak.  Peaks that extend 
above adjacent data less than this value are excluded from the peak finder.  To increase the minimum rise for a peak 
and reduce the number of passing peaks, increase this value.  To reduce the filter and allow more peaks to pass, 
reduce the value. 
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Correlation 

This value controls the minimum correlation coefficient allowed for a peak to pass this "shape" filter.  Each potential 
peak is fit with a Gaussian curve; the resulting correlation coefficient is compared to this filter.  To increase the 
minimum allowable correlation coefficient and reduce the number of passing peaks, increase the value.  To increase 
the number of peaks that pass the filter, reduce the value. 

 

* Open 

If you have previously saved peak finder settings to disk, you can use the Open button to load those settings into the 
program.  This is useful if you analyze sets of data that have different peak characteristics. 

 

Save 

Use this option if you want to store the current peak finder settings to a file on disk.  The standard file save dialog box 
will be displayed, allowing you to navigate to a location and name the file to save.  

 

* Reset 

Click this button to restore the peak finder values to the factory default settings. 

 

OK 

Click this button to accept the changes you have made and close the dialog.  If you logged in to the program as an 
Administrator, you will be asked whether you want to use the new settings as default settings.  If you choose Yes, the 
new settings will be used each time the program starts.  If you choose No, the changes will be used for the current 
session of ModFit LT. 

 

Cancel 

This option closes the dialog and discards any changes you might have made. 

 

Help 

This option displays the on-line help for this dialog. 
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Peak Finder dialog 

 

The dialog displays the data histogram.  The graphic indicates the currently identified peaks with black arrowheads at 
the base of the histogram.  In addition, there are controls that allow you to adjust the peak finder settings and see the 
effect immediately. 

As you move your mouse pointer over the histogram, boundaries of peaks are drawn over the data, illustrated in the 
graphic below.  The status of the peak for each criterion is shown next to the control for the filter.  Using this 
information, you can determine why the peak finder excludes peaks, and make adjustments to the filters accordingly.   

 

 

 

The dialog can be displayed by clicking the Show button in the Peak Finder Settings dialog.  See Peak Finder Settings 
for details on each peak finder option. 

 

To the right of the filter controls, three columns of information are displayed.  The first column shows the current value 
of the filter.  The second column indicates "Pass" if the current peak passes the filter.  If it does not pass the filter, the 
second column will indicate whether the value is too high or too low.  The third column shows the value for the current 
peak. 

 

Reset 

Use this button to reset the peak finder filters to the default values for the program. 

 

New file 

Use this button to select another data file to view in the peak finder dialog.  This is useful to testing several files for the 
settings you have adjusted. 

 

OK 

Click this button to accept the changes and close the dialog. 

 

Cancel 

Click this button to close the dialog and discard any changes you may have made. 
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S-Phase Cutoffs command (Edit menu) 

 

Use this command to review, edit, and create cutoff ranges for different tissue types.  The cutoff ranges you enter are 
used by the Fit Diagnostics routine to assign S-Phase percentages into low, intermediate, or high classifications. 

Refer to the DNA Consensus Conference report (Cytometry 14, p471-500, 1993 (c) Wiley-Liss, Inc.) for information on 
establishing cutoffs in your laboratory. 

 

 

 

To enable the S-Phase assessment system, check the Activate Assessment System checkbox.   

To disable the S-Phase assessment system, clear the check from the Activate Assessment System checkbox.   

To add a tissue cutoff, enter a tissue type in the Tissue edit box.  Then enter the thresholds for low-to-intermediate and 
intermediate-to-high for each ploidy type.  Click the Add button to add the new type to the list of choices. 

To set a tissue type as the Current Tissue, double click the entry in the listbox.  The current tissue is displayed at the 
top of the dialog and on the Toolbar in the Tissue type drop-down listbox. 

To edit a tissue cutoff, click the listbox entry for the tissue you want to edit.  Make changes to the ranges in the edit 
boxes, and then click Replace to update the entry. 

To delete a tissue cutoff, click the listbox entry you want to delete.  Then click the Delete button. 

To accept changes to the dialog, click OK. 

To discard changes to the dialog, click Cancel. 

 

See also: 

Fit Diagnostics dialog  

Tissue type (Toolbar dropdown)  

Histogram and S-Phase Assessment  

S-Phase Assessment Options dialog  

 



Reference 

123 

Options and Configuration 

 

This dialog is used to set program configuration options.   

When the current user is logged in as a Standard User, only a portion of these options are available.  Advanced users 
and Administrators have access to all of the options in the dialog.  Only those options shown with an asterisk below 
are available to Standard Users. 

Administrators will receive an additional prompt after clicking the OK button to close the dialog, asking if the new 
settings should be stored as program default settings.  If you answer, "Yes", the program will use the new settings 
each time it is started.  Otherwise, the settings are in effect only for the current session of ModFit LT. 

 

  

 

* Desired resolution 

Select the desired resolution for the analysis histogram.  It is strongly recommended that you use the default setting of 
256 channels to improve performance and consistency.  The histogram will be displayed and analyzed at the desired 
resolution, provided that the parameter's resolution is greater than or equal to the desired resolution. 

 

* Auto-scale X 

* Auto-scale Y 

These options control the auto-scaling of the main histogram graphic.  When checked, each data file is automatically 
scaled on the X-axis and/or Y-axis as it is opened.  The Y scaling is set to the height of the highest peak.  The low X 
scale is set to the value of the Peak Finder Start.  The high X scale is set to the highest channel that contains data, to 
a maximum of resolution minus 1.   

Uncheck one or both of these options to leave the scaling unchanged as new data files are opened.  This is 
convenient for studies where it is useful to see all histograms on a fixed scale. 

 

* Graphic output 

Choose the desired graphic format to create when exporting histogram and report graphics.  Export commands are 
found in the File menu and in the File and Report Batch Settings dialog. 

Supported formats currently include bitmap (bmp), JPeg (jpg), Tiff (tif), Portable Network Graphics (png), Portable 
Pixmap (ppm), X11 Bitmap (xbm), and X11 Pixmap (xpm).  

 

AutoLinearity Settings 

These settings control the AutoLinearity function of the program.  This feature is available when batch processing 
reports, and in the Quick Model Editor.  See Using AutoLinearity for more on this feature. 

Low linearity 
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This field sets the lowest value used by the AutoLinearity operation.  Values for this field must be between 1.85 and 
1.94, inclusive. 

High linearity 

This field sets the highest value used by the AutoLinearity operation.  Values for this field must be between 1.95 and 
2.2, inclusive. 

Linearity Increment 

Enter the amount by which to increment linearity when performing AutoLinearity adjustment. 

 

Initial zoom settings 

These settings determine the default values for X and Y Zoom graph objects.  These objects can be placed on the 
report to show the histogram zoomed in the X or Y scale, respectively. 

Y Zoom Factor 

Enter the initial value for Y Zoom graph objects.   The value is the number of times to magnify the scale, e.g. 25 
means multiply data points on the Y scale by 25.  

X Low Scale 

Enter the low channel value for the X Zoom graph object.  This value will be the leftmost portion displayed in the X 
Zoom graph object. 

X High Scale 

Enter the high channel value for the X Zoom graph object.  This value will be the rightmost portion displayed in the X 
Zoom graph object. 

 

Advanced settings 

Dip G2M Fraction 

This value is used to compute the relative area of the Diploid G2M in Tetraploid models.  Because the Diploid G2M in 
a Tetraploid model is in the same location as the Tetraploid G1 peak, the program disables modeling of the Diploid 
G2M.  After the model fit is completed, the program adjusts the Tetraploid G1 by subtracting a portion of its area and 
assigning it to the Diploid G2M.  The adjustment is computed by multiplying the Diploid G1 area by the Dip G2M 
Fraction.  The default value is 0.08, or 8%, which means that the Diploid G2M area will be 8% of the Diploid G1, and 
the Tetraploid G1 will be reduced by the same area. 

Password required 

If this option is checked, the program requires the user to enter a password for all user groups except for Standard 
users.  The passwords for each group are provided with the program on a separate card for security. 

If, as an Administrator, you do not want to enforce passwords for each user group, you can uncheck this option. 

User equations 

ModFit LT allows you to create additional equations to compute when the model is executed, either with Auto Analysis 
or Execute Model.  These equations must follow the syntax described in the section on Equation syntax.   

See Edit User Equations and Edit Properties for Equation for details on adding and editing equations. 

 

AutoDebris settings (Advanced) 

Four properties control the AutoDebris component.  If you have logged in as an Advanced user or Administrator, some 
of these properties also appear in the Quick Model Editor dialog. 

The AutoDebris model component is normally a set of three cut distributions.  The first cut distribution normally models 
debris particles generated by a single cut of sample particles, frequently found in paraffin sections.  The higher order 
cut distributions model various fragmentations of nuclei.  The combination of the three distributions enable the 
AutoDebris model component to be used in a wide variety of preparations (fresh, frozen, pulverized and paraffin).   

The component works best when debris events in the very low channels (5-10 for 256 channel histograms) have not 
been gated, since these channels are rich in information about the underlying cut distributions.  Under some 
circumstances, such as high discriminator settings, the auto debris system can fail because each of the internal cut 
distributions have too great of overlap.  Under a failing condition, there are two recourses:  turn off the auto debris or 
simplify the auto debris system. 

To simplify the auto debris system, turn off the second and third cut numbers by setting each to zero (0).  If the first cut 
number is 1, this operation creates the standard single-cut debris model.  Try to re-analyze the data with this simpler 
debris shape.  If this still doesn't work, turn the auto debris off and remodel. 

If you have just a few data files where the component is failing, do not change the setting here in the Options and 
Configuration dialog.  Instead, use the Quick Model Editor to change the settings for the model used on the failing files 
and reanalyze them.  Making changes here in Options and Configuration affects Auto Analysis and Manual Analysis 
for all data files. 
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Internal resolution 

This option sets the internal resolution of the cut distributions used by the AutoDebris model component.  Acceptable 
values range from 50 to 200, with a default value of 100.  You can use a lower value if computer memory is limited.  
Most users will not need to adjust this value. 

First cut number 

This value defines the number fragments assumed by the first debris component.  By default it is 1, which allows it to 
model distributions created by each nucleus splitting once in the sample preparation. 

Second cut number 

This value defines the second debris distribution.  By default it is set to 5, which corresponds to nuclei that have been 
randomly cut five times.  A value of zero turns both the second cut number and third cut number distributions off. 

Third cut number 

This value defines the third debris distribution.  By default it is set to 12, which corresponds to nuclei that have been 
highly fragmented.  A value of zero turns this distribution off. 

 

Override settings (Advanced) 

These options allow you to change settings in reports that ModFit LT opens from disk as they are read by the program.  
It can be used to convert old reports to new settings, or to compare the effects of changing settings on reports.  It is an 
advanced option, not available to Standard operators. 

Generate debris for standards 

This option only applies to reports as the program opens them.  When set to Yes, internal standard components are 
considered to be involved in the generation of debris in the histogram.  When set to No, internal standard components 
are ignored by the debris component.  When set to No override, the model in the report is unchanged.  Models that are 
created by AutoAnalysis starting with version 3.1 ignore internal standards from debris generation. 

Generate aggregates for standards: 

This option only applies to reports as the program opens them.  When set to Yes, internal standard components are 
considered to be involved in the generation of aggregates in the histogram.  When set to No, internal standard 
components are ignored by the aggregate component.  When set to No override, the model in the report is 
unchanged.  Models that are created by AutoAnalysis starting with version 3.1 ignore internal standards from 
aggregate generation. 

Force dependent G2M: 

This option only applies to reports as the program opens them.  With this option enabled, Means and Standard 
Deviations for all G2M components are made dependent on the associated G1 components.  With the option disabled, 
no changes are made to G2M components as reports are opened.  Starting with version 3.1 of the program, 
AutoAnalysis will force dependent G2M components by default.  See Auto Analysis Settings for more information on 
this setting.  

* Open 

If you have previously saved configuration settings to disk, you can use the Open button to load those settings into the 
program. 

 

Save 

Use this option if you want to store the current configuration settings to a file on disk.  The standard file save dialog 
box will be displayed, allowing you to navigate to a location and name the file to save.  

 

* Reset 

Click this button to restore the configuration values to the factory default settings. 

 

OK 

Click this button to accept the changes you have made and close the dialog.  If you logged in to the program as an 
Administrator, you will be asked whether you want to use the new settings as default settings.  If you choose Yes, the 
new settings will be used each time the program starts.  If you choose No, the changes will be used for the current 
session of ModFit LT. 

 

Cancel 

This option closes the dialog and discards any changes you might have made. 

 

Help 
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This option displays the on-line help for this dialog. 
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Edit User Equations 

 

ModFit LT allows you to create additional equations to compute when the model is executed, either with Auto Analysis 
or Execute Model.  These equations must follow the syntax described in the section on Equation syntax.   

 

  

 

To add a new equation, select one of the example equations and click the Copy button.   

To change an equation, click Edit.   See Edit Properties for Equation for details on editing equations. 
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Edit Properties for Equation 

 

ModFit LT allows you to create additional equations to compute when the model is executed, either with Auto Analysis 
or Execute Model.  These equations must follow the syntax described in the section on Equation syntax.   

 

  

 

You can enter a name for each equation and the equation expression.  The name will be used as a keyword name, 
prefixed with "USER_", and can be selected for databasing and display on the report.   

For example, if you name your equation, "SumOfAneuploidAreas", you can select the keyword 
"USER_SumOfAneuploidAreas" to display on the report using the Tools menu, Keywords command.  You can also 
select this keyword to be databased using the Edit menu, Databases command. 
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Settings Manager 

 

Overview: 

This dialog allows you to manage the program settings.  You can back-up settings so that they can be transferred to 
other computers or for archival purposes.  Similarly, you can select settings from previous back-ups and load them as 
current settings. 

 

  

 

Pathways  

Application Settings Path (Read only) 

Displays the path to the applicationsettings.  This field cannot be edited. 

 

Import or Export Settings Path 

Click to choose a path for importing or exporting settings. 

 

Stored Paths 

The system remembers the most recent import/export paths you used.  Choose a stored path to either export to or 
import from. 

 

 

Settings to act on  

Application window 

Check to import or export the settings for this object.  

 

Auto analysis 

Check to import or export the settings for this object.  

 

Color preferences 

Check to import or export the settings for this object.  
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Database 

Check to import or export the settings for this object.  

 

Flash comments 

Check to import or export the settings for this object.  

 

Options and configuration 

Check to import or export the settings for this object.  

 

Peak finder 

Check to import or export the settings for this object.  

 

Recent files and reports 

Check to import or export the settings for this object.  

 

S-Phase cutoff 

Check to import or export the settings for this object.  

 

 

Actions  

Export Settings... 

Click to export the selected settings.  Settings will be written into the import/export settings path. 

 

Import Settings... 

Click to import the selected settings.  Settings will be read from the import/export settings path. 

 

Clear Settings... 

Click to clear the selected settings. 

 

 

Actions 

OK 

Click this button to accept the changes and close the dialog box. 

 

Cancel 

Click this button to discard any changes and close the dialog box. 

 

Reset 

Click this button to reset the object's properties to default values. 
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Edit Log 

 

ModFit LT allows you to create a log of operations that you perform.  This is useful if you have any difficulties with the 
program and need to interact with the Technical Support team. 

 

To view the current log, click the Edit Log button from the Edit Properties for Configuration dialog. 

To adjust properties of the log, first click the Edit Log button, and then click the Properties button.  See Edit Properties 
for Log for details on the log settings. 
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Edit Properties for Log 

 

This dialog allows you to activate and adjust the program's logging features, useful in isolating problems that you may 
have in working with the program. 

 

  

 

Active 

To enable logging of program operations, check this option.  This file is a plain text file, with fields separated by tabs.  
It can be opened in most text editors, or attached to email messages. 

To disable logging, clear the check from this checkbox. 

 

File Name 

This read-only field shows the name of the log file on disk. 

 

MaxLines 

Enter the maximum number of lines to keep in the log.  When the log reaches this limit, the oldest line is removed, 
allowing the new line to be added. 

 

MaxChars 

This field shows the maximum length of a line in the log.  

 

Clear log 

Click this button to clear all entries from the log file. 
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Restore Default Settings 

 

To restore the program to the factory default settings, you need to use the Reset option in each of the dialogs that 
store configuration settings.  Follow the steps below to reset the program to factory default settings. 

If you are logged in as an Administrator, you can restore default settings and save them as the program default 
settings.  This allows Administrators to set up the program so that each time it starts, it uses factory defaults.  After 
clicking the OK button, an Administrator is asked whether or not to save settings as default settings; choosing Yes will 
set new program defaults. 

Standard and Advanced users can reset the program for the current session only.  

 

AutoAnalysis settings 

From the Edit menu, choose Auto Analysis Settings.  This will display the Auto Analysis Settings dialog.  Scroll to the 
bottom of the dialog and click the Reset button.  This will reset all Auto Analysis options to factory defaults.  Click OK 
to close the dialog. 

 

Peak Finder settings 

From the Edit menu, choose Peak Finder Settings.  This will display the Peak Finder Settings dialog.  Scroll to the 
bottom of the dialog and click the Reset button.  This will reset all Peak Finder options to factory defaults.  Click OK to 
close the dialog. 

 

Options and Configuration 

From the Edit menu, choose Options and Configuration.  This will display the Configuration dialog.  Scroll to the 
bottom of the dialog and click the Reset button.  This will reset all Configuration options to factory defaults.  Click OK 
to close the dialog. 

 

 

View menu 

Toolbar command (View menu) 

 

Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands 
in ModFit LT, such as Open->Data.  If a button represents a state, a check mark appears next to the menu item when 
the button is clicked. 

You can move the toolbar by clicking and holding the primary mouse button down on a blank portion of the toolbar, 
then dragging to a new location. 

 

See also: 

Toolbar  
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Status command (View menu) 

 

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected menu 
item or depressed toolbar.  A check mark appears next to the menu item when the Status Bar is displayed. 

 

See also: 

Status Bar 



Reference 

135 

Zoom command (View menu) 

 

Use this command to change the magnification of the report document as viewed on the screen.  Increase the zoom to 
magnify the image, or decrease it to reduce the image size. 

This has no effect on printed output. 

See Zoom dialog for help on using the zoom dialog. 

 

Shortcuts 

Toolbar:  

Analysis menu 

Get Next File command (Analysis menu) 

 

Use this command to select the next data file from a batch of files for analysis.  If a file is available in the batch, it will 
be loaded without displaying a dialog.  See Batch Processing for more.  

You create a batch of files using the Open->Data command from the File menu and selecting multiple files from the 
list.  When the batch is finished or empty, Get Next File functions the same as Open->Data command from the File 
menu. 

When finished with a batch, this option displays the File Open dialog. 

Shortcuts 

Keys: CTRL + N on PC;  Command + N on Mac 
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Auto Analysis command (Analysis menu) 

 

Use this command to automatically analyze the current data file.   

The program uses the settings from the Auto Analysis Settings dialog, along with Peak Finder Settings, to analyze the 
data file.  

 

What Does Auto Analysis Do? 

When you load a data file, ModFit LT identifies peaks it finds in the sample.  Automatic analysis looks at the peak 
positions, standard deviations, and other information about the sample and attempts to match the data to a ploidy-
specific model.  The model is constructed, ranges are positioned around the peaks, peak estimates are computed, and 
a non-linear least squares analysis is performed on the data.  In addition, ModFit LT tests the S-Phase measurements 
for statistical confidence if the S-Phase assessment system is activated. 

When automatic analysis finishes, ModFit LT displays the analysis results in both graphical and textual form on the 
report. 

You can interrupt an analysis by clicking on the Cancel button of the Model Status dialog. 

 

See also: 

Strengths and Limitations of Automatic Analysis  

 

Shortcuts 

Toolbar:  

Keys: CTRL + A on PC;  Command + A on Mac 



Reference 

137 

Set Scaling command (Analysis menu) 

 

Use this command to manually adjust the scaling of the loaded histogram data. 

A rectangle encompassing the data is displayed.  Each corner has a solid square in it.  Position the mouse over a 
corner square, click and hold the button down, and drag to position a new boundary. 

Data below the left boundary and above the right boundary will be excluded from the analysis.  Adjusting the top of the 
scaling rectangle re-scales the data on the Y-axis graphically, but has no effect on the analysis. 

Normally when each new data file is opened, the program will automatically scale the data.  See the section on the 
Options and Configuration dialog box to learn how to disable the auto-scaling feature.  

 

Shortcuts 

Toolbar:  
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Choose Model command (Analysis menu) 

 

Use this command to select a model to use in the manual analysis of the data. 

 

  

 

A model consists of a set of components, which are linked together in specific ways, depending on the assumptions 
you enter in this dialog.   

Selecting a model does not actually perform an analysis.  After choosing a model, you need to position its ranges and 
click the Fit button to analyze the data with the model.  

The left portion of the dialog contains a tree diagram of the model.  The top of the tree is the Manual Analysis branch, 
and the choices you need to make when selecting a model are described below.  Also shown in the tree is a branch 
for each cell cycle you want to model.  The number of cycles you see will depend on what you choose for “Number of 
cycles” in the dialog. 

After making your initial model selections with the Manual Analysis branch selected, you can fine-tune the model by 
selected each cycle branch and adjusting its properties.  See the Edit Properties for Cycle dialog box for details on 
cycle properties. 

 

AutoDebris 

To enable debris modeling, check this option.  The AutoDebris component can model debris from fresh, frozen, 
pulverized, and paraffin samples.  If the sample shows little or no debris, you may choose to disable this option. 

AutoAggregates 

Check this option to enable a model component that automatically fits most forms of aggregation.  Aggregates can 
form in the sample as cells and cell fragments stick together.  Because all sizes and shapes of cells can form 
aggregates, the AutoAggregate component is a continuous distribution.  Its shape is unique for each data file, and is 
based on probabilities of cells in each channel sticking together.  To disable the AutoAggregates component, uncheck 
this option. 

Apoptosis 

Check this option to model an apoptosis distribution in the sample.  A Gaussian will be used to model a peak, and a 
range to identify the peak will be displayed.   

Linearity 

Enter a linearity value for the sample.  This value can be determined by dividing the G2M position for a cycle by the 
G1 position for the same cycle.  The program will use the linearity value for computing positions for G2M populations 
that are not clearly defined peaks, and for the AutoAggregate model component. 

Standards 

Use this option to select the number of internal standards that appear as distinct peaks in the sample. 

Number of cycles 

Choose the number of cell cycles that appear in the sample.  Each cell cycle contains model components for G1, S-
Phase, and G2M populations. 

Model templates 

After choosing the number of cycles above, select a model template that best describes the cycles.  The templates are 
named with abbreviated forms of the common cell cycle names: “Dip” is Diploid, “Ane” is Aneuploid, “Tet” is Tetraploid, 
“Hyp” is Hyper-Diploid, and “NearDip” is Near-Diploid.   
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Notice that the model template name determines the relative positions of the cycles in the model.  For example, with 3 
cycles, there is a template for “Dip Ane Tet” and another for “Dip Tet Ane”.  The “Dip Ane Tet” template is designed for 
the Aneuploid appearing between the Diploid and the Tetraploid populations; the “Dip Tet Ane” is designed for the 
Aneuploid appearing above (to the right of) the Tetraploid population. 

The available model template will change depending on the number of cell cycles you have selected to model. 

Range positions 

This option allows you to determine whether or not the program will re-position ranges upon choosing OK.  If you have 
already selected a model and are making some adjustments in this dialog, choose “Use current range positions”.  If 
you are selecting a new model, choose “Compute range positions” to determine the initial locations for the ranges. 

 

OK  

Click this button to create a model matching your selections and display the ranges for the model.  After clicking OK, 
position the ranges and click the Fit button on the toolbar. 

The selected model will be used until 1) another model is selected using Choose Model, 2) an automatic analysis is 
performed, 3) a new report document is loaded, or 4) you close the program. 

Cancel  

Click this button to close the dialog without creating a model. 

Reset 

Click this button to restore the dialog to a default model. 

 

See Also 

Edit Properties for Cycle  

 

Shortcuts 

Toolbar:  
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Position Ranges command (Analysis menu) 

 

Use this command to manually adjust the ranges for the model. 

ModFit LT uses specific ranges to identify important parts of a histogram, usually peaks.  Automatic Analysis positions 
ranges for you.  However, if you need to correct a range position or if you manually select a model for analysis, you 
will need to position ranges yourself. 

The rule of thumb for positioning ranges is to make sure each range identifies one, unique peak.  Ranges should be 
positioned so that they do not overlap one another.  When a range is positioned correctly, you will see the associated 
portion of the histogram filled in with a color indicating the range estimate. 

The exception to the rule for placing ranges is shown in near-Diploid histogram.  In these histograms, you may need to 
place ranges so that they are not centered on the peaks.  Instead, move the ranges slightly apart to help differentiate 
the two, overlapping peaks. 

Only move or resize ranges that need to be adjusted.  By leaving correctly positioned ranges alone, you help improve 
user-to-user consistency. 

The vertical position of ranges has no impact on the range estimate.  You can arrange ranges vertically so that they 
are easy to read and access. 

 

Ranges and their uses 

Debris This range provides an estimate of debris.  The left side should be placed at the 
highest portion of the beginning of debris.  The right side should extend 
approximately two-thirds of the histogram scale.  The vertical position has no 
impact on the estimate. 

Stnd1 This range is used to identify the first internal standard, if there is one.  If you 
have named the internal standard, the name of the range is changed to the 
name of the standard.  Center the range over the first standard peak. 

Stnd2 This range is used to identify the second internal standard, if there is one.  If you 
have named the internal standard, the name of the range is changed to the 
name of the standard.  Center the range over the second standard peak. 

Apop This range identifies the apoptosis peak, if you have enabled the apoptosis 
component.  The range should be centered over the peak. 

Dip G1 This range identifies Diploid G0-G1 peak.  The range should be centered over 
the G1peak. 

Dip G2 This range identifies Diploid G2-M peak.  The range should be centered over the 
G2 peak. 

An1 G1 This range identifies an Aneuploid G0-G1 peak.  The first Aneuploid cycle will 
use An1, the second An2, and so forth.  The range should be centered over the 
G1 peak. 

An1 G2 This range identifies an Aneuploid G2-M peak.  The first Aneuploid cycle will use 
An1, the second An2, and so forth.  The range should be centered over the G2 
peak. 

G1 This range is used by the Sync Wizard to identify the Diploid G0-G1 peak.  The 
range should be centered over the peak. 

Parent This range is used by the Proliferation Wizard to identify the Parent population. 

Gen1 This range is used by the Proliferation Wizard to identify a daughter generation 
population, if the “Floating” option is selected on the Generations tab of the 
wizard dialog.  Gen1 is the generation closest to the parent, Gen2 is to the left of 
Gen1, etc. 

 

Shortcuts 
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Toolbar:  
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Fit with Current Model command (Analysis menu) 

 

Use this command to apply a model, with current scaling and range positions, to the histogram data.  This performs a 
non-linear least squares analysis of the data. 

If you use Automatic Analysis, you will not need to use this command.  It is done for you. 

Use this command after you have opened a data file, chosen a model, and positioned the model's ranges.  If you 
change the model using the Quick Model Editor, the Full Model Editor, or by positioning ranges, you need to use this 
command to re-fit the data with the model. 

 

See also: 

Choose Model  

Position Ranges 

 

Shortcuts 

Toolbar:  
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Fit Diagnostics command (Analysis menu) 

 

Use this command to display the Fit Diagnostics dialog, used to assess the probability of S-Phase measurements and 
compare the analysis with DNA Consensus Conference findings. 

 

See also: 

Fit Diagnostics  

 

Shortcuts 

Toolbar:  
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Report command (Analysis menu) 

 

Use this command to display, lay out, and edit the report document.   

The Report Tools window appears with this command, allowing you to easily add graphics and text to the report. 

 

Shortcuts 

Toolbar:  
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Auto Save Report command (Analysis menu) 

 

Use this command to name and save the report document without prompting for a file name or location.   

The name for the report is based on the data file currently loaded into it.   

In PC versions, ModFit LT takes the name of the data file, and combines it with the file extension, and adds ".MFL" to 
create the report name.  For example, if the data file is "RM2345.FCS", the report name will be "RM2345_FCS.MFL". 

On the Mac, the word "report" is appended to the name of the data file to create the report name.  For example, if the 
data file is "RM2345", the report name will be "RM2345 report". 

Reports are saved to the folder last navigated to with the Open->Report or Save dialogs.  In batch processing, reports 
are saved to the path specified in the File Batch Properties dialog. 

 

Shortcuts 

Toolbar:  
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Print command (Analysis menu) 

 

Use this command to print the report document without displaying the Print Options dialog.  It is equivalent to the 
Analysis Print command. 

To select print options, use the Print command  in the File menu. 

 

Shortcuts 

Toolbar:  

Keys: CTRL + P on PC;  Command + P on Mac 



Reference 

147 

Sync Wizard->Create or edit model (Analysis menu) 

 

The Synchronization Wizard guides you through the process of creating or editing a model to analyze synchronized 
cell lines.  You can initiate the wizard by selecting Sync Wizard->Create or edit model from the Analysis menu.  A 
dialog will appear containing several tabs, each presenting you with choices relative to a particular aspect of the 
model.  The wizard provides full functionality for creating and editing a synchronization model while maintaining a 
simple interface. 

When starting a Sync Wizard session, you should select each tab to adjust any settings to your data.  When you press 
the Analyze button, the Wizard dialog will close, the model will be constructed, and the data file analyzed.  In addition, 
the Wizard toolbar will appear on the screen, allowing you to open files, return to the Wizard, or exit the Sync Wizard. 

 

 

 

If you need to adjust a setting in the model, re-enter the Sync Wizard dialog by clicking the Wizard button on the 
Wizard toolbar, or selecting Sync Wizard->Create or edit model from the Analysis menu.  When editing a model, 
you only need to review the tabs containing options you want to change.  For example, you might view the G0-G1 tab 
to change the model from "Adjust automatically" to "Lock the position", then choose Analyze to close the dialog. 

ModFit LT remains in Sync Wizard mode until you quit the Wizard, either by clicking the X on the Wizard toolbar, by 
selecting Sync Wizard->Quit from the Analysis menu, or by choosing Cancel from the Sync Wizard dialog. 

You can save an active Sync Wizard session in a report to preserve your settings for the synchronization model you 
create.  The report must be saved with the Wizard toolbar visible to be able to re-enter the Wizard dialog when the 
report is reopened. 

 

See also: 

Sync Wizard: Start tab  

Sync Wizard: G0G1 tab  

Sync Wizard: G2M tab  

Sync Wizard: S-Phase tab  

Sync Wizard: Report tab  

Sync Wizard: Other tab  
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Sync Wizard:  Start tab 

 

You decide whether to create a model, or edit the one you already created on this tab.  The option to edit is disabled if 
the Sync Wizard is not already running.  Once a model has been created, you can re-enter the Wizard to edit the 
modelsettings.   

Use the Open button to select a data file, if you havenalready selected the file you want to start with. 
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Sync Wizard: G0G1 tab 

 

The purpose of this tab is to allow you to identify the G0-G1 peak.  A graphic of the currently loaded data file is 
displayed with a cursor used to identify the position of the G0-G1. 

The program will position the cursor automatically over the first peak in the sample.  If this is not the correct peak for 
your analysis, position the G0-G1 peak cursor by clicking on the red triangle at the top of the graphic and dragging it 
over the peak.  Alternately, you may type a channel value into the G0-G1 channel edit box.   

When you close the Wizard dialog by choosing Analyze and you are creating a model from scratch, ModFit LT will 
position the G0G1 range around the channel position you indicate.  The range is placed so that it encompasses 8 
channels to the left and 8 channels to the right of the peak position. 

When editing a model, the Sync Wizard does not adjust the range position on the data.  You can manually adjust the 
range by clicking the Range button on the toolbar and moving or resizing the G0G1 range. 

The Sync Wizard allows you to "lock" the channel position, or to let the program adjust the position within the G0G1 
range.  When you choose Lock the position, ModFit LT will not try to find a better peak position.  This setting is useful 
in case where the G0-G1 peak is indistinct or not present.  You must also specify a standard deviation for the peak 
with this option. 

Choosing Adjust automatically allows the program to look for a peak within the range of channels encompassed by 
the G0G1 range, initially plus or minus 8 channels from the identified peak position.  If the program cannot locate a 
peak within the G0G1 range, the Sync Wizard Adjustment dialog is displayed with options on how to adjust the model. 
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Sync Wizard: G2M tab 

 

The purpose of this tab is to allow you to identify the G2/G1 ratio.  This ratio is used to determine the position of the 
G2-M peak relative to the G0-G1 peak.  A graphic of the currently loaded data file is displayed with a cursor used to 
identify the position of the G2M peak.  

You may adjust the G2/G1 ratio three ways: by entering a new ratio in the G2/G1 edit box, by entering a channel 
position in the G2-M channel edit box, or by dragging the red triangle cursor over the G2-M position on the graphic.   

The model created by the Sync Wizard will multiply the G0-G1 peak position and standard deviation by the G2/G1 
ratio appearing on this tab to compute the G2-M mean position and standard deviation.  The position of the G2-M peak 
is always, therefore, dependent on the position of the G0G1 peak.   Similarly, the standard deviation of the G2-M peak 
is dependent on the standard deviation of the G0G1 peak. 
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Sync Wizard: S-Phase tab 

 

The purpose of this tab is to allow you to control the aspects of modeling S-Phase. 

You may adjust the shape used for S-Phase by selecting either Rectangle or Trapezoid.  

The Number of Compartments section allows you to pick how many trapezoids or rectangles you want to use.  By 
choosing more compartments you allow the S-Phase portion of the model more freedom to conform to your data.  
However, giving too much freedom may allow the S-Phase portion of the model to take over data that truly belong to 
G0-G1 or G2-M. 

If you use more than one compartment in S-Phase, you can choose the spacing of compartments.  Choosing Equal 
spacing distributes the compartments evenly between G0-G1 and G2-M populations.  Choosing Exponential 
spacing causes compartments to increase exponentially in size. 
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Sync Wizard: Other tab 

 

The purpose of this tab is to allow you select miscellaneous options related to the synchronization model you are 
creating. 

If you need to perform debris subtraction, enable the Debris checkbox.  The Sync Wizard will add a debris component 
appropriate for fresh and frozen samples. 

If your sample(s) contain aggregates that you want to model, enable the Aggregates checkbox.  The Sync Wizard will 
add an aggregate compensation component to the model. 
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Sync Wizard: Report tab 

 

The purpose of this tab is to allow you to control what information is reported by the Sync Wizard model.   

For Percent report options, you may choose to report percentages for all components and sub-compartments, or only 
the primary components. 

For Mean report options, you may choose whether or not to report means. 

You can include information derived from the data filekeywords and other demographic information by selecting "Show 
demographics". 

If you would like to display the %CV for the G0-G1 peak, enable the Report %CV check box. 
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Sync Wizard->Open and analyze (Analysis menu) 

 

Use this command to open a data file into ModFit LT and analyze the file with the model created by the 
Synchronization Wizard.  The standard File Open dialog is displayed for selection of a file.  After selecting a file, the 
program loads and analyzes the sample in one step. 

If you select more than one file, the program will display a prompt indicating that you should use the File Batch toolbar 
to process the files.  This technique provides many useful options, such as automatically saving or printing reports.  
See File Batch Settings and File Batch Toolbar for more. 

Alternately, you may use the standard Get Next File command from the analysis menu to load the next file in a batch.  
If you use this option, you will need to click the Fit button or choose Fit with Current Model from the Analysis menu to 
apply the model to the sample. 
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Sync Wizard->Quit (Analysis menu) 

 

Use this command to exit the Synchronization Wizard.  The Wizard toolbar will be removed and normal program 
operations, such as automatic analysis and opening reports, are restored. 
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Proliferation Wizard->Create or edit model (Analysis menu) 

 

The Proliferation Wizard guides you through the process of creating or editing a model to analyze cell tracking dye 
samples.  You can initiate the wizard by selecting Proliferation Wizard->Create or edit model from the Analysis 
menu.  A dialog will appear containing tabs, each presenting you with choices relative to a particular aspect of the 
model.  The wizard provides full functionality for creating and editing a Proliferation model while maintaining a simple 
interface. 

When starting a Proliferation Wizard session, you should select each tab to adjust any settings to your data.  When 
you press the Analyze button, the Wizard dialog will close, the model will be constructed, and the data file analyzed.  
In addition, the Wizard toolbar will appear on the screen, allowing you to open files, return to the Wizard, or exit the 
Proliferation Wizard. 

 

 

 

If you need to adjust a setting in the model, re-enter the Proliferation Wizard dialog by clicking the Wizard button on 
the Wizard toolbar, or selecting Proliferation Wizard->Create or edit model from the Analysis menu.  When editing 
a model, you only need to review the tabs containing options you want to change. 

ModFit LT remains in Proliferation Wizard mode until you quit the Wizard, either by clicking the X on the Wizard 
toolbar, by selecting Proliferation Wizard->Quit from the Analysis menu, or by choosing Cancel from the Proliferation 
Wizard dialog. 

You can save an active Proliferation Wizard session in a report to preserve your settings for the Proliferation model 
you create.  The report must be saved with the Wizard toolbar visible to be able to re-enter the Wizard dialog when the 
report is reopened. 

 

See also: 

Proliferation Wizard: Start tab  

Proliferation Wizard: Parent tab  

Proliferation Wizard: Generations tab  

Proliferation Wizard: Other tab  
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Proliferation Wizard: Start tab 

 

You decide whether to create a model, or edit the one you already created on this tab.  The option to edit is disabled if 
the Proliferation Wizard is not already running.  Once a model has been created, you can re-enter the Wizard to edit 
the modelsettings.   

 

 

 

Use the Open button to select a data file, if you havenalready selected the file you want to start with. 
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Proliferation Wizard: Parent tab 

 

This tab allows you to locate the peak that represents the parent population in the sample.  The program automatically 
positions the cursor over the rightmost peak in the histogram.  If this is not the correct peak for your analysis, position 
the parent peak cursor by clicking on the red triangle at the top of the graphic and dragging it over the peak.   

 

 

 

Alternately, you may type a channel value into the Parent channel edit box. 

This tab also allows you to “lock” the standard deviation (SD) of the Gaussian component used to model the parent 
population.  The Lock SD option is most useful when analyzing samples in which there is a great deal of proliferation.  
In these cases, the parent population is often difficult for the model to resolve, and the modeling process may broaden 
the SD of the parent too much.  When this option is enabled, the SD value can be edited. 
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Proliferation Wizard: Generations tab 

 

This tab displays the information about how the generations will be modeled.   

 

 

 

There are edit boxes displaying the number of generations to model, the number of log decades in the sample, and 
the spacing between generations.  Generally, the only setting you might need to adjust is the number of log decades.   

The number of generations is preset to model all possible generations for 4 decade log data.  If your data contains 
more than 4 decades, you may need to increase the number of generations. 

When you enter a new value for number of decades, the spacing is automatically re-computed.  The value you enter 
for log decades should match the dynamic range of the acquisition flow cytometer.  The formula used to compute the 
spacing follows: 
 spacing = (histogram resolution -1) * log10(2.0) / log decades 

For example, if histogram resolution is 256 and log decades equals 4.0, 
 spacing = (256 - 1) * log10(2.0) / 4.0 
 spacing = 19.19 

The spacing value is automatically computed, based on the number of decades and the assumption that each 
generation has one-half of the intensity of the previous generation.  If the marker or the cell types you are using do not 
match these assumptions, you may need to manually enter a value for the spacing of the generations. 

A dropdown box is provided to select between the Standard and Floating option for modeling generations.  In the 
Standard mode, the mean position of each generation is dependent on the position of the parent generation.  For 
example, if the parent population is located at channel 200, the first generation will be located at the parent location 
minus the spacing value, 200 - 19.19 = 180.81, in this example.  The next generation will be 19.19 channels less than 
the first, and so on. 

The floating option allows the mean of each generation to be computed independently of the other populations.  This 
option provides much greater flexibility to the model and works well for samples with visually distinct generations.  The 
floating option is not recommended for samples where generational boundaries are not obvious to the eye.  

The graphic displays a red line where the parent generation is positioned and dotted lines for each generation. 
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Proliferation Wizard: Other tab 

 

The purpose of this tab is to allow you select miscellaneous options related to the proliferation model you are creating. 

 

 

 

The Proliferation Options group allows you to identify the generation that is considered the start of true proliferation.  
This value is used in computing the Precursor Frequency and the Upper Generation Proliferation Index (UGPI).  For a 
description of the use of Precursor Frequency, see "A flow cytometric method to estimate the precursor frequencies of 
cells proliferating in response to specific antigens", Givan, A., et al, Journal Of Immunological Methods Vol. 230, 1999 
Elsevier Science B.V.  

If you need to perform background subtraction, enable the Background checkbox.  The Proliferation Wizard will add a 
rectangle to model background. 

When you enable Background subtraction, another option, Asymmetric cytokinesis, becomes available.  With this 
option checked, the standard deviations of the generations are broadened by interpolation along the background 
rectangle.  If this option is not enabled, all generations have the same standard deviation as the parent population. 

With the Asymmetric cytokinesis option enabled, the program sets the name of the model to "Proliferation Wizard 
Cytokinesis Model".  If the option is not checked, the model name is "Proliferation Wizard Basic Model". 

Two export options can be enabled for the Proliferation Wizard.  When Export partition table is enabled, the program 
will save a text file containing the “boundaries” of the generations.  These are the points of intersection of the adjacent 
generations, illustrated below. 
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The export file is created each time the wizard analyzes a data file.  By default, the export file name is 
ProlifWizardPartitions.txt.  If you enable the Prompt for file name option, the wizard will display a File Save dialog 
before storing the partition file, allowing you to choose a file name and location. 

The partition file can be imported into other applications, like WinList, for further analysis.  It is a simple, text format file 
that is readable by spreadsheets, databases, and word processors. 
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Proliferation Wizard->Open data and analyze (Analysis menu) 

 

Use this command to open a data file into ModFit LT and analyze the file with the model created by the Proliferation 
Wizard.  The standard File Open dialog is displayed for selection of a file.  After selecting a file, the program loads and 
analyzes the sample in one step. 

If you select more than one file, the program will display a prompt indicating that you should use the File Batch toolbar 
to process the files.  This technique provides many useful options, such as automatically saving or printing reports.  
See File Batch Settings and File Batch Toolbar for more. 

Alternately, you may use the standard Get Next File command from the analysis menu to load the next file in a batch.  
If you use this option, you will need to click the Fit button or choose Fit with Current Model from the Analysis menu to 
apply the model to the sample. 
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Proliferation Wizard->Quit (Analysis menu) 

 

Use this command to exit the Proliferation Wizard.  The Wizard toolbar will be removed and normal program 
operations, such as automatic analysis and opening reports, are restored. 

 

Tools menu 

Text command (Tools menu) 

 

Use this command to add editable text to the report document.   

A dialog will appear allowing you to enter text.  After typing the text, click OK on the dialog. 

The text will appear on the document.  It can be dragged anywhere on the page.  Its bounding rectangle can also be 
resized. 

To edit the text, double click anywhere on the text block. 

To drag text, click the text and hold down the mouse button.  With the button depressed, move the mouse.  Release 
the button to set the new position. 

To add text to the Flash Comment list, choose the Save button in the Edit Text dialog.  The standard File Save dialog 
is displayed.  Type in a name for the comment file and click OK.  Once the comment has been stored on disk, you will 
be prompted to type a description for the comment.  Enter the description and click OK.  The Edit Text dialog will now 
display the description in the Flash Comment list. 

To add a stored comment to the report, choose the Text report tool.  The Edit Text dialog appears.  From the Flash 
Comment list, click the comment you want to add.  The text of the comment will appear in the Edit Text dialog.  Click 
OK to add the comment. 

 

Shortcuts 

Report tool:  
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Equations command (Tools menu) 

 

Use this command to display the Edit Equations dialog box.  This dialog displays the unprocessed equations that the 
program uses to compute and display analysis results on the report.  Each equation translates into one line of the 
analysis results. 

See Edit Equations for details on this dialog. 

 

Shortcuts 

Report tool:  
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Properties for Report Equations 

 

This dialog allows you to set the properties of the main equation object that appears on the report. 

 

Select the font 

Font of the equations 

 

Select the text color 

Color of the equations 

 
Actions 

OK 

Click this button to accept the changes and close the dialog box. 

Cancel 

Click this button to discard any changes and close the dialog box. 

Reset 

Click this button to reset the object's properties to default values. 
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Keywords command (Tools menu) 

 

Use this command to add keywords from your data file and analysis results to the report document.  Some keywords 
are stored in the file at the time it is created by the acquisition software.  ModFit LT allows you to access these 
keywords and place them in the report.  In addition, you can access the analysis results as keywords to place on the 
report.  A list of the keywords appears in the Keywords section. 

 

  

 

To move the object after it is inserted, click on it and hold down the mouse button.  With the button depressed, move 
the mouse.  Release the button to set the new position. 

 

Shortcuts 

Report tool:  
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Keywords 

This section lists and describes the keywords that are created by ModFit LT.  These keywords can be selected for 
display on reports using the Keywords command in the Tools menu, and can be stored in a database as well. 

Some keywords are available only when the conditions they relate to exist.  For example, keywords related to a 
second DNA Aneuploid population will only be available if the model that is used contains components for a second 
Aneuploid cycle.  

NOTE: The keywords for second, third, and fourth aneuploid cycles are identical to those for the first, expect that they 
are prefixed with Z_An2, Z_An3, and Z_An4 instead of Z_An1. 

  
Standard Model 
Keywords 

Comment 

Z_Aggregates % aggregates 
Z_AllCycleEvents Sum of events in cycles 
Z_An1 % events in first aneuploid cycle 
Z_An1_BAD % BAD in first aneuploid cycle 
Z_An1_CV % CV for first aneuploid cycle G1 
Z_An1_DI DNA index of G1 in first aneuploid cycle 
Z_An1_G1 % of first aneuploid cycle in G1 
Z_An1_G1_Mean Mean of G1 in first aneuploid cycle 
Z_An1_G2 % of first aneuploid cycle in G2 
Z_An1_G2_Mean Mean of G2 in first aneuploid cycle 
Z_An1_G2G1Ratio G2/G1 ratio for first aneuploid cycle 
Z_An1_Ploidy Ploidy of first aneuploid cycle 
Z_An1_S % of first aneuploid cycle in S-Phase 
Z_AneuploidS_Bnd S-Phase assessment cut-off value 
Z_AneuploidS_Class S-Phase assessment classification 
Z_AneuploidS_PValue S-Phase P-value 
Z_AneuploidS_Std S-Phase assessment standard deviation 
Z_CycleEventsPerChannel Average number of events per channel in cycles. 
Z_Debris % debris 
Z_Dip % events in diploid cycle 
Z_Dip_BAD % BAD in diploid cycle 
Z_Dip_CV % CV for diploid cycle G1 
Z_Dip_G1 % of diploid cycle in G1 
Z_Dip_G1_Mean Mean of G1 in diploid cycle 
Z_Dip_G2 % of diploid cycle in G2 
Z_Dip_G2_Mean Mean of G2 in diploid cycle 
Z_Dip_G2G1Ratio G2/G1 ratio for diploid cycle 
Z_Dip_Ploidy Ploidy of diploid cycle 
Z_Dip_S % of diploid cycle in S-Phase 
Z_DiploidS_Bnd S-Phase assessment cut-off value 
Z_DiploidS_Class S-Phase assessment classification 
Z_DiploidS_PValue S-Phase P-value 
Z_DiploidS_Std S-Phase assessment standard deviation 
Z_LinearityFactor Linearity value used in the model 
Z_ModeledEvents Number of events accounted for by the model 
Z_PloidyStatus S-Phase assessment ploidy 
Z_RCS Reduced chi-square 
Z_Stnd1 % of events in first internal standard 
Z_Stnd1_DI DNA Index of first standard 
Z_Stnd1_DipG1Ratio DipG1 mean/First Std mean 
Z_Stnd1_Mean Mean of first standard 
Z_Stnd2 % of events in second internal standard 
Z_Stnd2_DI DNA Index of second standard 
Z_Stnd2_DipG1Ratio DipG1 mean/Second Std mean 
Z_Stnd2_Mean Mean of second standard 
Z_TotalAneuploidFraction Percentage of cells in aneuploid cycles 
Z_TotalAneuploidS (Sum all aneuploid S-Phase areas)*100/(Sum all 

aneuploid areas).  For simple Diploid models, the 
keyword reports the value of Diploid S-Phase.  You 
may think of this keyword as "tumor S-Phase." 

Z_TotalBAD % BAD for histogram 
Z_TotalS Average or total S-Phase 
Z_TotalS_Bnd S-Phase assessment cut-off value 
Z_TotalS_Class S-Phase assessment classification 
Z_TotalS_PValue S-Phase P-value 
Z_TotalS_Std S-Phase assessment standard deviation 



ModFit LT User Guide 

168 

 

The following keywords store configuration values used by the program.  The Auto Analysis Settings, Peak Finder 
Settings, and Options and Configuration dialog boxes set these values. 

 
Configuration Keywords Comment 
CF_APOPTOSIS Auto Analysis state for apoptosis 
CF_AUTOAGGREGATE Auto Analysis state for AutoAggregates 
CF_AUTODEBRIS Auto Analysis state for AutoDebris 
CF_MOD_S_COMPARTMENTS Number of S-Phase compartments in this 

model 
CF_MOD_S_SHAPE Shape of S-Phase in this model 
CF_G2G1RATIO Auto Analysis state for linearity or G2/G1 

ratio 
CF_PLOIDY_DIP_STD_RATIO Auto Analysis state for diploid-to-standard 

ratio 
CF_PLOIDY_MODE Auto Analysis state for ploidy detection mode 
CF_SPHASE_COMPARTMENTS Auto Analysis state for number of S-Phase 

compartments 
CF_SPHASE_SHAPE Auto Analysis state for shape of S-Phase 
CF_SPHASE_DI_THRESHOLD Auto Analysis state for DI for S-Phase 
CF_TET_RANGE Auto Analysis state for Tetraploid range 
CF_PF_STATE State for Peak Finder 
CF_PF_RISE Peak Finder setting for rise 
CF_PF_LOWCV Peak Finder setting for low CV 
CF_PF_HIGHCV Peak Finder setting for high CV 
CF_PF_CC Peak Finder setting for correlation coefficient 
CF_PF_PCNTSTART Peak Finder setting for starting threshold 

 

MF keywords 

Internal keywords are prefixed with "MF_" and store data computed by the program.  They are listed in the table 
below. 

  
Internal Keywords Comment 
MF_ANALYSIS Type of analysis performed 
MF_AUTODEBRIS_FIRSTCUT Setting for AutoDebris first cut 
MF_AUTODEBRIS_RESOLUTION Setting for AutoDebris resolution 
MF_AUTODEBRIS_SECONDCUT Setting for AutoDebris second cut 
MF_AUTODEBRIS_THIRDCUT Setting for AutoDebris third cut 
MF_DATE Date of analysis 
MF_FILE Full path name of the data file 
MF_FILEPATH Pathway to the data file 
MF_GATE1 Parameters for gate 
MF_GATE1_PERCENT Percent of events in gate 
MF_GATE2 Parameters for gate 
MF_GATE2_PERCENT Percent of events in gate 
MF_GATE3 Parameters for gate 
MF_GATE3_PERCENT Percent of events in gate 
MF_MODEL Name of the model used in analysis 
MF_PLOIDYINDEX 0=Diploid, 1=Tetraploid, 2= One 

Aneuploid, 3=Two Aneuploid, etc. 
MF_RCS Reduced chi-square  
MF_REPORT Name of the report 
MF_REPORTPATH Pathway to the report 
MF_TIME Time of the analysis 
MF_VERSION Version of the program 

 

USER keywords 

These keywords show the results of user-entered equations found in Options and Configuration dialog.  The name for 
the keyword is prefixed with "USER_".  This allows you to display and database results of user-entered equations. 

 

C keywords 

Keywords that begin with "C_" display the final value for a detail of a model component.  The naming convention starts 
with "C_", followed by the name of the component, an underscore, and the name of the detail.  For example, "C_An1 
G1_Area" displays the area of the An1 G1 component. 
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Sync Wizard keywords 

When using the Sync Wizard, several additional keywords are made available.  These allow you to extract the 
percentage of each compartment used in modeling S-Phase.  If, for example, you use 3 rectangles to model S-Phase, 
you will find three additional keywords: Z_DIPS_C1, Z_DIPS_C2, Z_DIPS_C2. 

 

Proliferation Wizard keywords 

When using the Proliferation Wizard, additional keywords are available to allow you to display and database all of the 
information generated by the wizard.  These keywords are prefixed with "Z_PROLIF", and are named to indicate the 
value that it stores. 
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Line command (Tools menu) 

 

Use this command to add lines to the report document.  Lines can be dragged into position anywhere on the report. 

To drag a line, click on the object and hold down the mouse button.  With the button depressed, move the mouse.  
Release the button to set the new position. 

To change the size or angle of a line, click on the line to make it the active object.  Handles will appear on a rectangle 
that contains the line.  Click and hold one of the handles to reposition that corner of the bounding rectangle.  The line 
will reorient as you move the handle.  Each of the handles can be moved in the same manner. 

To change the color of a line, double click on the line.  A standard color selection dialog will appear.  Select the color 
you wish to display, and click the OK button.  The object will be redrawn with the newly selected color. 

 

Shortcuts 

Report tool:  
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Arrow command (Tools menu) 

 

Use this command to add lines with arrowheads to the report document.  Arrows can be dragged into position 
anywhere on the report. 

To drag an arrow, click on the object and hold down the mouse button.  With the button depressed, move the mouse.  
Release the button to set the new position. 

To change the size or angle of an arrow, click on the arrow to make it the active object.  Handles will appear on a 
rectangle that contains the arrow.  Click and hold one of the handles to reposition that corner of the bounding 
rectangle.  The arrow will reorient as you move the handle.  Each of the handles can be moved in the same manner. 

To change the color of an arrow, double click on the arrow.  A standard color selection dialog will appear.  Select the 
color you wish to display, and click the OK button.  The object will be redrawn with the newly selected color. 

 

Shortcuts 

Report tool:  
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Rectangle command (Tools menu) 

 

Use this command to add rectangles to the report document.  Rectangles can be dragged into position anywhere on 
the report, and have selectable colors. 

To drag a rectangle, click on the object and hold down the mouse button.  With the button depressed, move the 
mouse.  Release the button to set the new position. 

To change the size of a rectangle, first click on it to make it the active object.  Click and hold one of the handles to 
reposition that corner of the rectangle.  Each of the handles can be moved in the same manner. 

To change the color of a rectangle, double click on the rectangle.  A standard color selection dialog will appear.  Select 
the color you wish to display, and click the OK button.  The object will be redrawn with the newly selected color. 

 

Shortcuts 

Report tool:  
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Ellipse command (Tools menu) 

 

Use this command to add ellipses and circles to the report document.  Ellipses can be dragged into position anywhere 
on the report. 

To drag an ellipse, click on the object and hold down the mouse button.  With the button depressed, move the mouse.  
Release the button to set the new position. 

To change the size of an ellipse, first click on it to make it the active object.  Click and hold one of the handles to 
redefine the size and shape of the ellipse.  Each of the handles can be moved in the same manner. 

To change the color of an ellipse, double click on the ellipse.  A standard color selection dialog will appear.  Select the 
color you wish to display, and click the OK button.  The object will be redrawn with the newly selected color. 

 

Shortcuts 

Report tool:  
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X Zoom Graph 

 

Use this command to add a graph object to the report that shows a zoomed view of the histogram.  The inserted graph 
can be moved and resized on the report. 

The X Zoom graph object is especially useful for visually identifying near Diploid populations.  It is designed to crop the 
X-axis so that only the Diploid G1 peak is on scale. 

To edit the object zoom settings, double click on the object after it has been inserted into the report.  Then, adjust the 
X-Axis minimum and maximum values to include the portion of the histogram you want to view. 

You can set the default values for this object using the Options and Configuration dialog box. 

 

Shortcuts 

Report tool:  
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Y Zoom Graph 

 

Use this command to add a graph object to the report that shows a zoomed view of the histogram.  The inserted graph 
can be moved and resized on the report. 

The Y Zoom graph object is designed to enhance low-level histogram data.  It provides a detailed view of S-Phase and 
small G2M and aggregate forms.  Use the graph to verify the fit of the model and ensure the correct model is selected. 

To edit the object zoom settings, double click on the object after it has been inserted into the report.  Select a new Y 
Zoom factor to increase or decrease the magnification of the histogram. 

You can set the default values for this object using the Options and Configuration dialog box. 

 

Shortcuts 

Report tool:  
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Properties for 1P Graphics 

 

This dialog is used to change the graphic properties for 1P histograms. 

 

  

 

Smooth 

This value determines the amount of smoothing for the histogram.  Set to 0 for no smoothing. 

 

Y Zoom Factor 

Select a zoom factor for the Y direction. 

 
X-axis Label  

Text 

Enter the text for the X-axis label. 

Color 

Choose a color of the x-axis label. 

Font 

Select the font of the x-axis label. 

Number Color 

Choose the color of the x-axis tic numbers. 

Number Font 

Select the font of the x-axis tic numbers. 

 
X-axis Min Scale  

Auto Minimum 

Enable this option to automatically set the minimum of the x-axis. 

Minimum Value 
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When Auto Minimum is not enabled, this value sets the minimum value displayed by the x-axis. 

 
X-axis Max Scale  

Auto Maximum 

Enable this option to automatically set the maximum of the x-axis. 

Maximum Value 

When Auto Maximum is not enabled, this value sets the maximum value displayed by the x-axis. 

 
X-axis Major Tic  

Auto Calculate 

Enable this option to automatically determine the major tic unit for the x-axis 

Unit 

When Auto Calculate is not enabled, this value sets the major tic unit of the x-axis. 

 
X-axis Minor Tic  

Auto Calculate 

Enable this option to automatically determine the minor tic unit for the x-axis. 

Number Of Minor Tics 

When Auto Calculate is not enabled, this value sets the number of minor tics per major tic on the x-axis. 

 
Y-axis Label  

Text 

Enter the text for the Y-axis label. 

Color 

Choose a color of the y-axis label. 

Font 

Select a font for the y-axis label. 

Number Color 

Choose the color of the y-axis tic numbers. 

Number Font 

Select a font for the y-axis tic numbers. 

 
Y-axis Min Scale  

Auto Minimum 

Enable this option to automatically set the minimum of the y-axis 

Minimum Value 

When Auto Minimum is not enabled, this value sets the minimum value displayed by the y-axis 

 
Y-axis Max Scale  

Auto Maximum 

Enable this option to automatically set the maximum of the y-axis 

Maximum Value 

When Auto Maximum is not enabled, this value sets the maximum value displayed by the y-axis 

 
Y-axis Major Tic  

Auto Calculate 

Enable this option to automatically determine the major tic unit for the y-axis 

Unit 

When Auto Calculate is not enabled, this value sets the major tic unit of the y-axis 

 
Y-axis Minot Tic  



ModFit LT User Guide 

178 

Auto Calculate 

Enable this option to automatically determine the minor tic unit for the y-axis 

Number of Minor Tics 

When Auto Calculate is not enabled, this value sets the number of minor tics per major tic on the y-axis. 

 
Actions 

OK 

Click this button to accept the changes and close the dialog box. 

Cancel 

Click this button to discard any changes and close the dialog box. 

Reset 

Click this button to reset the object's properties to default values. 
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Fit Diagnostics command (Tools menu) 

 

Use this command to add a report object that displays a summary of the Fit Diagnostics dialog box on the report.  The 
object shows a legend of the elements found in the Fit Diagnostics dialog box.  The object can be moved to any 
convenient location on the report. 

 

  

 

To edit the object's font, double click on the object after it has been inserted into the report.  Choose new font 
properties and click OK to accept the new font. 

For more information on Fit Diagnostics, see the section on the Fit Diagnostics command found in the Analysis menu. 
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Send to Back command (Tools menu) 

 

Use this command to move the selected object in a report behind all others in the report.  This command, along with 
the Bring to Front command, lets you control overlapping objects.  For example, if you want to display a text object on 
top of a filled rectangle object, you could select the rectangle object and choose Send to Back.  This will force the 
rectangle to draw behind the text, allowing the text to display on top of it. 

Each time the command is executed, the drawing order of objects may change.  The selected object becomes the 
new, back-most object.  Objects are drawn from back to front order. 

 

Shortcuts 
Keys: CTRL + K on PC; Command + K on Mac 
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Bring to Front command (Tools menu) 

 

Use this command to move the selected object in a report in front of all others in the report.  This command, along with 
the Send to Back command, lets you control overlapping objects.  For example, if you want to display a text object on 
top of a filled rectangle object, you could select the text object and choose Bring to Front.  This will force the text to 
draw after the rectangle, allowing the text to display on top of it. 

Each time the command is executed, the drawing order of objects may change.  The selected object becomes the 
new, front-most object.  Objects are drawn from back to front order. 

 

Shortcuts 
Keys: CTRL + T on PC; Command + T on Mac 

Help menu 

Index command (Help menu) 

 

Use this command to display the opening screen of Help.  From the opening screen, you can jump to step-by-step 
instructions for using ModFit LT and various types of reference information.   
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About command (Help menu) 

 

Use this command to display the About dialog box. 
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Appendices 

Report Design 

 

What is a report 

The documents created by ModFit LT are called reports.  Reports contain the analysis information for one data 
sample, and can be saved to disk and re-opened by the program.  

When you start ModFit LT, a simple report is created for you automatically.  It contains several objects which are 
common to all reports: a graphical element which displays the histogram data, a textual element which displays 
analysis results, and the S-Phase assessment object which also displays text.  The histogram is not displayed until 
there is a data file loaded.  The text objects remain hidden until you have analyzed the data. 

To see these elements, load a data file into ModFit LT.  The histogram will be displayed. 

Choose Auto Analysis or click the Auto button on the toolbar.  When the analysis is finished, the results and S-Phase 
assessment objects will appear. 

In addition, if you load and analyze listmode data, you can create one or two gates on the data.  The gate graphic(s) 
will appear on the report, allowing you to manipulate the gate(s) without reloading the sample.  

What you can add to reports 

ModFit LT reports can include additional text and graphics that you add to the report with report tools.  When you 
choose Report from the Analysis menu or click the Report button on the toolbar, the Report toolbar is displayed. 

The table below shows the report tools and their functional descriptions.  Each tool in the Report toolbar is also 
accessible through the Tools menu. 

Tool Description 

 

Text 

Adds free-form text objects. 

 

Equations 

Displays the Edit Equations dialog to permit editing of 
the analysis equations. 

 

Keywords 

Adds keyword information extracted from the data file 
you analyze. 

 

Line 

Adds a solid line. 

 

Arrow 

Adds an arrow. 

 

Rectangle 

Adds a filled rectangle. 

 

Ellipse 

Adds a filled ellipse. 

 

X-zoom graph 

Adds a graph zoomed on the X-axis to magnify the 
Diploid G1 component. 
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Y-zoom graph 

Adds a graph object zoomed on Y-axis to magnify the 
S-Phase and aggregate components. 

 
Text 

  To add free-form text or comments to a report, choose the Text tool.  A dialog will appear which allows you to 
enter the text, choose a font for the text, and optionally add the text to a library of comments ModFit LT keeps for you.  
Enter the text and click OK. 

  To revise text, change its font, or edit the comment library, double click the mouse on the textual object.  The Edit 
Text dialog will appear. 

  To view or change the font, click the Font button in the Edit Text dialog.  The standard font selection dialog 
appears, allowing you to select a new font, size, and attributes for the font.  Click OK to use the new font, or Cancel to 
discard changes to the font. 

  To delete a text object from the report, click the object to select it, then press the Delete key on the keyboard. 

  To add text to the comment list, choose the Save button in the Edit Text dialog.  The standard File Save dialog is 
displayed.  Type in a name for the comment file and click OK.  Once the comment has been stored on disk, you will be 
prompted to type in a description for the comment.  Enter the description and click OK.  The Edit Text dialog will now 
display the description in the comment list. 

  To add a stored comment to the report, choose the Text report tool.  The Edit Text dialog appears.  From the 
comment list, click the comment you want to add.  The text of the comment will appear in the Edit Text dialog.  Click 
OK to add the comment. 

 

 Equations 

Displays the Edit Equations dialog to allow review and editing of analysis equations.  See Edit Equations for details.  

 

 Keywords 

When you want to include in the report information from the data file you analyze, use the Keywords tool.  This tool 
displays all the textual information that ModFit LT can extract from the data file and the analysis system, allowing you 
to pick and choose what you want to include in the report.  As with other text objects, you can also choose a font for 
the text. 

  To add keyword information to your report, click the Keywords tool or choose Keywords from the Tools menu.  
From the list of text and analysis keywords displayed, select those you want in the report and click the Add button.  
The items you selected will appear in the Added edit box.  You can also double click keywords to add them.  Click OK 
to close the dialog and display the keywords.  You may drag the new keyword object to a new location on the report 
with the mouse. 

  To edit a keyword object, double click the object in the report.  The Keywords dialog appears, allowing you to add, 
and delete, and choose a font for the keywords.  Click OK to accept changes, or Cancel to abort. 

  To annotate keywords with text, double click the keyword object to display the Keyword dialog.  Click the mouse in 
the Added edit box at the point where you want to insert text.  Type the text you want to add, and then click OK. 

  To delete a keyword object from the report, click the object to select it, then press the Delete key on the keyboard. 

Note:  If a keyword does not appear in the list, load in a file that has that particular keyword.  If you want keywords 
from different flow cytometers, you will need to load each file, then select and add the desired keyword.  The analysis 
keywords appear only after the file has been analyzed. 

 

 Graphical elements 

There are several built-in graphical elements ModFit LT provides for you: lines, arrows, rectangles, and ellipses.  In 
addition, you can design graphics in other software, copy the graphics to the clipboard, and use the Paste command to 
insert the graphic into the report. 

  To insert a line, arrow, rectangle, or ellipse into a report, click the appropriate button in the Tools toolbar or choose 
the object by name from the Tools menu.  

  To insert a graphic or text object from the clipboard, choose Paste from the Edit menu. 
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  To select a new color for a rectangle or ellipse, double click the object in the report.  A dialog will appear with a 
choice of colors.  Select the one you want and click OK. 

  To delete an object from the report, click the object to select it, then press the Delete key on the keyboard. 

  To edit a histogram graphic, double click the mouse on the object.  In the dialog presented, you can adjust 
attributes of the graphic including scaling, major tic intervals, and minor tic intervals.  Click OK to accept the changes, 
or Cancel to discard changes. 

 

X and Y Zoom Graph objects 

These special objects allow you to display several views of the analysis histogram at one time.  The X-zoom graph 
magnifies a portion of the X-axis that you are interested in, typically the Diploid G1 area.  The Y-zoom graph magnifies 
the low-level events in the histogram so that you can carefully examine debris, aggregates, and S-Phase model 
components. 

The initial zoom settings for these objects are set using Edit Options and Configuration. 

  To insert a new X- or Y-zoom graphic into a report, click the appropriate button in the Tools toolbar or select the 
object from the Tools menu. 

  To adjust the scaling of an X- or Y-zoom object after it is placed on the report, double-click the object to display 
the Edit 1P Graphics dialog.  Choose the new settings from the dialog options and click OK. 

 

Moving and resizing report objects 

All of the objects on the report can be moved, and most objects can be resized.  This allows you to place objects 
where you want them on the report page, and adjust the size of graphics elements. 

  To move an object, click and hold the mouse button down on the object, then move the object.  Release the 
mouse to set the new position. 

  To move an object off the report page, press and hold the Shift key on the keyboard, then click and hold the 
mouse button down on the object.  You can now move the object off the report page.  Release the mouse to set the 
new position. 

  To resize an object, click the object to select it.  Handles will appear on the object.  Click and hold the mouse 
button down on one of the handles.  As you move the handle, the object will resize.  Release the mouse to set the new 
size. 

 

Saving and opening reports 

ModFit LT allows you to save and re-open the reports you create.  Each report captures all the elements used in the 
analysis: the model used, the results, and all the elements you added to the report. 

  To save a report, choose Save or Save As from the File menu. Choosing Save will store the report under the 
name that appears in the title bar, if it has been saved before.  Choosing Save As requires you to enter a name for the 
report, and then click Save to save the report.  The pathway for the saved report is automatically registered.  If you 
need to change the location of saved reports, navigate to the location and save a sample report. 

  To automatically name and save a report, choose Auto Save Report from the Analysis menu.  Auto Save Report 
will store the report under the name derived from the data file being analyzed. Example: If you open a data file, 
"SAMPLE1" and analyze it, Auto Save Report will create a report called "SAMPLE1.MFL" on PC platforms, or 
"SAMPLE1 REPORT" on the Mac. 

  To open a report, choose Open->Report from the File menu.  The File Open dialog is displayed.  Navigate to the 
location of the previously saved report and select it from the file listbox, then choose Open. 
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Model Descriptions 

 

This section contains descriptions of the models used by ModFit LT. 

Model naming 

When Auto-analysis or Choose model commands are used to create models, the program uses the following logic to 
create a name for the model. 

Position in name Meaning 

1 Number of cycles 

2 'D' if AutoDebris is enabled; 'n' if not 

3 'A' if AutoAggregates is enabled; 'n' if not 

4 Number of standards 

5 'A' if Apoptosis is enabled; 'n' if not 

For each cycle in the model, the name includes the following: 

An underscore (_) character; 

The first character of the cycle's ploidy, i.e. D=Diploid, A=Aneuploid, T=Tetraploid, H=Hypo-diploid; 

'S' if S-Phase is active, or 'n' if not; and 

'F' if G2M is active and floating, 'D' if active and dependent, 'n' if G2 inactive.  Floating means that the mean position 
and standard deviation are adjusted during the modeling process.  This gives more freedom to the model, but the peak 
must be unambiguous.  Dependent means that the position and standard deviation of the G2M are computed by 
multiplying the G1 position and standard deviation by a factor of 2.0 or your chosen linearity setting.  Inactive means 
that the G2M is not modeled. 

 

For example, the model name "3DA0n_DSD_AnD_ASF" can be interpreted to mean that there are 3 cycles, 
AutoDebris is enabled, AutoAggregates is enabled, zero standards, and apoptosis is not being modeled.  The first cell 
cycle is Diploid, with S-Phase active and a Dependent G2M.  The second cycle is Aneuploid, S-Phase is turned off 
and the G2M is dependent.  The third cycle is also Aneuploid, S-Phase is enabled, and the G2M position is allowed to 
float. 

 

Ranges and their uses 

The table below shows the ranges used by ModFit LT and the populations they are used to identify. 

Range Usage 

Debris Left side placed at start of downward sloping debris, right side extended through 
roughly 2/3 of the histogram.  Provides estimates for AutoDebris component. 

Stnd 1 Identifies the peak of the first standard.  The range should be positioned to 
encompass the standard peak.  If you have named your standards, the range 
will show the name you assign.  See Auto Analysis Settings for details on 
naming standards. 

Stnd 2 Identifies the peak of the second standard.  The range should be positioned to 
encompass the standard peak.  If you have named your standards, the range 
will show the name you assign.  

Dip G1 Identifies the G1 of the Diploid cycle.  The range should be positioned to 
encompass the peak. 

Dip G2 Identifies the G2 of the Diploid cycle.  The range should be positioned to 
encompass the peak. 

Cycle 
G1 and 
G2 

Identify the G1 and G2 for each additional cycle.  The range should be 
positioned to encompass the associated peak. 

 

When you use automatic analysis, ModFit LT picks a model for you based on the peaks it can identify in the data 
sample.  It looks at how many peaks there are, their standard deviations, areas, and relative locations, then takes its 
best shot at deducing the ploidy, debris, and aggregation aspects of the sample.  It chooses a model that matches its 
deductions.  The black triangles at the base of the histogram show the peaks the program has identified.   
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When you select a model yourself using the Choose Model option from the Analysis menu, you are presented with the 
dialog pictured below.  With this dialog, you make the decisions about the sample.   

 

  

See Choose Model for more on this option. 

 

Colors 

ModFit LT allows you to edit the colors used by the model using the Colors command (Edit menu) .  The default color 
assignments are listed in the table below. 

Component Color 

Diploid G0-G1 red 

Diploid G2-M red 

Diploid S-Phase reverse-hatched blue 

Aneuploid G0-G1  1st is bright yellow; 
others become darker 
shades of yellow 

Aneuploid G2-M  1st is bright yellow; 
others become darker 
shades of yellow 

Aneuploid S-Phase  forward-hatched blue 

AutoAggregates light green 

AutoDebris medium blue 

Apoptosis sky blue 

1st Standard dark gray 

2nd Standard light gray 

 

Component Shapes 

The parts of ModFit LT's models are comprised of several component shapes.  The table below shows the shapes 
used by the models, and where they are used. 
 Component Shape Uses 

Gaussian 

 

Gaussian components are 
used to model peaks.  
They are often linked to 
ranges. 
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Rectangle 

 

This component is typically 
used to model S-Phase.  
The peaks on either side 
of it determine boundaries 
and standard deviations.   

Trapezoid 

 

This component can be 
used to model S-Phase.  It 
has an additional degree 
of freedom over the 
rectangle and generally 
yields higher S-Phase 
values.  The peaks on 
either side of it determine 
boundaries and standard 
deviations.   

Polynomial 

 

This component can be 
used to model S-Phase.  It 
has an additional degree 
of freedom over the 
trapezoid and should be 
used with caution. The 
peaks on either side of it 
determine boundaries and 
standard deviations.   

AutoDebris  

 

The AutoDebris 
component is used to 
model debris.  Its starting 
point is based on the 
position of the Debris 
range. 

AutoAggregate 

  

This component is used for 
aggregate compensation.  
Its shape is unique to each 
histogram.  It does not use 
a range. 

Weibull 

  

This component can be 
used to model skewed 
peaks in custom models. 

Contact Verity technical 
support for assistance with 
this component. 

 

See also: 

Choose Model command (Analysis menu)  

Manual analysis with ModFit LT  

Analysis Results  
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Analysis Results 

 

This section describes the results that are displayed by ModFit LT after an analysis has been performed.  The results 
are usually displayed on the upper right side of the report, although you can move the results to anywhere on the 
report. 

There are several types of models available in the program, each with its own set of results.  Standard models are 
created by Automatic Analysis and by choosing a model for manual analysis.  These models include components and 
results for debris, standards, aggregates, and apoptosis, as well as for one or more cycling populations.  For each of 
the cell cycles, a G0G1, G2M, and S-Phase component is included. 

Sync Wizard models are created when using the Sync Wizard.  These models are designed for the special demands 
of perturbed cell cycle analysis. 

The Proliferation Wizard creates Proliferation Wizard models.  These models are used to study cell proliferation in 
samples using cell-tracking dyes and proliferation markers. 

The program calculates percentages based on the number of events that are actually modeled.   The number of 
events modeled can be less than the total number of events in a sample if you apply a gate, scale the data to eliminate 
events, or if the model itself does not fit the data exactly.  Suppose, for example, that a listmode file contains 10,000 
events.  If you gate out 10% of the events, the analysis will be performed on 9,000 events, or 90% of the total events.  

 

Standard Models 
Result Computation 
Ploidy Mode Displays the Auto Analysis Diploid 

Determination setting. 
Diploid Reference If the Diploid Determination setting is 

External Reference, Based on 
Standard 1, or Based on Standard 2, 
this result will display the location of 
the ploidy reference. 
If First Cycle is Diploid mode, this 
result is meaningless and is not 
displayed. 

% Cycle Percent of all events that are 
associated with cycling populations 

    %G0G1 G0G1 as a percent of all cells in that 
cycle 

    G0G1 mean G0G1 mean channel 
    %G2M G2M as a percent of all cells in that 

cycle 
    G2M mean G2M mean channel 
    % S-Phase S-Phase as a percent of all cells in 

that cycle 
    G2/G1 ratio Ratio of G2 mean channel to G1 

mean channel 
    %CV Coefficient of variation for G0G1 cells 
    DI DNA Index, defined as the mean 

channel of G1 cells of an aneuploid 
population compared to Diploid G1 
mean channel. 

    DI based on reference If the Diploid Determination setting is 
External Reference, Based on 
Standard 1, or Based on Standard 2, 
this result will display the DNA index 
based on the computed reference 
position for the Diploid G1. 

  
Total Aneuploid S-Phase Sum of all Aneuploid S-Phase areas 

as a percentage of the total (G1G1 + 
S + G2M) area for all Aneuploid 
populations.  This result is not 
displayed for Diploid models.  
However it is computed as a keyword 
even for Diploid models.  For Diploid 
models, the "tumor" S-Phase is 
considered to be the Diploid S-Phase, 
and so the keyword reports the S-
Phase of the Diploid.   

Total S-Phase Also called "Average S-Phase".  Sum 
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of all S-Phase areas as a percentage 
of the total area for cycling cells of all 
populations. 

Total B.A.D Amount of debris and aggregates 
found within the region between the 
first G1 and the last G2 peak. 

  
Standards  
   Stnd % Area of standard as a % of all 

modeled events minus debris 
   Stnd mean Mean channel position of standard 
   DI DNA Index of standard as standard 

mean channel relative to the Diploid 
G1 mean channel. 

   Dip G1 Ratio Diploid G1 mean channel divided by 
mean channel of the standard 

   %CV Coefficient of variation for standard  
  
%Debris Debris area as a % of all modeled 

events 
%Aggregates Aggregate area as a % of all modeled 

events 
%Apoptosis Apoptosis area as a percent of all 

modeled events minus debris 
Modeled events Number of events accounted for by 

all components in the model 
All cycle events Number of modeled events in the 

G0G1, G2M, and S-Phase 
components of all cycling populations 

Cycle events per channel All cycle events divided by the 
number of channels between the first 
G0G1 and the last G2M of the model. 

RCS Reduced chi-square, a measure of 
goodness of fit.  Values from 1.0 to 
3.0 are good, 3.0 to 5.0 are fair, and 
greater than 5.0 are poor. 

 

Tetraploid Model 

ModFit LT handles Tetraploid histograms slightly differently than most other ploidy types.  Because the Diploid G2M 
and the Tetraploid G1 peaks are superimposed, the program disables the Diploid G2M during the modeling process.  
After the model has been applied to the histogram using the Fit with Current Model command or Auto Analysis, the 
program will add back a specified amount to the Diploid G2M and reduce the Tetraploid G1 by the same amount. This 
amount is computed as a percentage of the Diploid G1 peak, and the percentage is specified in the Options and 
Configuration dialog box.  The default percentage is 8% (0.08). 

 

Sync Wizard Model 

In addition to many of the results described for standard models, the Sync Wizard also computes the percentage for 
sub-compartments of S-Phase 
Result Computation 
S-Phase Cells in S-Phase as a percent of all 

the cells in that cycling population 
  Compartment n Area of S-Phase sub compartment as 

a percent of all the cells in that 
cycling population 

 

Proliferation Wizard Model 
Result Computation 
Generation n % Area associated with a particular 

generation as a percent of all cells 
(parent plus all daughter 
generations), excluding background 

Generation n mean Mean channel position of generation  
Proliferation Index See explanation below 
Nonproliferative Fraction See explanation below 
Division Error Index See explanation below 
Spacing of generations Channel spacing for the halving of 
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intensity that the model assumes will 
occur at each cell division.  This value 
is found on the Wizard Generations 
tab 

  
For cells at generation Start generation for "true proliferation" 
Upper Generation P.I. See explanation below 
Precursor Frequency See explanation below 

 

Proliferation Index, Nonproliferative Fraction and Division error index use a model for cell division that expects that cell 
number will double as cells proliferate through each daughter generation.  For example, the system expects that 1 
parent cell will divide into 2 second-generation cells, which in turn will divide into 4 third generation cells, and so on.  
Think of it this way: the model needs to work backwards from the time of flow data collection to the time at which the 
cells were put into culture originally.  If there are 200 cells in the second-generation at the time of data collection, they 
were theoretically generated from 100 original parent generation cells each dividing into two cells.  If there are 200 
cells in the third-generation at the time of data collection, they were theoretically created from 50 original parent cells.  
Those 50 divided into 100 first-generation cells, which in turn divided into 200 second-generation cells during the 
course of cell culture. 

The Proliferation Index is the sum of the cells in all generations divided by the computed number of original parent 
cells theoretically present at the start of the experiment.  It is a measure of the increase in cell number in the culture 
over the course of the experiment. 

The Nonproliferative Fraction is the number of cells in the parent generation at the time of data collection divided by 
the computed number of cells present in the original culture.  It represents the fraction in the original culture of cells 
that have not proliferated during the course of the experiment. 

The Division Error Index is always equal to 1.0 in the "Basic" model.  If you use the Asymmetric Cytokinesis Model, the 
Division Error Index equals the standard deviation of generation 2 divided by the standard deviation of the parent 
generation.  Enabling Background and Asymmetric cytokinesis checkboxes on the Other tab in the wizard activates 
the Asymmetric Cytokinesis model. 

The Upper Generation P.I., or UPGI, is conceptually similar to the Proliferation Index, except that it is computed for a 
specified subset of generations.  It excludes from the designation as "True Proliferating cells" those cells that have 
gone through only a small number of divisions.  You can set the starting generation for "true proliferation" on the Other 
tab of the wizard.  The UGPI is a measure of the increase in cell number over the course of the experiment for cells 
that are actually proliferating (that is, those that have gone through at least the designated number of divisions). 

The Precursor Frequency is the proportion of the total cells calculated to have been present at the start of the 
experiment (derived by back-calculation according to the model) which have then gone on to "true proliferation" during 
the course of cell culture. 

Here is a table to serve as an example.  Assume that there are 6559 cells analyzed in a proliferation data file. 
Generation Cell # Parent Factor Parent # 
Parent 3000 1 3000.00 
2 600 2 300.00 
3 800 4 200.00 
4 1600 8 200.00 
5 2400 16 150.00 
6 4200 32 131.25 
7 4400 64 68.75 
8 2000 128 15.63 
9 800 256 3.13 
10 200 512 0.39 
    
G1 - G10 20000  4069.14 
Proliferation  
Index  

=20000 / 4069.14  4.92 

    
Nonproliferative 
Fraction 

=3000.00 / 
4069.14 

 0.74 

    
G4 - G10 16400  769.14 
UGPI =16400 / 769.14  21.32 
    
Precursor Frequency =769.14 / 4069.14  0.189018 
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Histogram and S-Phase Assessment 

 

ModFit LT contains two systems to evaluate confidence in the S-Phase estimates it computes.  The first method 
evaluates several histogram features that have been published as affecting S-Phase accuracy (Cytometry.  Vol. 14.  
Number 5, 1993.): %CV, Cell Number and %B.A.D.  The ProutNeck DNA Consensus Conference published a set of 
guidelines for these histogram attributes and ModFit LT uses these published guidelines to provide you with a 
graphical and quantitative picture of how the histogram satisfies the requirements.  By pushing the button next to each 
of these features you can examine the actual published quote. 

ModFit LT evaluates an additional feature not covered by the Consensus Conference: RCS.  Reduced Chi-square is a 
measure of how well the model fitted the data.  Based on our experience with RCS values, we added our own 
guidelines for this feature. 

The second method of S-Phase assessment is unique to ModFit LT and is based on a statistical approach to the 
problem rather than a consensus of experiences.  By using established statistical methods, ModFit LT calculates the 
error probability distribution about each of its S-Phase estimates (e.g. Total or Average S, Aneuploid S, and Diploid S).  
The standard deviation of this probability distribution provides a direct quantifiable way of evaluating the confidence of 
a given S-Phase estimate.  If you are getting glassy-eyed on this statistical stuff, let us show you four graphs that will 
make it crystal clear how this system works.  The first graph demonstrates how cell cycle programs used to work. 

 

Letsay that your old cell cycle program reported a Total (average) S-Phase estimate, also known as "Average S-
Phase", of 20.5%.  Since the program did not give you any information on the variability associated with this estimate, 
you had to assume that it was correct.  Another way of saying the same thing is that the probability of the Total S-
Phase being 20.5% was assumed to be unity or one.  Largely because of this limitation, a number of S-Phase criteria 
were developed that normally would be conducive to obtaining accurate S-Phase estimates (cell number>10,000, 
%CV<8.0, etc). 

ModFit LT has an exclusive statistical method of estimating the probability distribution about each of its S-Phase 
estimates.  Lettake a look at how that changes our figure. 
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Since ModFit LT calculates the probability distribution about its estimate, you now have a way of quantifying the S-
Phase estimatevariability with a standard deviation.  Rather than 20.5% in this example, you now know that it is really 
20.5% +/- 1.2%. 

However, ModFit LT takes this S-Phase assessment one step further.  By evaluating S-Phase cutoffs against this 
probability distribution, the program can calculate the probability of the estimate being in a particular category (e.g. 
Low, Intermediate, or High).  Letlook at the next graph to see how this works. 

 

The areas of the probability distribution between each of the S-Phase cutoffs indicate how likely the S-Phase estimate 
is within that category.  For example, the area of the High category is 0.95; thus, there is a 95% chance that the 
specimen has a high S-Phase with your laboratoryspecific S-Phase cutoffs.  Normally in statistics, you express the 
probability of the hypothesis not being correct (p-value).  In this case, the p-value is simply 1.0 - 0.95, or 0.05, and it is 
the p-value which ModFit LT displays.   

Thatjust about all there is to it.  Not only does ModFit LT indicate the variability of its estimate, but it also merges your 
S-Phase cutoffs with the derived probability distribution to provide you with just the information you need to convey to 
the physician about the proliferative activity of the specimen.  Is the S-Phase high?  How sure are you of this 
assessment?  You can now answer both questions quantitatively. 

We promised you four graphs and have only shown three so far.  Suppose the derived S-Phase estimate was one of 
those borderline calls.  It overlaps one of your S-Phase cutoffs.  Letmodify the above graph to show that situation. 
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How do you classify this specimen?  If you choose High, then you have a 25% chance of being wrong.  When 
confronted with this situation itbest to combine two categories.  By calling the specimen: Intermediate to High, the 
probability of being wrong is back to a reasonable level.  What you are really saying is that the S-Phase is probably not 
Low. 

If ModFit LT determines that the certainty (probability) of a particular S-Phase level is less than 0.9, it will automatically 
combine the two most probable categories.  If the certainty is still less than 0.9 with the combined categories, then the 
program will display a question mark (?) next to the corresponding S-Phase assessment. 

ModFit LT enables the inspection of the error distributions about each of its S-Phase estimates.  If the sample is DNA 
diploid, only the diploid S-Phase error distribution can be evaluated.  If the sample is DNA aneuploid or tetraploid, only 
the aneuploid and total S-Phase error distributions can be evaluated. 

 

See also: 

S-Phase cutoffs command (Edit menu)  

Fit Diagnostics command (Analysis menu)  

S-Phase Assessment Options dialog  
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DDE Support 

 

NOTE: This feature is only available on Windows versions of ModFit LT.  DDE is not support on the Macintosh. 

Dynamic Data Exchange (DDE) in ModFit LT allows the program to be driven by and to provide information to other 
applications. 

WinList for Windows can use DDE to connect with ModFit LT, and to share data with it.  In most cases, the DDE 
scripts provided with WinList are sufficient for this interaction.  If you have another application you want to connect with 
ModFit LT using DDE, please contact Verity Customer Support. 
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Listmode 

 

Note: ModFit LT reads data files stored in Flow Cytometry Standard (FCS) format.  If your data is not stored in this 
format, you may need additional conversion software in order to use your samples with the program. 

 

Loading a Listmode File: 

If ModFit LT detects that the file you select to open is a listmode file, it will present you with several dialogs to choose 
which parameter you want to analyze, as well as the opportunity to create one or two gates on the data.  After you 
respond to the dialogs, the program will display a histogram for analysis.  In addition, if you create gates, copies of the 
gating graphics will be placed on the report. 

 

Choose  Parameter for Analysis: 

 

The first dialog displayed when a listmode file is selected is the Choose Parameter for Analysis dialog.  This is used to 
identify which of the listmode parameters represents the signal you want to analyze.  Choose the parameter to analyze 
from this list. 

See Choose Parameter for Analysis for additional details on this dialog. 

After choosing a parameter, click OK. 

 

Gate Selection: 

 

After you choose the DNA parameter, ModFit LT presents the Define Gates dialog.  You can create up to three gates 
for the analysis.  Gates are logically “AND” gates, which means that events must satisfy all active gates to display in 
the histogram. To create an active gate, select one of the Define Gate push buttons. 

 

Choosing Gate Parameters: 
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The Define Gate Parameters dialog enables the selection of two parameters. The left listbox represents the x-axis 
parameter; the right listbox represents the y-axis.  Choose the two parameters for gating, and then click OK to define 
the gate. 

 

Defining the Gating Region: 

 

Choose the predefined shape that most closely resembles the desired gating region (Ellipse, Rectangle, Aggregates).  
The initial shape is the Ellipse.  Move the gating region by clicking the mouse inside the region and dragging it to the 
desired location.  Clicking and dragging on one of the corner black squares adjusts the overall size of the region.  
Clicking and dragging redefine a particular point in the region.  Dragging the white square within the region can rotate 
the region. 
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Population Visualization: 

The gating display is a 128x128 channel histogram.  There are two display options: Rainbow and Color Density.  In 
both modes, the number of events in each channel is represented by a color. 

In Rainbow mode, a pre-defined palette of colors is used to provide a high contrast density plot.  You can change the 
background color by clicking the BG button and selecting a new color. 

In Color Density mode, the colors are selected from a color palette shown to the right of the graph.  You can define the 
beginning and ending color by pressing the Low and High buttons respectively.  You can also change the background 
color by pressing the BG button.   

To change the color of the region label and line, double-click the region label and select a color.   

Use the "+" and "-" buttons to change the z-scaling of the graphic. 

We suggest that you experiment with different color selections and pick one that works for you. 

 

Enhance Small Populations: 

By checking this button, a special non-linear palette is used that maximizes color differences for small populations.  If 
you are having trouble seeing a small population, try this option. 

 

Copy To Clipboard: 

If you wish to copy the gate used for this file to another application, select the Copy To Clipboard button.  This option 
copies the histogram and region to the clipboard.   

 

Finishing Up: 

Once the region is over the desired population, select OK.  If you are going to define two gates, then press the Define 
Gate 2 button; otherwise, select OK in the Define Gates dialog to load the gated DNA histogram. 

If you have created gates, a graphic for each gate will appear on the report.  The gating regions can be adjusted 
directly on the report without reloading the file. 
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Choose Parameter for Analysis 

 

 

This dialog is displayed when a listmode file is selected.  It is used to identify which of the listmode parameter you 
want to analyze.  Choose the parameter to analyze from this list. 

The Convert button can be used to choose parameters that should be converted from linear to log.  See Edit 
Properties for Log Conversion for details. 

After choosing a parameter, click OK. 
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Edit Properties for Log Conversion 

 

  

This dialog is available for any data files that are FCS listmode format.  It allows you to convert linear parameters to 
log.  It is most useful for data files generated by high-resolution, digital flow cytometers that store all parameters in 
linear format. 

The dialog is accessed from the Choose Parameter for Analysis dialog box that appears when a listmode file is 
opened. 

Any parameters selected are converted to log for display and analysis.  The conversion is done in memory and does 
not affect the actual data in the FCS file. 

Number of Decades: 

This option allows you to convert into 4-decade log or to allow the program to compute the number of log decades 
based on the resolution of the linear parameter. 

 

Linear-to-Log Conversions  

Enable the Convert-to-log checkbox for each linear parameter that you want to display and analyze in log. 

 

Click OK to accept changes, or Cancel to discard changes. 
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Batch Processing 

 

ModFit LT provides powerful batch processing of data files and reports.  Batch processing of data files supports 
automatic analysis, saving and printing of reports, and databasing of results, in addition to other features.  When 
processing batches of reports, you can re-analyze data, perform AutoLinearity adjustments, re-save and print reports, 
and store results in databases. 

Batch Processing Settings 

The Edit menu contains entries for File Batch Settings and Report Batch Settings.  These options allow you to select 
what you want to do as you process data files and reports, respectively.  Refer to these sections for specific details. 

 

Batch Selection 

If you select more than one file in either the Open Data or Open reports dialogs, the program automatically enters 
batch-processing mode.  A toolbar appears at the lower left of the application window when more than one data file is 
selected.  A separate toolbar is displayed at the lower right when more than one report is selected.  These toolbars 
allow you to navigate through the selected files, performing the selected operations.  Refer to sections on File Batch 
Toolbar and Report Batch Toolbar for details. 

 

Examples 

1.  Suppose that you want to select a set of data files, auto-analyze them, and save reports for each.  In additions, you 
do not what the program to prompt you to store a record in the database, nor for any listmode gating changes.  From 
the Edit menu, choose File Batch Settings.  In the dialog, choose Auto-analyze and Save report.  Choose a location for 
the reports using the Save Report Path button.  Clear the checkboxes for Database prompt and File prompt.  Click OK 
to apply the settings and close the dialog.  Next, choose the Open Data command from the File menu, or click the File 
button on the toolbar.  Select the files that you want to analyze and click Open.  The File Batch toolbar will appear at 
the bottom of the application window, the first file will be opened and auto-analyzed, and a report will be saved for the 
analysis.  Click the Auto-advance button (an arrow followed by 3 dots) on the File Batch toolbar to automatically 
process the rest of the files. 

 

2.  Suppose you want to review a set of reports, one at a time, and print them after making changes to them.  You can 
approach this either of two ways: 1) review, correct, and print each report, or 2) review, correct and re-save each 
report, then re-run the entire batch and automatically print each report. 

From the Edit menu, choose Report Batch Settings.  Clear all of the checkboxes and click OK.  Next, from the File 
menu, choose Open report.  Select the reports you want to review and choose Open.  The Report Batch toolbar will 
appear at the lower right of the application window, and the first report will be displayed.  Review the report, making 
changes as needed. 

When you are ready to proceed, you have 2 choices.  If you prefer the first method described above, you would click 
the Print button on the main toolbar to print the report, and probably click the Save button if you made any changes.  
For the second method, just click the Save button to resave the report.  

To move to the next report, click the Next button on the Report Batch toolbar and repeat the process above until you 
have reviewed all of the reports. 

If you want to batch print all of the saved reports, you would return to the Report Batch Settings dialog.  This time, you 
would check the option to Print reports and click OK.  Click the button on the Report Batch toolbar that moves you to 
the first report.  The report will be re-opened and automatically printed.  Now click the Auto-advance button (an arrow 
followed by 3 dots) to open and print each of the remaining reports. 
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Strengths and Limitations of Automatic Analysis 

 

ModFit LT uses some very sophisticated logic when it attempts to automatically analyze your data.  The system has 
been designed to work with a great variety of data samples, samples that vary in almost an unlimited number of ways.  
When your data samples fit into the assumptions built into the automatic analysis functions, the program works well in 
automatically modeling them.  Conversely, as you might expect, the automatic systems do not work as well when your 
samples differ from what it has been designed to analyze. 

To better understand the strengths and limitations of automatic analysis, it may be helpful to examine some of the 
assumptions built into the system. 

 

 Peak Finder 

When you open a data file with the program, one of the first things the software attempts to do is locate "peaks" in the 
sample.  This step is the foundation of automatic analysis: if it finds the important peaks in the sample, the remaining 
steps in auto-analysis have a good chance at succeeding.  If it cannot detect the important peaks, it will more than 
likely have difficulty or may fail to automatically analyze the sample. 

While it is relatively easy for our eyes to see peaks in a histogram, the computer algorithms that perform this function 
are anything but simple.  The process ModFit LT uses works well with the large library of data files we use to test the 
system.  Here is how it works. 

The program performs a statistical analysis of the histogram to identify potential peaks.  Then the peak finder begins to 
filter out peaks that do not meet certain criteria.  There are filters for high and low %CV, relative peak height, and how 
well the peak can be fitted with a Gaussian in a quick analysis.  These filters can be viewed in the Peak Finder 
Settings dialog.   

If one or more of the filtering criterion filters out an important peak, the system will likely fail in a later step.  For this 
reason, you can adjust some of the filters used by the peak finder so that the system better matches the data samples 
analyzed in your laboratory.   

A very important note on the peak finder settings: adjusting one or more settings to work with a single sample is a bad 
idea.  The reason is simple: without looking at numerous samples to test your new setting, you may find you have 
fixed the peak finder for one exceptional sample, and broken it for the typical sample.  Weigh your adjustments 
carefully.  Do not make adjustments to accommodate a single sample; use manual analysis to handle the exception. 

 

 Ploidy Detection 

The peak finder identifies the peaks it finds by displaying a small, black triangle under the peaks on the histogram 
display.  The next step in automatic analysis is to look at the pattern presented by those peaks and attempt to match 
the pattern to a type of histogram the program knows about.  This occurs when you click the Auto button on the 
toolbar, or choose Automatic Analysis from the Analysis menu. 

So just what is an "important" peak? 

The most important peaks the program needs to find are peaks for internal standards, apoptosis, and G0G1 peaks for 
each cycling population.  If the program finds these peaks, it generally succeeds in auto-analysis.   

You need to tell the program how many standard peaks your sample contains.  This is done in the Auto Analysis 
Settings dialog box.  The program assumes that standard peaks, if any, are the first peaks, followed by an apoptosis 
peak, if selected, and the remaining peaks are cycling population peaks. 

If you have correctly informed the program as to how many standard peaks the sample contains and whether or not it 
has an apoptosis peak, and the peaks found by the peak finder are the important peaks, the ploidy detection step is off 
to a good start.   

The remaining step is a pattern-matching step, which ignores standard and apoptosis peaks.  Here, the program 
analyzes relative sizes and positions of the peaks remaining, looking for cell cycles.  ModFit LT is designed to handle 
any number of cell cycles in a histogram, though it is rare to find samples with more than 4 cell cycles. 

In general, the more complicated the histogram, the more difficult it is to classify.  You may need to manually analyze 
very complex samples. 

Once the sample is classified, a model is created to match the pattern.  Then ranges are assigned to important peaks, 
and the non-linear least-squares analysis of the sample is performed. 

 

Debris and Sample Quality 

As you might expect, the success of automatic analysis is closely linked to the quality of the data you want to analyze.  
Samples with lots of debris or aggregation detract from the programability to find peaks or determine the right model to 
use.  Efforts to gate out debris and aggregation sometimes work, but they are usually going to work against the 
programbuilt-in functions designed to compensate for debris and aggregates.  The better solution is to perfect the 
sample preparation and acquisition techniques you use.  Starting off with a cleaner sample greatly simplifies the peak 
and ploidy detection operations, and helps ensure that the peaks seen by you and the program are real peaks. 
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Follow the suggestions of experts to prepare and analyze your samples.  Establish standards that must be met before 
a sample can be considered for analysis.  The DNA Consensus Conference (Cytometry.  Vol. 14.  Number 5, 1993) 
made many specific recommendations on DNA analysis, many of which relate to sample quality.  Your standards 
should be at least as restrictive as those presented in that report. 

Be aware of obvious things, as well.  If you accidentally try to analyze forward angle light scatter instead of the DNA 
parameter, you will end up with nonsensical information when you perform automatic analysis. 

 

Your Responsibilities 

Based on this discussion, it is probably obvious that there are numerous ways automatic analysis of your samples can 
fail.  The problem is that the program itself doesnknow when it has failed; only you can make that determination.   

You should view automatic analysis with scientific skepticism.  You must review the information on the report to ensure 
all the model matches your understanding of the histogram.  You should always review the results of an automatic 
analysis to ensure that the program has identified the standard peaks, apoptosis peaks, and G0G1 peaks of the 
cycling populations.  In addition, you should verify that the ploidy classification assigned by the program concurs with 
your knowledge of the sample. 

 

See also: 

Automatic Analysis command (Analysis menu)  

Manual analysis with ModFit LT  
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